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1 Introduction 

1.1 About this software release    *12.0.sp5* 
PDMS 12.0 is supplied on a DVD-R, which self-installs using standard Microsoft installation 
procedures. The full software suite is usually loaded onto individual PCs running Windows, with the 
license server and file loaded onto a networked Windows server.  

A number of Service Packs (SP1… SP5 – see section 1.7) have been released to improve the original 
release. It is strongly recommended that the latest one is used. 

Please note that PDMS 12.0.SP3 onwards requires Flexman 4.1 and an appropriate license – they will 
not work with Flexman 3.1. For further details of Flexman License Server 4.1, please see 
http://support.aveva.com/support/United_Kingdom/index.htm.  

1.2 About this manual     *12.0.sp5* 
This manual gives an overview of changes since the previous major release: PDMS 11.6. It is 
primarily aimed at users upgrading from that release, though it also contains information about 
changes since the earlier releases of PDMS 12. 

It has been updated for each Service Pack (SP) of PDMS 12.0, with the significant changes flagged in 
the section titles as appropriate. 

Additional chapters have been added at some service packs for the associated products. In particular, 
details for AVEVA Cable Design and Global have been added at SP4 and for Status Control, 
Mechanical Equipment Interface and for some of the Schematics products at SP5. 

1.3 Software distribution & installation  *12.0.sp5* 
Please note that the installation process has been changed for PDMS 12.0.SP4 onwards. The installers 
now use standard Microsoft Installer (MSI) technology, which facilitates silent installations through 
standard MSI means. They are usually triggered by use of a setup.exe file. 

There are fewer separate installers, each corresponding to an AVEVA ‘release’, on the DVD. The 
PDMS/Plant installer now includes options to install many of the associated products, although, for 
various reasons, some products still use a separate installer. 

This means that a selection of products can easily be installed together – please see diagram over. It is 
recommended that the Global option(s) are installed this way, though there is a separate installer for 
use on a separate machine, such as a server, which does not have PDMS. 

Please note that there is no ‘thin client’ installation option as this is no longer supported. 
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Target location or ROOTDRIVE can be specified when running each installer. By default, those 
performed using setup.exe will be loaded on C:\ and will stop with an error if there is no C: drive. 
Alternatively, the .msi file (e.g. Plant12.05.msi) can be run directly; this will by default use the local 
drive (that can be written to) having the most free space. For more details, see 
http://msdn.microsoft.com/en-us/library/aa371372(VS.85).aspx.   

Existing installations should be changed, repaired or removed using Add or Remove Programs from 
the Control Panel. This process will prompt for the original DVD if required. This ensures that a 
consistent product set, as tested by AVEVA, will be deployed. 

Fix releases (patches) will use a standard updating process, which also checks, and if necessary 
‘heals’, the existing installation. There is therefore no prompt for location, as the system already has 
this information. Fix releases may also be removed using Add or Remove Programs. 

Fix releases are applied to all products installed together, not to the individual products. It is therefore 
important to use the Plant/PDMS installer to apply a fix to Global if that is the way it was installed. A 
Fix release for the Global installation will not patch the Global program installed by the Plant 
installer. The use of the latest fix release is recommended: this includes any previous fixes for that 
installer. 

For full details of the installation options and procedure, and the hardware and software requirements, 
please refer to the PDMS & Associated Products Installation Guide. 

1.4 AVEVA Plant 
AVEVA Plant is the new name for the VANTAGE Plant product portfolio and encompasses the Plant 
Engineering, Plant Design and Project Resource Management aspects. It shares a lot of technology 
with the new AVEVA Marine portfolio: both are based on much enhanced version of the tried and 
tested PDMS design platform.  
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Most of the Plant products have been updated and given a 12.0 version number, to clarify their 
compatibility. Since this is a major change to PDMS, many older versions of interfaces such as 
OpenSteel will no longer work with PDMS 12.0, though there are some exceptions. Conversely, 
version 12.0 of the Model Management products is also compatible with some older versions of 
PDMS and other products. 

1.5 AVEVA Design Platform 
The AVEVA Design Platform provides a fully interactive, easy-to-use 3D environment for every 
designer on the project, supported by an Office-style user interface based on Microsoft’s .NET 
technology and the latest in 3D graphical interaction tools.  It is based on the globally distributed 
database used on countless PDMS projects for over 20 years. 

It provides the basis for both the Plant and Marine products, including catalogue, administration, clash 
and integrity checking and reporting. It is highly configurable and includes a powerful programmable 
macro language (PML) that can be used to customise the system and automate key activities across all 
areas of the product.  

The new platform will facilitate many further developments to both the Plant and Marine products 
over the next few years. Following on from the introduction of Microsoft’s .NET Framework at 
PDMS 11.6, we are making more use of it to improve the user interface and also to provide a common 
look – and better integration – across the AVEVA products. 

1.6 AVEVA Plant Product portfolio 

1.6.1 AVEVA Plant Version 12.0 
Most of the Plant Design products have been updated and re-branded as Version 12.0 to simplify the 
question of compatibility. All Version 12.0 products are designed to work together; in some cases 
they may also work with earlier versions. 

1.6.2 Major Plant Design Products    *12.0.sp5* 
AVEVA PDMS is of course the major AVEVA Plant Design product: it includes the AVEVA Design 
Platform and engineering applications for piping and equipment, structural, ducting, cable trays and 
supports, including drafting. [It should be noted that PDMS can read data from an AVEVA Marine 
Outfitting database but cannot read or write Hull data.] 

The main add-on applications and interfaces are: 

AVEVA Global Allows project data to be synchronised between remote sites. 

AVEVA Review 3D visualisation of large complex plant models – including walk-
through, animation, and high-quality photo-realistic images. 

AVEVA ReviewShare Collaboration tool that provides a method of tracking and 
responding to comments and incorporates web-based access to a 
central 3D model. 

AVEVA Multi-
Discipline Supports 

Highly productive application for the design of all kinds of 
supports, from a complicated framework encompassing integral 
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(MDS) hangers to a simple U-bolt. Use of a standard catalogue of pads, 
sliding shoes, straps and clips etc. enables the design of consistent, 
reliable and fully detailed hanger and support designs in the 
shortest possible time. Fully dimensioned manufacturing drawings 
are produced automatically with all the necessary data for 
fabrication and erection of the support, including Material Take 
Offs and cut lengths.  

AVEVA Laser Model 
Interface (LMI) 

Laser Model Interface enables the use of as-built 3D model data 
by interfacing with point cloud data from laser scanning systems. 

AVEVA Model 
Management products 

Manages clash information, object status and deliverable 
production. Comprises AVEVA Model Object Manager, AVEVA 
Clash Manager, AVEVA Connectivity Manager and AVEVA 
Deliverable Manager. Clash Manager is also available as a stand-
alone product. 

AVEVA Area-based 
Automatic Drawing 
Production (ABA ADP) 

Automates the production of volumetric drawings using specified 
templates, thus simplifying their update after a change to the 
PDMS model. This ensures that up-to-date drawings are always 
available for maintenance work etc.  

AVEVA Isometric 
Automatic Drawing 
Production (Iso ADP) 

Automates the production of fully annotated drawings of HVAC, 
including a bill of materials. This has not yet been updated to 
PDMS 12 but is planned for release at PDMS 12.1. Customers 
using the PDMS 11.6 version could adapt this to provide a basic 
level of function – see section 25.1.5. 

AVEVA  
Final Designer 

Produces drawings directly from the PDMS model and allows 
them to be edited in an AutoCAD environment, with access to 
PDMS data for annotation and dimensioning. 

AVEVA SQL-Direct Enables SQL queries on PDMS data, thereby simplifying 
integration of PDMS data into Office applications such as Excel. 

AVEVA QUERY Allows PDMS applications written in PML to access ODBC 
databases, to read or write their data and use it in PDMS 
applications. 

AVEVA OpenSteel Allows import and export of files in Structural Detailing Neutral 
Format (SDNF) format to and from PDMS. Used for transferring 
data between 3D steel detailing packages and PDMS. 

AVEVA ImPLANT-I Converts MicroStation 3D geometric model (.DGN) files for input 
to PDMS or REVIEW; can also translate any associated Design 
Review (.DRV) files. Version 2 (new with *12.0.sp5*) is a major 
update and can translate DGN v8 files. 

AVEVA  
ImPLANT-STL 

Converts stereo-lithography (.STL) files from mechanical CAD 
systems for input to PDMS.  

AVEVA ExPLANT-A Exports 3D geometric models from PDMS to an AutoCAD 
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interchange (.DXF) file. This can be used to import 3D geometric 
models into AutoCAD or other suitable CAD systems. 

AVEVA ExPLANT-I Exports 3D geometric models from PDMS to a binary 
MicroStation (.DGN) file. This can be used to import 3D 
geometric models into MicroStation or other systems such as 
Intergraph’s PDS. 

AVEVA Pipe Stress 
Interface 

Provides a two-way interface for the data exchange between 
PDMS and the CAESAR II pipe stress system. Piping designers 
and stress engineers can exchange design and stress information. 

AVEVA Mechanical 
Equipment Interface – 
import and export 

New at *12.0.SP5*. These interfaces import and export geometric 
models using the standard STEP AP203 format; other PDMS 
objects may also be exported in the same format. The Mechanical 
Equipment geometry in stored in new geometric primitives – the 
solid GENPRIM and the curve GENCUR. See chapter 22. 

AVEVA PML Publisher Allows encryption of PML scripts, thereby enabling the use but 
not the modification of users’ PDMS applications. 

AVEVA Diagrams New at *12.0.SP4*. Used for creating P&IDs and HVAC 
diagrams. It saves both the diagram and the engineering objects in 
the model database. 

AVEVA Schematic 
Model Manager 
(formerly P&ID 
Manager) 

Provides unrivalled features for the consolidation of all P&ID data 
for a project, independently of the P&ID authoring tool. 

AVEVA Schematic 3D 
Integrator  
(formerly P&ID 3D 
Integrator) 

Provides an integrated Schematic / 3D environment that allows 
customers to build their 3D model in a controlled manner, directly 
from the information on a P&ID, and enables consistency checks 
between the Schematic model and the 3D model. 

AVEVA P&ID 
(formerly VPE P&ID) 

A P&ID design system which stores intelligent engineering data 
onto graphical entities in an AutoCAD drawing while the designer 
draws and annotates the P&IDs. These intelligent P&IDs, 
containing tagged items, quantities and connectivity data, can be 
loaded into the AVEVA schematic model via AVEVA Schematics 
Manager, or synchronised with the AVEVA VPE Workbench. It 
supports different engineering standards, individual company 
working methods, and complex projects containing many hundreds 
of P&IDs – and is now included on the main Plant DVD, as from 
12.0.SP5. 

AVEVA VPE 
Workbench 

An integrated engineering database which manages the evolving 
engineering descriptions of all tagged items in a plant.  

AVEVA VPRM Allows the effective management of materials, vendor documents, 
design documents, progress and costs through all phases of a 
project from inception to handover. It receives data from VPE to 



 
 

  
 

6 

keep materials aligned with the engineering data, and also includes 
a management information system for project management. 

1.7 Summary of PDMS 12.0 Service Packs 
Please note that changes or additions made to this document for each service pack are flagged as 
below. 

1.7.1 Service Pack 1 (*12.0.SP1*)  
This was the initial general release.  

1.7.2 Service Pack 2 (*12.0.SP2*)  
PDMS 12.0.SP2.1 replaced all previous PDMS 12.0 releases and included a new Cable Design 
application and a major update to the Access platforms, Stairs and Ladders application. The DVD 
release also included additional interface products, completing the new Plant Suite. 

1.7.3 Service Pack 3 (*12.0.SP3*)  
PDMS 12.0.SP3 added schematic (such as P&ID) model data to its integrated environment. A new 
Schematic 3D Integrator product enables quick and easy browsing and reporting on those data. It can 
also link 3D objects with their corresponding schematic objects, or even build them from the 
schematic, to ensure consistency. See chapter 18 Schematic 3D Integrator. 

In addition, SP3 consolidates enhancements and corrections made in the light of early usage of PDMS 
12.0. 

1.7.4 Service Pack 4 (*12.0.SP4*)  
Enhancements to the associated products Global, P&ID Manager & Schematic 3D Integrator, many of 
which require changes to PDMS itself. In particular, PDMS Admin has been enhanced to cover the 
new functions in Global and the GUI improved. The Schematics database has been enhanced for the 
improved Schematics functions. 

SP4 sees the release of the new associated product AVEVA Diagrams, which replaces and expands 
the scope of Cable Diagrams to enable its use for P&IDs and HVAC diagrams.  

It also includes many minor enhancements and corrections to defects. This includes an improved grid 
gadget. 

The sample projects have also had many significant enhancements to provide sample data for new 
applications such as Cable Design and to correct defects. 

1.7.5 Service Pack 5 (*12.0.SP5*) 
In addition to numerous minor enhancements and corrections, this Service Pack makes provision for 
Schematics enhancements and adds GENPRIM and GENCUR (solid & curve) geometric primitives 
for the new AVEVA Mechanical Equipment interfaces – see brief description in section 1.6.2 and an 
overview in Chapter 22. 

A new Status Control concept has been introduced – this covers the Control and Monitoring of both 
2D & 3D object status in the appropriate applications. 



 
 

  
 

7 

There are also improvements to the PDMS Piping application (Production support, Wall thickness, 
Flange Offsets) and enhanced password security in command windows and files. New at PDMS 
12.0.SP5 are the specialised Nuclear Applications – AVEVA Nuclear Concrete Design, AVEVA 
Nuclear Room Manager and AVEVA Nuclear Concrete Quantities. 

There are significant changes to the associated Schematics products, including enhancements to the 
Schematics database schema. Access to this database is now licensed, which may have some 
implications for the way these products are used – see section 6.12. 

The AVEVA Schematic Model Manager replaces and extends P&ID Manager and there are 
enhancements, mostly related to instrumentation, in AVEVA Diagrams.  

The obsolete SAINT module has been removed.  
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2 PDMS 12.0 

PDMS 12.0 is a major update – the biggest ever – that includes significant enhancements to the 
database structure and the underlying system technology as well the new Design Platform. In 
addition, there is improved workflow support for many engineering design disciplines, including 
some new to PDMS. The main reason for all these changes is to provide a more productive 
environment for all disciplines, both old and new. 

There are of course many additions to the database to provide new functions and new applications – 
including the new engineering disciplines. In addition, there are options for alternative hierarchies – 
for example, to present a view more suited to fabrication or assembly. Further flexibility is provided 
by an ability to group objects across the usual database boundaries. 

The design applications for each discipline have been much improved to incorporate all these changes 
and to further enhance their users’ productivity by improving their ease of use. 

Integration within and between disciplines within PDMS in improved by a new concept of 
‘associations’ which allows rules to store relationships between objects – these rules are stored 
separately to provide flexibility of access and can be checked to ensure that relationships are not 
compromised during design changes. 

An overview of all these changes is included in this bulletin with the details documented in a 
completely updated set of manuals. 

2.1 Overview of enhancements 
PDMS 12.0 is the first version of a new generation of Plant Design products based on the new 
AVEVA Design Platform. This platform has been designed to provide a solid technical foundation for 
both Marine and Plant design for the next ten years.  

The first release of the system in late 2007 included all the major products; the second release in mid 
2008 completes the full suite, with a few exceptions. It includes most of the interfaces and some new 
applications. 

This section highlights the major enhancements provided in PDMS 12.0. The upgraded Design 
Platform includes an extended and more flexible database, with improved facilities for reporting and 
customisation, including PML. It provides a common Administration and Catalogue for all the 
relevant products. Many system limits have been relaxed and the User Interface has been extensively 
improved. In addition, all the PDMS engineering applications have been updated and extended – with 
provision for some new ones. 

2.1.1 User interface  
The new Design Platform is based on Microsoft’s .NET Framework 2.0, which provides excellent 
compatibility with Windows XP (and future versions of Windows) and simplifies integration with 
other Windows software. It provides an environment similar to Microsoft Office, which can be 
configured to suit the individual user. Increasing use is made of standard system components for 
operations such as printing and file browsing. 

Changes are obvious from initial login, where there is now an option to use the Windows login 
authentication to bypass the PDMS login and password. 
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To provide the tools needed for wider use of the platform, it is now possible to have a wider variety of 
Explorers and Graphical displays and a database search facility is provided. Results from this search 
are shown in a new tabular grid gadget and can be manipulated in a manner similar to a spreadsheet.  

2.1.2 Customisation  
The rich and powerful user interface tools provided by .NET are being used to provide better 
integration and a more sophisticated user interface. They can now be accessed from users’ and 
potentially third parties’ PML programs using the new PML.NET tools.  In addition the PML user 
interface tools have been enhanced – for example, the command line window has been completely 
overhauled and provides facilities for running macros and extensive cut-and-paste capabilities. For 
details, please refer to the new .Net Customisation User Guide. 

2.1.3 Database        *12.0.sp4* 
There are new database types to cater for new applications, such as schematics, and extensive 
enhancements to existing databases to cater for all the new functions. The database now provides a 
User-defined Element Type (UDET) that can be used to provide more specific applications. This 
means, for example, that different types of Equipment may be more readily distinguished in users’ 
own specialist tools.  

Please note that PDMS and the AVEVA Marine Hull & Outfitting products are built on common 
database technology.  This means that some Hull database elements may be visible in the PDMS 
hierarchy, although it is not possible to access or build them.  Hull data may be built only when Hull 
products are used; Outfitting products can access but not build Hull data. Please note that this also 
applies if Marine databases are copied or referenced into a Plant project. 

Database objects may also be grouped together in a more flexible way and even placed in different 
hierarchies for different applications. A new concept of ‘Associations’ provides a mechanism to store 
relationships such as connectivity between objects, both within and between disciplines. A similar 
concept may be used to link design objects with documents, either internal (such as Draft drawings) or 
external (PDF files). 

In addition, several database limits, such as the number of current databases and the maximum size of 
each, have been relaxed. Number storage is now accurate enough for the largest plant coordinates to 
be used and manipulated with ease. 

2.1.4 Administration  
The Admin user interface has been extensively updated to cater for new functions and simplify the 
administrative role. In particular, a new access control assistant provides a much simpler way of 
defining the required access to data for different users. 

There is a completely new Lexicon user interface to cover the dictionary database used for User-
Defined Attributes (UDAs) and User-Defined Element Types (UDETs). 

For details, see Chapter 6. 

2.1.5 Catalogues & Specifications  
A completely new application provides access to all aspects of the Cats & Specs environment, 
including Catalogue, Specification and material properties. It also covers new facilities such as 2D 
symbols for Schematics (for future development) and for certain types of 3D drawings. A new 
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Explorer provides suitable access to the data. Objects may now have connections for other disciplines 
such as Electrical and HVAC ducting. 

The scope of the catalogue has been further increased to cover aspects of materials management with 
the introduction of part families. Each piping part has its own SCOM element, and all members of the 
family share the same geometry, connection and user defined property definitions. There are now 
branch and wall thickness tables to assist in the selection of appropriate piping components. There is 
also a new selection table mechanism for disciplines other than piping. 

2.1.6 Engineering applications     *12.0.sp2* 
The applications for each engineering discipline have been extensively updated and enhanced, in 
addition to the improved multi-discipline aspects such as associations and penetration management.  

Of particular note are the improvements to design templates for Equipment, new tools for revising and 
splitting Piping, a much-extended HVAC catalogue and a completely new application for Access 
Platforms, Stairs & Ladders.  At PDMS 12.0.sp2, PDMS includes new applications for Cableways 
(cable routes for spatial reservation) and Cable Trays. A new add-on product covers the Cables 
themselves, including both schematic diagrams and 3D. 

Equipment 
There are many enhancements to the Equipment application, with the emphasis on ease-of-use.  

Design templates can now be selected via a specification, with changes in the template easily 
propagated to all instances in the project. These specifications may reference components (SCOM) 
containing parameters for a family of equipment components.  

Parameterised obstruction volumes and maintenance volumes can of course be incorporated into the 
template definition. Users can specify parametric or non-parametric equipment assemblies in an 
intelligent manner, using a variety of common parts for reuse, without the need to write bespoke PML 
applications. 

Templates can also manage multiple repeat elements, such as the rungs on a ladder, as part of their 
core capability.  

Piping 
Enhancements in the piping applications include a simpler but better way of specifying mitred bends 
and utilities for re-organising pipes, for example splitting them or changing the bore and/or piping 
specification. 

There are new facilities for defining and using commonly-used piping assemblies such as vents, 
drains, control sets etc. 

In common with other disciplines, pipes may be organised into systems in addition to their normal 
geographical hierarchy.  

A major enhancement is to include the automatic Pipe Router as a standard part of PDMS. This, in 
combination with the interactive Pipe Editor, provides a truly productive piping design environment. 

Ducting / HVAC 
The HVAC application also includes improved modelling utilities for splitting and data checking. Its 
catalogue is extended with a range of flexible ductwork and it is now easier for the user to define 
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joints. In addition, there is a new type of automated deliverable – detailed spool sketches for 
fabrication. 

Structures – new Access platforms, Stairs and Ladders (ASL) 
PDMS 12 incorporates a completely new application for the design and detailing of access platforms, 
stairs and ladders. Its user interface is designed to be fast, powerful & easy to use and has high levels 
of 3D graphical interaction. 

The new application is highly configurable so that it can easily be adapted to structural standards 
(DIN, ANSI etc) as required.  

It uses fully parameterised definitions for the various components (Stair Tower, Stair Flight, Stair 
Landing, Platform, Ladder, Cage, Handrail) and stores the design intent so that the design is quick and 
easy to modify. It covers all stages of design from concept to detail: default configurations and simple 
routing options enable a fast initial definition, which may be refined as more data becomes available. 

The use of standard structural sections for the detail design enables a detailed material take-off (MTO) 
and assessment of weight etc.  

Please note that some parts of the application are not yet fully complete. For details, please see section 
13.1. 

Electrical Cabling Applications 
There are three components of the new applications for cabling: Cableways (volumes), Cable trays 
and the cables themselves. Cableways and Cable trays are included in PDMS but Cable Design is an 
add-on product.  

Extensive catalogues for rectangular and circular cableways, together with over 22000 cables are 
included. VANTRUNK and ØGLÆND cable trays are also covered. 

Cableways are used to reserve space and provide routing points, obeying the various rules according 
to cable classification.  

Cable trays have new spec capabilities and can be automatically or manually created. Existing 
catalogues can be used but need upgrading to take advantage of the new functions. 

Cable design takes the connectivity model, which can be imported from a diagram or CSV file or 
manually input, and determines the route. The system can output single line or core diagrams, lengths, 
mark points. 

Nuclear Applications 
There are 3 new applications, earlier versions of which are also available for PDMS 11.6: 

AVEVA Nuclear Concrete Design – a highly productive, specialised application for the design of 
complex concrete structures for nuclear power plant. 

AVEVA Nuclear Concrete Quantities – specialised reporting for the nuclear power plant 

AVEVA Nuclear Room Manager – a specialised application for managing nuclear power plant design 
by Room, Volume or Area. 

2.1.7 Drawing Production 
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Additional representation options in Draft – for aspects such as line-styles – make it easier to comply 
with industry standards. The use of colour has been improved to cover a wider range of colours, 
including the standard AutoCAD colours, and colour may now be selected independently of line style. 
TrueType text fonts may be used in place of the standard PDMS ones, which are expected to be 
phased out in due course. 

Draft’s drawings of the 3D model may now include a symbolic representation of an object, scaled to 
suit, rather than the full 3D representation. This is expected to be of great use, particularly the in new 
engineering applications such as electrical. 

New output formats such as Adobe’s PDF, Windows meta file and various image formats including 
TIFF are now available from Draft. 

2.1.8 Schematics       *12.0.SP5* 

The availability of tightly integrated Schematics products based on the AVEVA Design platform, and 
using a dedicated Schematics database, marks a major change at the PDMS 12.0 release. Significant 
improvements have been made at each service pack. These products now include AVEVA Diagrams, 
AVEVA Schematic 3D Integrator, and AVEVA Schematic Model Manager as well as AVEVA 
P&ID. Changes at SP5 include improved handling of instrumentation aimed particularly at improved 
integration with the new AVEVA Instrumentation product. These associated products are noted in the 
next section but have their own manuals and are not fully covered in this document.  

2.1.9 Status Control      *12.0.SP5* 
Status Control is a set of new functions that provide the ability to control and report on the status of 
individual model objects as they progress through their lifecycles. It can be applied to any model 
objects, e.g. tagged items, catalogue components, drawings, etc. A brief overview is given in chapter 
20 and a new manual provides full details. 

2.2 Documentation     *12.0.sp5* 
The entire documentation set has been revised and updated; it is now available in both PDF and 
installed Help versions.  

Some manuals have been withdrawn or renamed to reflect a different emphasis; there are also many 
new manuals for PDMS 12. They now include: 

• Minimum System Requirements Plant – gives advice on hardware and operating environment 
required for PDMS & Associated products 

• Database Management Reference Manual 
General information about database philosophy and navigation 

• Data Model Reference Manual  
Information about database elements & attributes (Plant & Marine) – replaces DESIGN 
Reference Manual part 3. 

• Design Common Functionality User Guide  

• Lexicon User Guide 

• Catview User Guide  
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• Drawing Production User Guide 

• Catalogues and Specifications User Guide 

• Catalogues and Specifications Reference Manual  

• Equipment User Guide 

• Structural Design 

• Status Control 

• AVEVA .NET Customization User Guide 
Using C# & Visual Studio for development of .NET add-ins for PDMS & Marine  

Installing PDMS also installs the manuals for some of the associated products so that they are all 
listed in one index. This includes Area Based ADP, Cable Design, Diagrams, Final Designer, MDS, 
Nuclear Applications, Schematic Model Manager, Schematic 3D Integrator, PML Publisher, SQL-
Direct and a number of interfaces. Installing the manuals does not mean that the products themselves 
are available; a separate license file entry and in some cases separate installation is required. 

2.3 Associated products 

2.3.1 AVEVA Global 12.0 
Global has been enhanced to cater for the largest projects, to give better diagnostics and to cater for 
the enhancements made in PDMS 12, including: 

• Propagation of Schematics and other new Marine database types and drawing files 
• Removal of the limit of 500 drawing picture files per database  
• Support for multiple drawing picture sub-folders 
• Improved updates for Extract operations  
• Enhanced diagnostics, including more information on remote copy operations 
• Better reliability of REMOTE MERGE operations, in order to prevent unnecessary secondary 

merges 
• Improved support for drawing files in extract databases – prevention of deletion when two 

extracts use the same file 

In addition, the licensing method has been changed to allow a Global Satellite to use a Hub license if 
no satellite license is available. 

AVEVA Global 12.0.SP4       *12.0.sp4* 
PDMS 12.0.SP4 supports the use of this new release of Global; use with earlier versions of Global is 
not supported. This new release uses additional features in the Global daemon to allow a number of 
significant enhancements, similar to those in Global 2.5 for PDMS 11.6.SP5. These include 
significant improvements in update speed and several enhancements aimed at providing better 
feedback to users, as well as some giving additional control of Global functions. The robustness of the 
daemon itself has been improved to minimize the number of occasions it needs to be re-started. 

The new features in Global are documented in this release bulletin and updated versions of its other 
manuals. 

Please see the AVEVA Global User guide for detailed information. 
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2.3.2 AVEVA Multi-Discipline Supports (MDS) 12.0 
A number of enhancements have been made since the initial release of MDS version 11.6; some were 
also included in later service packs.  

A major change for PDMS 12 is that MDS parameters are now stored in the catalogue database, thus 
allowing a much faster start-up time. In addition, it is easier for users to define their own standards for 
ancillary types and reports may now be directed direct to Excel rather than via a CSV file. 

Other new features include: 

• Ancillary Clearance Values 

• Health Check Utility – to check integrity of support data 

• Snipes on steelwork frameworks 

• Framework Bracing 

• Automatic Steelwork Orientation 

• Lighting Supports 

Please see the AVEVA MDS User bulletin for detailed information. 

2.3.3 AVEVA Area-Based ADP (ABA)     *12.0.sp2* 
Major updates have been made to Area-Based Automated Drawing Production for compatibility with 
PDMS 12.0 and to improve its robustness. Appropriate changes have also been made to the manuals 
and to MDS; users will need to make adjustments to any other use of the system – see section 0. 
Major updates cover the following:  

• The new line style and colour changes 

• List Column gadget replaced by a .net GRIDCONTROL 

• The implementation of True-Type fonts 

• Spaces in file names 

Please see the Area Based ADP Administrator Guide and User Guide for detailed information. 

2.3.4 AVEVA Laser Model Interface (LMI) 12.0 
LMI has been updated for compatibility with PDMS 12.0 but there is no major change at this release. 

2.3.5 AVEVA Model Management 12.0 
Model Management 12.0 is compatible with both PDMS 12.0 and 11.6.  

Clash Manager may now be used in stand-alone mode only (i.e. without connecting to VPE) with a 
SQL-Server database as an alternative to Oracle.  

For details, please see the Model Management User Bulletin. 

2.3.6 AVEVA SQL-Direct 12.0 
SQL-Direct has been extended to work with MSDE, and thus with multi-threaded applications. 



 
 

  
 

15 

2.3.7 AVEVA QUERY 12.0 
QUERY is loaded with PDMS 12.0 and works in the same manner as earlier releases. 

2.3.8 AVEVA Diagrams      *12.0.sp5* 

AVEVA Diagrams, used for creating P&IDs and HVAC diagrams,  saves both the diagram and the 
engineering objects in the Schematic model database. The product and its data model have been 
improved at SP5 for advanced instrumentation diagrams. This enables users to define separate lines 
and instrumentation loops which are clearly differentiated from Pipelines and the main flows. Details 
of updates at SP5 are given in Chapter 20. 

2.3.9 AVEVA Schematic 3D Integrator     *12.0.sp4* 
This is a new product at PDMS 12.0, initially called P&ID 3D Integrator. The Integrator provides an 
integrated environment for both schematic and 3D models, enabling quick and easy browsing and 
reporting on the data. Integrator can also link 3D objects with their corresponding schematic objects, 
or even build them from the schematic, to ensure consistency.  

Schematic Integrator has been further extended at the 12.0.SP4 release in the light of feedback from 
early adopters. In particular, the same object name can now be used for an element in a schematics 
database as is used in a design database for the equivalent 3D element. 

See Chapter 18 – Schematic 3D Integrator. Full details can be found in the AVEVA SCHEMATIC 3D 
Integrator User Guide. 

2.3.10 AVEVA Schematic Model Manager    *12.0.sp5* 

AVEVA Schematic Model Manager is a new product at PDMS 12.0.SP5, which replaces AVEVA 
P&ID Manager and is used to import P&ID data into PDMS Schematic databases. The P&ID data is 
imported from an XML file, the content of which complies with ISO 15926. The ISO 15926 data may 
be exported from AVEVA P&ID and from other supported P&ID systems. Schematic Model 
Manager, unlike its forerunner P&ID Manager, is accessed via the Plant and Marine login dialogue or 
by the module change mechanism. 

Full details can be found in Chapter 19 and the AVEVA SCHEMATIC Model Manager User Guide. 

2.3.11 AVEVA Review 6.4 & 12.0 – and ReviewShare 

AVEVA ReviewShare 
ReviewShare is a new, freely downloadable application designed to be particularly easy to install and 
use. It offers a threaded document based collaboration with an integrated streaming 3D viewer for 
easy 3D navigation. It includes mark-up capabilities, together with the option to include other 
graphics as bit-maps, to provide a simple but effective medium for discussion based around the 3D 
model.   

AVEVA Review 6.4  

• Supports the publishing of models to the ReviewShare server and the preparation of 
ReviewShare documents  
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• Has additional VizStream ZGL translators  

• Extends the Laser Model Interface (LMI) API to enable enhanced interaction with as-built 
models 

• Provides enhanced Section Planes and Clip Volumes 

• Introduces a new Quick Find facility and the Export of Textures  

AVEVA Review 12.0        *12.0.sp5* 
Review 12.0 enables direct access to live PDMS 12.0.SP3 data, together with further ReviewShare 
integration and support for further 3D model formats, and Workspace Management. Later service 
packs of Review 12.0 are available for later service packs of PDMS. 

2.3.12 AVEVA P&ID 12.0.SP1      *12.0.sp5* 

AVEVA P&ID 12.0.SP1.0 is now available for install from the AVEVA Plant Design (and AVEVA 
Marine Design) Product DVD. After installing AVEVA P&ID 12.0.SP1.0 please download and install 
the Partial Fix Release 90130, AVEVA P&ID 12.0.SP1.1. Fix Releases can be downloaded from 
AVEVA Support website.      

2.3.13 AVEVA Interface products     *12.0.sp5* 
The following interface products are available for release with PDMS 12.0. 

AVEVA Open Steel 12.0 

AVEVA Pipe Stress Interface (PSI) 12.0 

AVEVA ImPLANT-I 2.1 

AVEVA ImPLANT-STL 1.2 

AVEVA ExPLANT-I 1.3 

AVEVA ExPLANT-A 1.1 

AVEVA Final Designer 1.3 

This is compatible with AutoCAD 2006 and is largely unchanged since PDMS 11.6. 
However, changes have been made to DRAFT to support PDMS 12.0 functions.  

2.3.14 Catview        *12.0.sp4* 
Catview is an unsupported ‘freeware’ application for piping catalogues. It has been updated for 
PDMS 12.0 but is no longer distributed on the release DVDs. Copies are available on the AVEVA 
web-site or by request from your local AVEVA office. 

2.4 Operating Environment 
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2.4.1 PC hardware configuration 
A minimum of 1 GB of memory is recommended for this release. PDMS 12.0 will operate with less, 
but system performance will be compromised.  A screen resolution of at least 1280x1024 is 
recommended, though most users now use either two such screens or a wide-screen display.  For 
details, please refer to the Minimum Systems Requirements manual. 

2.4.2 Microsoft Windows      *12.0.sp4* 

Desktop 
PDMS 12.0 is supported for use on Microsoft Windows XP Professional Service Pack (SP) 2 or 3, 
with appropriate patches. It is not yet supported on Windows Vista – please see section 2.9.2 below. 
Limited support for PDMS – but NOT Global – is available on Windows 2000 Professional; please 
note that Microsoft no longer offers mainstream support for this. This limited support will be 
withdrawn at PDMS 12.1 (see section 2.9.3). 

Windows XP SP2 or 3 require changes to the default settings.  The Internet Connection Firewall (ICF) 
should be turned off or configured to enable access to the database & license servers.  In addition, 
Group Policy changes (which alter the registry) are required for users of Global projects to ensure that 
RPC requests do not require authentication.  Details are given in the Installation Guide. 

Server 
PDMS does not usually run on the server but relies on it for file-handling. The license server software 
may be installed on the server or on any accessible desktop. The server operating system should be 
Windows 2000 Server or Windows 2003 Server, with the latest service packs and patches. (The 
Global daemon requires Windows 2003 (or XP) or later to support its extended diagnostics.) 

Please note that AVEVA no longer supports the use of Samba on IRIX servers for use with PDMS. 

2.4.3 Microsoft .NET Framework & fonts 
PDMS 12.0 requires Microsoft’s .NET Framework 2.0, which is supplied on the DVD and installed if 
required. This is used for the PDMS graphical user interface. It should be noted that it is possible to 
install multiple versions of .NET in order to support other applications – such as PDMS 11.6, which 
requires .NET 1.1. 

Serialization 
Please note that serialized settings (of the user interface configuration) are now saved in the following 
location:  
C:\Documents and Settings\<USERNAME>\Local Settings\Application Data\Aveva\PDMS 

2.4.4 Microsoft Office       *12.0.sp4* 

Excel interoperability 
Import of data into a grid control requires an optional component from Microsoft Office. This is not 
supplied with PDMS but is an installation option for Microsoft Office. Please ensure that “.NET 
Programmability Support” under “Advanced customization of applications” is enabled when Office is 
installed.  
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This will install the Microsoft Microsoft.Office.Interop.Excel.dll. If this assembly is not enabled, 
invoking the Excel import facility will not work. 

Screen font for GUI 
The PDMS user interface (version 11.6 onwards) requires the use of the Arial Unicode MS font, 
which is supplied with Microsoft Office (version 2000 onwards) and is usually installed automatically 
when using Windows XP. For further information, please refer to http://office.microsoft.com/en-
us/help/HP052558401033.aspx. If this font is not installed, some of the text in the PDMS user 
interface may become illegible. 

2.4.5 Graphics cards 
Due to the rapidly changing list of hardware-accelerated OpenGL graphics cards commercially 
available, an up-to-date list of supported graphics cards is not included in the documentation released 
with PDMS. The AVEVA Web-site (http://www.aveva.com) – Product Support section – contains a 
list of tested and supported graphics cards. 

2.5 Upgrading from PDMS 11 
PDMS 12.0 is a major update from earlier releases of PDMS but every effort has been made to 
simplify the upgrade process.  Most of the database updates are automatically applied when using 
PDMS 12. Please note that once a database has been written using PDMS 12, it will no longer be 
accessible by PDMS 11. Upgrade scripts are provided to upgrade projects from PDMS 11.6. It is 
strongly recommended that projects are backed up before commencing the upgrade process. 

Global projects should be upgraded at all sites simultaneously; the recommended procedure is to 
consolidate them at the hub, perform the upgrade and re-distribute as required. 

It should be noted that PDMS 12.0 databases will not be accessible by PDMS 11.x due to format 
changes. However, the inconvenience should be minimal as PDMS 12.0 can access PDMS 11.6 
databases (in read mode) from a ‘foreign’ project.  

Users’ own PML applications from PDMS 11.4 onwards should continue to work, after being 
amended to use the new application switching mechanism.  Please see Chapter 23.  It is possible that 
some form layouts will be adversely affected by the change at PDMS 11.6 to the standard Windows 
proportional screen fonts, though this depends on the way the forms have been defined.  There is also 
scope for enhancement by using the new facilities offered by PML, such as toolbars and docking 
forms.  Many of the AVEVA applications have been upgraded in this way, so users who have revised 
the AVEVA applications should review their changes in the light of this work. 

Any Data Access Routines (DARs) programs must be re-compiled – please see note below. 

2.5.1 Summary of project upgrade process    *12.0.SP5* 
There are major changes to PDMS databases between PDMS 11 and PDMS 12, including many 
extensions, more accurate (double precision) numbers and changes to Draft pens. There are also 
changes to the system database to enable many of the new functions in PDMS 12.  

Draft Picture files are now stored in a more complex directory structure to cope better with very large 
volumes of drawings – for details, please see section 16.7. The Picture files also need to be upgraded 
to cope with the more accurate coordinates.  



 
 

  
 

19 

The upgrade to increase accuracy is performed ‘on-the-fly’ by changing data as it is updated in the 
normal course of design work. It is not necessary to use the database Reconfigurer function but it is 
necessary to perform some major upgrades on the DRAFT (Paddle) databases. A script is provided – 
see section 2.5.2 below. 

The upgrade process is initiated by a Free User, who is allowed to enter PDMS 12 Monitor and 
Admin in a PDMS 11.6 Project in order to run the main script upgradeMac. Before doing this, the 
following actions should be performed: 

• Ensure that there are no extracts on PADD databases and that they have been synchronised at 
the hub for Global projects 

• Run the upgrade script, which works on both Global projects (see note below) and non-Global 
projects. Please note that it may be simpler to consolidate a project at the hub and then re-
distribute after performing the upgrade. 

Please note that any attempt to access a constructor module before completing the upgrade will result 
in an error message: 

 
Error attempting to access a PDMS 11 project using PDMS 12 

Among other things, the upgrade process will: 

• Enter Admin  

o Delete and re-create the COMMS elements to allow larger MDBs 

o Mark the project as a PDMS 12 project 

o Update the module definitions, including removal of the obsolete DESCOMP module 
and its COMP databases 

• Enter DRAFT 

o Create a new DRAFT (PADD) database (MASTER/STYLWL) with a STYLWL and 
add it to relevant MDBs 

o Read %pdmsdflts%/dra-pens and dra-lindef and create definitions of user 
defined pens if necessary 

o Run the command UPDATE STYLEATTS on all current PADD Databases  

o Create a new directory structure for DRAFT Picture Files 

o Optionally regenerate the picture files to cater for increased accuracy  
(this is the time-consuming step) 
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Notes: 

• DRAFT databases that do not belong to an MDB will be missed, as the process upgrades each 
MDB containing one or more PADD databases. Users are advised to create a temporary MDB 
for all such ‘orphan’ databases, if any. 

• For a Global project the sequence should be:- 

o At the Hub (where the STYLWL should be created) go through all PADD databases 
(those that are primary at the Hub will be writeable, those that are non-primary at the 
Hub will be read-only); add all necessary pen information to the new STYLWL (which 
is writeable at this location) 

o Propagate the db containing the STYLWL to all locations. 

o At each location go to each PADD db and run the Update Style Attributes 
command. 

• If applicable, the user should delete and re-create all Isodraft symbol files. 

• TrueType fonts are available in PDMS 12 but may not be mixed with the older PDMS fonts 
(font families 1 to 4) in any way. If you wish to upgrade libraries or drawings, it is therefore 
necessary to output them to a Data Listing, edit it to change the fonts and then re-input: 
libraries and then drawings. Before re-input, the receiving project should have suitable fonts 
created as new font families (from 5 onwards). 

• It is advisable to update the spatial map after upgrading a project to PDMS12. This can be 
achieved using the command MAP BUILD MDB. 

2.5.2 Performing the upgrade process    *12.0.sp4* 

Upgrade macro files 
Five Macro files are included with the PDMS 12.0 DRAFT user interface (default location 
C:\AVEVA\plant\PDMS12.0.SP4\pdmsui\dra\upgrade) 

The location of these files is referenced by a global variable in the main Upgrade macro 
UpgradeMac (!!upgradeDirectory = '%PDMSUI%\DRA\upgrade’) 

The upgrade uses a function called tstAllocRecdPM.pmlfnc which will need to be enabled using the 
command: 

PML REHASH ALL 

As part of the upgrade process, the project is locked to prevent new users from accessing it. There is 
no User prompt. All Users are expunged, and all entries in the COMMS database are deleted. This is 
in order to increase the number of DBs in an MDB from 300 to 1000.  

Non-Global projects 
If the project is not Global, the process is very simple. The upgrade is initiated by running the 
upgradeMac macro from the Monitor command window, either by typing: 

$m/C:\AVEVA\plant\PDMS12.0.SP4\pdmsui\dra\upgrade\upgradeMac 

or by dropping the upgrade macro on to the command pane.  

The process is tracked by writing 2 files in %PDMSUSER% as it progresses:- 
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1. Logfile<proj code>   ALPHA LOG file: echo of the console window 

2. UpgradeLog<proj code>  Upgrade results file reporting success/failures 

If these log files show no problems, the project itself should be reviewed to check that all is well. It 
might also be worthwhile checking the database integrity using DICE. The project should now be 
ready for use with PDMS 12. 

Global projects  
Global projects require a little more work – it may be easier to bring all the data back to the hub for 
the upgrade. However, this is not always possible so the upgrade process can be carried out globally if 
a few additional steps are taken – note that all sites must be upgraded before the project is used. 

When upgrading a Global project, the daemon must be stopped at all locations. Upgrading from an 
earlier release of PDMS 12.0 is straightforward; the new daemons should be installed at each location 
and then restarted. Upgrading from PDMS 11 needs the upgrade script to be run at the HUB and the 
Global database copied to all Satellite locations.  

If upgrading from PDMS 11.2 or 11.3 (Global 1), the transaction database for each satellite should 
also be copied to the satellite. (It is not necessary to copy the transaction databases when upgrading 
from Global 2.1.0 or later.) 

The upgrade script should then be run at each satellite. All the projects associated with the global set-
up must be upgraded before the upgrade is complete. Daemons can then be restarted and you should 
INITIALISE each satellite. 

Please see the AVEVA PDMS Installation Guide and the AVEVA Global Installation Guide. 

Summary process for upgrading Global projects from PDMS 11 to PDMS 12 
Preliminary checks: 

Ensure that the HUB has an up-to-date view of every non-propagating PADD database which is 
primary elsewhere. This is necessary to gather all required pen data at the project HUB. 

• This may mean issuing manual UPDATE DB commands for non-propagating PADD 
databases which are primary at satellites 

• EXTRACT FLUSH DB for all PADD working extracts at satellites (if any) 

• All locations must have their old daemons stopped, and their new Global 12.0 Daemons 
restarted prior to starting the upgrade process.  
Make certain that the Daemons are running 

• Stop any update events 

Upgrade process: 

1. Run the upgrade at the HUB  

As above, enter Monitor and run:  
$m/C:\AVEVA\plant\PDMS12.0.SP4\pdmsui\dra\upgrade\upgradeMac 

This performs the upgrade and propagates a PADD database MASTER/STYLWL to satellites. 
Log files are written as above. It is best to wait for the whole hub upgrade to finish before 
attempting to upgrade the satellite locations. 

2. Review the results  
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3. Run the upgrade at each SATELLITE, after checking that the propagated STYLWL 
database has arrived: 
$m/C:\AVEVA\plant\PDMS12.0.SP4\pdmsui\dra\upgrade\upgradeMac 

This performs the upgrade and allocates a PADD db to satellites 

4. Final review of the results – check the project at each site! 

Please note:  

The Global Daemon is no longer supported on Windows 2000 or Windows 2000 Server. The daemon 
will no longer run on this operating system, as it now makes use of some diagnostic functions that are 
not available on Windows 2000. 

2.5.3 Upgrading Area-Based ADP tasks    *12.0.sp2* 
At version 12.0, there have been changes to the way in which Task elements are modified. 

If you have created any of your own Tasks that have an associated form, for example as with the 
system task *Arrange_Labels and its form !!abaArrange, then you will need to make the following 
modifications to the form definition file. 

1. Add two new form members in the setup form section as follows; 
   member .task  is ABATASK 

   member .form       is FORM 

The member .task will hold the object definition for the task being modified and the .form method 
will hold details of the form that called the form being used to modify the parameters. 

 

2. The method .apply() (or whatever your call back is named) must now carry out the two 
following actions; 
  -- Reset the task object 

   !this.task.paramVal = !parameters 

    -- Transfer the modified task back to the calling form 

    !this.form.receiveTask(!this.task) 

The first action is to reset the task object held in the form member .task with the values for the 
modified parameters, hence the variable !parameters is significant. 

The second action returns the modified task object to the calling form. Consequently, all forms that 
allow the modification of Task parameters now contain the method .receiveTask(ABATASK). 

2.5.4 Mixing PDMS 12 and PDMS 11.6 projects 
PDMS 12.0 projects may continue to use PDMS 11.6 databases as foreign databases, so there should 
be no need to maintain two versions of shared corporate catalogues until all projects have been 
upgraded and the corporate catalogue projects are done last. Any foreign projects that contain Draft 
Admin elements, for example Back Sheets, etc must be upgraded first. However, PDMS 11.6 projects 
cannot use PDMS 12 databases, so this does need to be planned carefully.  

Once the database includes elements that use the newly increased accuracy, its use in PDMS 11.6 will 
be incorrect and unpredictable, so this is prevented. Any attempt to enter an upgraded project (or a 
newly created PDMS 12 project) using PDMS 11.6 will result in an error message: 
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Error attempting to access a PDMS 12 project using PDMS 11 

2.5.5 Features removed at PDMS 12 
The syntax in the project creation program MAKE no longer has the command for specifying 
pathnames for database schema files. This has been obsolete since PDMS 11.3, when these files were 
moved to PDMSEXE, but was retained through the PDMS 11 lifecycle for upwards compatibility. 

The COMP database has been removed as the DESIGN COMPARE option is no longer available: it 
has been replaced by the new SCHEMATIC 3D Integrator. 

2.6 Upgrading from earlier PDMS 12.0 releases  *12.0.SP5* 

2.6.1 Upgrade from P&ID Manager to Schematic Model Manager 

Users who have been running a project using PDMS 12.0.SP3 or 12.0.SP4 will need to upgrade it, 
using a macro supplied. 

The main reason is to ensure that the new Schematic Model Manager module is loaded into the 
module list. The process will also remove any references to the Cable Diagrams and Marine Diagrams 
modules and replace them with the Diagrams module. If this has already been done, perhaps at 
12.0.SP4, the macro will ignore this part and continue. 

Schematic data already stored in SCHE databases, if any, will also be upgraded: 

At 12.0.SP5, schematic off-line instruments (SCOINS) can have an array of references 
stored in a SCIREF attribute. In previous versions, the SCOINS could only have a single 
reference stored in a CREF attribute. The macro collects all the SCOINS from all the SCHE 
databases and moves any existing CREF attribute onto the first array connection of the 
SCIREF attribute.  

To perform the upgrade, the user must have FREE access to the project and there should be no users 
accessing the project. If a project has no schematic data, the macro should still be run for any project 
that will use any of the above modules to ensure they are correctly set up. Foreign SCHE databases 
will be ignored, so the upgrade must be done on each project.   
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Any extra schematic databases must have all data issued to the parent. Only the parent databases will 
be upgraded, not the extracts. In addition, only the original schematic databases will be upgraded, any 
copy databases will be ignored. 

To run the macro, enter the project and type the following: 

$M/%PDMSUI%/ADM/ADMIN/UPGRADESP5.PMLMAC 

It does not matter which module the macro is run from; it will leave the user in the ADMIN module. 
After the macro has been run the user should inspect the following log file: 

%PDMSUSER%/upgradeLog<proj code> 

Any warnings or errors are logged in this file. As an example, it might not be possible to update a 
SCOINS object, perhaps because it is locked. This will be logged so that the user can take corrective 
action – in this instance, the user could unlock the SCOINS objects and re-run the macro.  

2.6.2 Setting Schematic Model Manager options 

For projects upgrading from 12.0.SP4 

Schematic Model Manager will automatically copy its options files from the P&ID Manager folder, 
e.g. C:\Aveva\Projects\xxx\xxxdflts\P&ID Manager\Options,  

to the new project defaults schematic configuration folder,  
e.g. C:\Aveva\Projects\xxx\xxxdflts\Schematic\Configuration 

For projects upgrading from earlier versions 

The options files must be manually copied over from their location in the installed executable folder, 
e.g. C:\Aveva\Plant\Pdms12.0.SP3\P&ID Manager\Options, 

to the project defaults schematic configuration folder,  
e.g. C:\Aveva\Projects\xxx\xxxdflts\Schematic\Configuration 

In all cases 

Check that all mandatory UDAs have been made available. Enter Lexicon, click on Schematic Model 
Manager > UDA Catalogue, make any changes needed to the selection, and press Apply. 

2.6.3 Upgrading Existing 3D Integrator Projects 

The SP5 version of Integrator has a new ProjectConfiguration.xml file in the installed executable 
folder. There are only minor changes in this version. 

Existing projects may copy the new ProjectConfiguration.xml file to the 
<project>dflts\ModelManagement folder and then modify it according to their own requirements. 
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Alternatively, the existing file may be modified if required. Administrators should ensure the 
appropriate environment variable, e.g. xxxdflts, is set. 

If syntax errors are reported following Integrator > Show from the main menu, the 
ProjectConfiguration.xml file is an old version and must be modified or replaced. The probable reason 
is that there are rules defined using selectors that have not been entered in the Spec Queries section. 
Here is an example with STYP added. 

 

If existing projects have their own copy of the the HVACStypeTable.xml file in the 
<project>dflts\ModelManagement folder, this should be deleted. Integrator will then look for this file 
in the installed executable folder. This file should only be copied to the 
<project>dflts\ModelManagement folder if it is to be modified to suit project requirements. 

2.6.4 Change to policy for .NET assembly versions  

Customers who have written PML.NET applications for earlier releases are advised to refer to section 
23.1.1 in the Customisation chapter. 

 

2.7 Compatibility 

2.7.1 AutoCAD       *12.0.sp2* 
PDMS 12.0 AutoDRAFT and DXF output functions have been designed and tested with AutoCAD® 
2006 and 2007. No later version of AutoCAD is supported, 

Final Designer (version 1.3.SP2, available on the PDMS 12.0 DVD) is compatible with PDMS 12.0 
and AutoCAD® 2006, but not 2007 or later, and is unchanged since PDMS11.6. PDMS 12.0 is not 
compatible with earlier versions of AutoCAD.  

2.7.2 Data Access Routines (DARs) 
Any Data Access Routines (DARs) programs must be re-compiled in Double Precision (/real-size:64) 
to work with PDMS 12, using a (different) IFORT compiler. There is no change to the C compiler. 

In addition, changes to the Property database made at PDMS 11.6.SP4 may also require minor 
changes to be made to DARs programs. Prior to this, a DARs program had to navigate to the relevant 
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CMPD or TUBD element and then query the real attribute, in order to obtain a property for a piping 
component or similar. DARS has been updated so that this still works for either existing data or for 
simple expressions; however, it will give the wrong answer if more complex expressions are used.  

The type of expression that will not work is one which uses PARA or DESP while a simple expression 
is similar to (33.5 * 8.6)  

To upgrade any such DARs applications, use the pseudo attribute PROPRE of the Design element, 
with the qualifier of the property required. 

2.8 Notice of change in support status  *12.0.sp5* 
The support status for all full releases of PDMS is shown on the AVEVA web-site. The release of 
PDMS 12.0 has now triggered a change of status for PDMS 11.4 and 11.5 to ‘Withdrawn’ and 
‘Limited’. 

2.9 Future considerations 

2.9.1 Withdrawal of old design applications 

Access, Stairs & Ladders (ASL)      *12.0.SP5* 
At PDMS 12.0, there is a completely new Access platforms, Stairs & Ladders application (see section 
13.1). However, this still has some limitations, so use of the old ASL application is recommended, 
even though it will be removed at a future release. It is available, hidden, at PDMS 12.0 and can be 
reactivated by a simple edit to the PML file PDMSUI/des/addins/access:  

This file is all commented out; activate all the code lines after the header and ensure that the 
application is shown on the menu: 

showOnMenu: TRUE 

 

Hangers & Supports 
At PDMS 12.0, the recommended application for Pipe Hangers & Supports is the Multi-Discipline 
Supports (MDS) add-on product. The old Hangers & supports application will be removed at a future 
release but is available, hidden, at PDMS 12.0. It can be reactivated by a simple edit to the PML file 
PDMSUI/des/addins/supp:  

This file is all commented out; activate all the code lines after the header and ensure that the 
application is shown on the menu: 

showOnMenu: TRUE 

2.9.2 Windows Vista & Windows 7     *12.0.sp5* 
Microsoft released the Windows Vista in late 2006, followed by the first service pack in Spring 2008. 
This is a major upgrade and requires some significant changes, including some to the installation 
procedures. AVEVA has investigated the implications and commenced preparation for its support 
with the release of an updated license server, FlexMan 4.1, which can also be used by older products.  
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The successor to Vista, Windows 7, is now expected to be released in October 2009 and seems likely 
to achieve a more rapid acceptance. Many customers have indicated that they plan to move directly 
from Windows XP to the Windows 7 operating system. 

PDMS 12.1 will be delivered in 2010 and will enable AVEVA to provide full support on Windows 7. 
To support the limited number of customers intending to use Windows Vista, AVEVA will be 
following Microsoft’s best practice guidance to ensure that the 12.1 release will be fully compatible 
with both Vista (Business and Enterprise) and Windows 7. 

Please note that almost all development at AVEVA is currently carried out using Windows XP 
(service pack 2 or 3), which is at present the preferred option. PDMS 12.1 will remain supported on 
Windows XP, with the then latest service pack. 

2.9.3 Windows 2000       *12.0.sp4* 
With the advent of support for Windows Vista and 7, support for Windows 2000, which is no longer 
supported by Microsoft, will be discontinued at PDMS 12.1.  

2.9.4 PML features 
There are many new features of PML listed in chapter 23. The following features are obsolescent and 
will be removed at a later release.  

File browser 
There is a new file browser included in the core capability of PDMS 12.0. The use of the old PML 
based one will be phased out; it will then be removed from PMLLIB at a future release. 

RGROUP gadget 
The RGROUP gadget, which replaced the withdrawn RADIO gadget, has itself been superseded by 
the radio group capability of the FRAME gadget in conjunction with RTOGGLE gadgets. It still 
exists in PDMS 12.0 and continues to work, but its use is discouraged; it will be removed in a future 
release. 

Cursor Functions 
Cursor Functions e.g. ID@, are deprecated and will be phased out. 

These functions are an input mechanism that is inappropriate to the current look and feel. It is also 
becoming increasingly difficult and expensive to maintain these demand driven input facilities in an 
event driven world. 

It is proposed to replace them by Event Driven Graphical interactions (EDG). AVEVA expects to 
provide and document a set of atomic event modes, which can be assigned to views, to allow a similar 
degree of interaction. 

Cursor functions have the following specific problems: 

• They are demand driven. The entire user interface, apart from graphical view gadgets, has to be 
greyed-out while they are in progress in order to prevent the user attempting to perform other 
operations. This is both constricting and visually obtrusive.  

• This is very slow because it has to be performed at the individual gadget level for each 
displayed form because any of them may contain one or more graphical view gadgets. 
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• Interaction is not view specific, as the cursor function might be implemented in any of the 
views. If it is not, any attempted interaction with inappropriate views must alert an error.  

• The user cannot be prompted in a specific view because its gadgets are greyed-out, and the 
interaction is potentially not view specific. The alternative is the status line, which is usually 
remote from the required interaction and hence not very helpful to users. 

2.9.5 Unicode characters      *12.0.sp2* 
PDMS has supported the use of a range of character sets for many years. This involves setting the 
character set (CHARSET) in Admin and ensuring that appropriate font files are used for the drawing 
production modules, Draft and Isodraft. A newer standard, Unicode, has the potential to support most 
world languages in a simpler manner and is used by the current versions of many other applications, 
as well as Windows. Since PDMS 11.6, it has also been used for the PDMS GUI. 

The use of Unicode should make it rather simpler to support additional languages and to exchange 
data with other applications in a variety of different languages. In combination with the use of 
TrueType text, it will also open up the use of a large range of high-quality fonts for drawing 
production. In addition, it will assist the removal of some limitations in the use of the various 
character sets. 

It is planned to use Unicode for the storage of names and text attributes in PDMS. At PDMS 12.1, this 
will be an option, in order to allow continued use of existing databases and avoid the need to 
reconfiguration. It is likely that the use of the older ‘internal’ format will be phased out at some point 
in the future. 

2.9.6 PDMS Plotfiles       *12.0.sp2 
The PDMS plotfile format has served its users well over the years but has remained unchanged for 
many years. Its scope is quite limited and it cannot cope with some of the more complex documents 
we now wish to produce. In particular, it cannot handle text that uses TrueType fonts.  

It was decided that it was more sensible to adopt one or more standard formats rather than extend the 
plot file. Any existing programs using the plotfile would in any case have to be radically changed. 

PDMS 12.0 can output Adobe’s PDF, the Windows enhanced meta-file (EMF) and a variety of bit-
map formats such as TIFF. It is proposed to drop the plotfile option at some point during the life of 
PDMS 12.1. 

In effect, its use in PDMS will largely be replaced by the EMF and its use for output by PDF. The 
EMF is an integral part of Windows and its printing system; its use will have the effect of opening 
PDMS to the use of EMF from other sources, for some purposes. The full details have yet to be 
assessed and will be announced in due course. 



 
 

  
 

29 

3 Database Enhancements 

There are very many changes to the database system and structure for PDMS 12.0. The most 
important are listed here. Full details are given in the new Data Model Reference Manual, which 
contains details of all the database types, listing their elements, their positions in the hierarchy and 
their attributes. 

3.1 New database types 

3.1.1 Schematic 
A new SCHEmatic database is provided for storage of schematics data, which is used by the new 
AVEVA Diagrams, Schematic Model Manager and Schematic 3D Integrator products. This contains a 
complete definition of the logical structure of the Plant for comparison with the 3D design. License 
files for each of these products include licenses for access to the database itself. 

3.1.2 Manufacturing & Name Sequence 
In addition, new databases are provided for MANUfacturing and NameSEQuence. These will not 
usually be used in PDMS but are used in AVEVA Marine. 

3.2 Database top level elements 
A number of new top level elements, including many types of WORLD, have been added. This list 
includes all such elements in PDMS 12.0, including the new ones, with additions indicated by an 
asterisk*. 

3.2.1 Catalogue (CATA) database top level elements 
Group World Element (GPWLD) 

Nominal Bore World Element (NBRWLD) 

* Part World Element (PRTWLD)  

Specification World Element (SPWLD) 

* Table World Element (TABWLD) 

Connection Compatibility Table Element (CCTABLE) 

Catalogue DB Element (CATALOGUE) 

Units Element (UNIT) 

Bolt Table Element (BLTABLE)  

3.2.2 Design (DESI) database top level elements 
Group World Element (GPWLD),  

Site (SITE),  
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Template World Element (TPWLD),  

Rule World Element (RLWLD),  

* Document World Element (DOWLD),  

Area World Element (AREAWLD),  

Fabrication Machine World Element (FMWLD),  

Grid World Element (GRIDWLD),  

Weld Table World Element (MWLWLD),  

Standard World Element (STDWLD),  

* Association Instance World Element (ASSOWL),  

* Association Definition World Element (ASDFWL),  

* Application Data World Element (APPLDWORLD),  

* System Group World Element (SYGPWL),  

* Integrator World Element (CYMWRL),  

* Link Document Element (LINKWLD),  

The following elements are present and may be visible in some circumstances but are used only for 
the Marine products: 

Hull Block World Element (HBLWLD),  

(Hull) Surface World Element (SSOWLD),  

(Hull) Reference Surface World Element (RSOWLD),  

(Hull) Compartment World Element (COMWLD),  

(Hull) Mog World Element (MOGWLD),  

(Hull) Block Element (BLOCK),  

Hull Curved Model World Element (HCMWLD) 

Building Block (BBLOCK),  

Assembly World Element (ASWLD) 

3.2.3 DRAFT (PADD) database top level elements 
LIBY, DEPT, PTWLD, * STYLWL 

3.2.4 Property (PROP) database top level elements 
Group World Element (GPWLD),  

MATWORLD, CASWORLD, RUNWORLD, CMPWORLD, CONWORLD 

3.2.5 Schematic (SCHE) database top level elements 
Schematic Group Element (SCGROUP) 
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3.2.6  Spooler (ISOD) database top level elements 
Isometrics Department Element (ISODEPT) 

3.3 System database 

3.3.1 TrueType fonts  
The System database has been updated to include TrueType font information for use in DRAFT. The 
information about the fonts is stored under the Font World element (FTWL) in a TTFONT element, 
which stores the font family number, a name and a description. Setting them is by a new menu item: 

  
This enables the setting up of the new families: 

  
Add enables a font to be picked using the standard font browser: 

  
The Font family ID (5 onwards) is automatically allocated by the system. 
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3.4 Dictionary (Lexicon) database 
The flexibility of the PDMS database has been enormously increased by the addition of User-defined 
Element Types and new facilities for User-Defined Attributes. 

3.4.1 User-Defined Element Types  
User-defined element types (UDETs) may now be created: they must be based on an existing element 
type in the Design, Draft, Catalogue or Property database. The BASETY attribute indicates from 
which system type the UDET is derived. 

This allows users to distinguish between variants of each element type, filtering its attributes, 
specifying User Defined Attributes (UDAs), and modifying its allowed member types etc. This 
permits, for example, different types of EQUIPMENT such as pumps and towers to be distinguished 
in reports etc. It also allows specifications to be made more specific for different components. Local 
languages may be used if required. 

UDETs also allow extra levels of administration element at the ZONE level. 

In PML, the UDET is recognised wherever an element type is allowed. For example, you would be 
able to do a collection based on a specific UDET.  

UDET elements are created in a UDET world (UDETWL), either directly or in a UDET group 
(UDETGR) in a UDETWL. For details, refer to section 6.6. 

3.4.2 User-Defined Attributes  
A number of enhancements allow much more control over the customisation of the PDMS data 
structures. 

Category for a UDA 

Text and Numerical Value validation 
A UDA definition may now contain an acceptable set of valid values for a text UDA or an acceptable 
set of ranges for an int or real UDA, which are used to verify its value on entry. These are defined in 
the dictionary DB by adding UVALID and UVALID elements below the UDA, one for each valid 
value or range. 

Remove existing limits 
The limits on numbers of UDA definitions and UDAs per element type have been removed  

External links 
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A UDA may refer to ‘documents’ such as web and email addresses, external WORD documents or 
drawings. The links may be shown in the GUI and the appropriate editor invoked by clicking the link. 

Hidden UDAs 
UDAs may be hidden from the command ‘Q ATT’ and the attribute form, though the individual UDA 
may still be queried. It may be hidden for all users, or visible to specific teams. This is controlled by 
two new attributes UHIDE and UTEAM on a UDA element. 

Connection flag 
A new UCONN attribute on a UDA element signals that it is a connection: if set, the UDA value will 
appear in the reference List form.  

Pseudo user-defined attributes 
A UDA may now be marked, using the new attribute UPSEUD, as a pseudo attribute, for which the 
values are calculated as needed rather than being stored. The code to evaluate the attribute must be 
plugged in by the user through the C# API. 

If the calculation of the pseudo attribute relies on other element attributes, and the pseudo attribute is 
to be used in a dynamic rule, then it is possible to denote what real attributes the pseudo attribute uses. 
For example, to add a UDA :VOLUME to a box, the code multiplies XLEN*YLEN*ZLEN, therefore 
:VOLUME is dependent on those 3 attributes. This should be indicated by setting the UDPEND 
attribute to ‘XLEN YLEN ZLEN’. If :VOLUME is subsequently included in a dynamic rule, any 
revision of XLEN, YLEN, ZLEN will be reflected in the result.  

Enhancements to system attributes 
For system attributes, the user may define Valid values and Limits, and also specify a Category. In 
addition, it is also possible to specify that the attribute is hidden on forms. 

Valid values and limits may be varied according to element type; they are defined by creating a 
USDA element in the dictionary DB. A USDA owns ULIMIT and UVALID elements that denote the 
limits and valid values. For example, to restrict the setting of the FUNC attribute on EQUIPMENT to 
be ‘HeatX’ or ‘Pump’, you could create a USDA as follows: 

new usda /UFUNC 

desc 'set restriction on FUNC attribute on EQUI' 

usysty FUNC 

ELELIST ADD EQUI 

new UVALID 

UVVAL 'PUMP' 

new UVALID 

UVVAL 'HEATX' 

Enhancements to ATTDEF command 
The existing ATTDEF command has been enhanced to take the following fields: 

PROTEC – Protection on/off 

HYPERL – hyperlink flag 
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CONNEX – connection flag 

CATEG – category 

For example: 
VAR !A ATTDEF XLEN CATEG 

New PML objects 
There are new PML objects to represent element types and attributes. These are: 

• Attribute class – To represent attributes 

• ElementType class – To represent Element types 

Instances of these classes is limited to querying details of the attributes and element types. Direct 
usage of the new objects in existing syntax is not supported. 

Attribute class 
An attribute instance may be created for a system attribute or a UDA, for example: 
!AXLEN = object attribute('XLEN') 

!UINT = object attribute(':UINT') 

Methods on an Attribute object are: 
• String Type() 
• String Name() 
• String Description() 
• Int Hash() 
• Int Length() 
• Bool IsPseudo() 
• Bool IsUda() 
• String querytext() – string  
• String units – string (either BORE, DISTANCE or NONE) 
• Bool Noclaim() – bool  
• ElementType array  ElementTypes –  this will work for UDAs only 
• Real array limits – only valid for real/int types 
• String array ValidValues(ElementType) – The list may vary with element type. 
• String  DefaultValue(ElementType) – Only valid for UDAs initially.  
• String Category() 
• Bool hyperlink() – attribute denotes an external file if true 
• Bool connection()  
• Bool hidden() 
• Bool protected() 

ElementType class 
An ElementType instance may be created for a system Element type or a UDET. For example,  

!EQUI = object elementtype('EQUI') 

!UEQUI = object elementtype(':MYEQUI') 

Methods on an ElementType object are: 
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• string Name() 
• string Description() 
• int Hash() 
• bool IsUdet() 
• Attribute array systemAttributes() 
• string array DbType()s 
• string ChangeType() 
• ElementType  SystemType()- for UDETs 
• ElementType array  udets() – UDETs derived from this type 
• bool Primary() 
• ElementType array MemberTypes()  
• ElementType array ParentTypes()  

3.5 Property database 

3.5.1 Parameterised Property attributes 
Various Property attributes can now be parameterised (since PDMS 11.6.SP4). This makes is much 
easier to prepare and report on attributes such as weight. 

For CMPD & TUBD elements: 
CWEI, CIWE, UWEI, UIWE, ACBO, BTOL, WTOL, WDIA, SHAP, PRFC, CORA, EFAC, 
PWAS, BFLE & OUTD 

These can be set with standard expression syntax such as: 
Cweight ( ATTRIB PARA[2 ] + ATTRIB PARA[3 ] ) 

Outdiameter ( ATTRIB PARA[1 ] + ATTRIB DESP[1 ] ) 

Existing syntax is still valid, for example: 
UWEI 2.5 

The following pseudo attributes have been updated to use the parameterised properties: 
BRWEIG  BRANCH WEIGHT 

BRIWEI   BRANCH INSULATED WEIGHT 

BRWWEI  BRANCH WET WEIGHT 

BRWIWE  BRANCH WET INSULATED WEIGHT 

BRIARE  BRANCH INTERNAL SURFACE AREA 

BREARE  BRANCH EXTERNAL SURFACE AREA 

WALLTH   TUBE WALL THICKNESS 

A new pseudo attribute, PROPRE, has been added to query of the calculated result of the property 
attribute. This is a valid at the element, such as a branch or hanger member, which indirectly 
references the property component. It has a qualifier of the property attribute to be evaluated and can 
be queried using the syntax: 
Q PROPRE OUTD 

This also impacts on DARs programs – please see 2.7.2 Data Access Routines (DARs). 
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3.6 Design database 

3.6.1 Accuracy of large coordinates  
The accuracy of large numbers, notably coordinates, has been increased for PDMS 12.0. This is 
primarily to simplify project administration by allowing the use of large coordinates without having to 
work relative to a local datum. Coordinates should now be accurate up to the limit of the spatial map 
(100 km) – but please note that there is currently a limit of 21 km for Isodraft. 

This accuracy has been achieved by changing from Single to Double Precision. [In detail Real 
Numbers are now represented by 8 bytes rather than 4, with that part used for the mantissa increased 
from 24 to 53.] The main effect of this change will be that the number of accurate digits will increase 
from about 6 or 7 to around 15. This should be more than enough to allow coordinates up to 100 km 
to be accurate to 1/10000 mm – and also allow them to be converted to accurate measurements in feet 
and inches! 

All data written to the database using PDMS 12 will be stored in this form, including any elements in 
upgraded projects. Database elements are converted as necessary – no special upgrade or 
reconfiguration is necessary. However, such converted projects may also have elements or previous 
session data that have not been changed – and of course the original data may be less accurate.  

Please note that DRAFT picture files will need to be regenerated to contain Double Precision Data. 
The upgrade process can manage this or leave it to the user to do as required. 

3.6.2 New Application Data world (APPLDW) 
This new storage area provides a means to store information used by the various engineering design 
applications. User applications could also make use of this data structure.  

3.6.3 Associations  
A new data structure, for storing Associations or constraints between objects in the database, 
represents a step change in the information stored in the PDMS Model.  It allows the user to store 
another dimension of detail in order to capture the design intent, and then use it to ensure that the 
model continues to match these constraints throughout the design process. 

These associations may be used by applications to apply rules as data is entered – and then checked 
against these rules later on in the design process. A good example is the new Hole Management 
application. 

There is scope for browsing the model using new user defined routes via the associations in the model 
rather than just system provided relationships such as the ownership hierarchy, the steelwork joint 
connection structure etc.  User productivity can be greatly improved by the use of these features. 

Associations can be quantitative using data such as positions and directions.  A particular form of this 
is the restriction that performs a check on its associated elements and exposes a Boolean result. 

Each Association references one or more database elements. No back reference is written to these 
elements, so users do not need write access to the database containing elements they wish to be 
associated with or connect to. Note that this also makes it simple for an element to participate in any 
number of such Associations.  
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Associations are stored in a DESI database but remain independent of the objects that they link. They 
may therefore be stored in an independent DESI database, with no design data, that is accessible for 
writing to all users who can create Associations.   

Each Association references a master Association Definition, which defines the type of Association 
and the rules under which they operate. They are also in a separate database, to which the users may 
not have write access.  

The diagram shows the relationship between Association Definitions, Association (Instances), and 
Design elements participating in Associations.  All references are one way.  A design element may be 
referenced by many Association Instances; an Association Definition may be referenced by many 
Association Instances.  

 

  

3.6.4 Extended Design Templates  
Templates now include a simple method to manage multiple repeat elements, such as the rungs on a 
ladder, as part of their core capability. This is based on the new Rule Repeat element (TMRREL) 
element owned by a Rule Repeat set (TMRPSE). 

All primitive elements that can be owned by a TMPL have an additional TMRREF attribute that can 
point to a TMRREL. Repeats can be Cartesian, linear or radial. 

The Design Templates application is very much improved and can allow Design Templates with no 
geometry to be created. Please see section 11.1. 

3.6.5 Secondary hierarchies & groups  

A major extension to the PDMS database enables data to be organised in a variety of ways in addition 
to the standard SITE > ZONE… hierarchy. This enables, for example, Equipment, Piping and HVAC 
to be organised by system and for objects to be organised for assembly. There is also the option to 
display multiple Explorers to access these new capabilities.  

One important use of these new features is to provide a capability to group objects in a persistent 
manner across normal database boundaries. This has been implemented using a new SYGPWL 
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element at the top level of the DESI database. It owns System Area (SYGPAR) elements to allow a 
structuring of the various systems, which are represented by SYSGRP elements below SYGPAR. 

Membership of a SYSGRP is achieved not by hierarchical ownership but by elements that reference it 
or any (sub) SYSGRP elements, using the MDSYSF (model system reference) attribute.  This allows 
membership to be defined by the discipline engineers without the need to write to the SYSGRP 
elements themselves.   

A model element can be a ‘member’ of a number of systems, because the MDSYSF attribute is a 
reference array.  The first member of this array is used to denote the Primary System of the 
component. 

SYSGRP elements have pseudo attributes SMEMB (secondary member) and SEXPND (expanded 
secondary members).  These return all design elements referencing them (via MDSYSF).  Since 
SYSGRPs do not reference each other, SEXPND will return the same result as SMEMB in all cases.   

The members of a SYSGRP element are displayed in the tree view as the combination of its LIST and 
those listed in its SMEMB/SEXPND pseudo attribute. This will not include TUBI or BOXI elements. 

Secondary hierarchies  

The Equipment, Piping and HVAC disciplines can now be organised by System in addition to the 
standard (SITE, ZONE…) hierarchy. The creation of the System is performed by the administrator 
using a new System Hierarchy option on the Create menu. Attributes can be modified through a 
Tabular Grid gadget (similar to a spreadsheet); the popup menu options change depending upon the 
current selection in the Explorer. 

 

The System Explorer displays the hierarchy and shows the design contents in a grid control. 
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The Systems entry on the Utilities menu gives access to the Modify system form: 

 

Groups  

A new type of Group element, which will supersede the existing GROUP element, has been 
introduced. They behave in much the same way but have several advantages: they can group elements 
from different databases; they can include implied tube (TUBI) and are generally more visible as 
every element has a pseudo attribute GROUPS which lists all GPSET groups to which it belongs. The 
GADD and GREM commands now work on GPSET items, as well as GROUPs. 
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These new GPSET groups, like GROUPs, are owned by the Group World element (GPWL), and have 
the attributes NAME, DESCription and FUNCTION. They can own group items (GPITEM) which 
have the attributes NAME, DESC, and the pseudo attribute SITEM, which sets system attributes 
GPREF, GPRFTY.  These describe the group hierarchy, which does permit a GPSET to own other 
GPSETs but not a GPWL, GROU or GPITEM. 

The new group manipulation form is shown from the bar menu of Design: 

  

This displays the Groups forma that shows the GPWLs and GPSETs in the current MDB and also 
enables you to create and manipulate them.  

  

Elements may be added or removed by using the popup menus on the Explorer or the tabular control 
on the Groups form. 

3.6.6 Volume Models  

The volume (VOLModel) element allows geometric models to be inserted into the project model.  
This element represents an object in the model space that is not an equipment item. They behave in a 
very similar manner to EQUIPMENT elements and can own the normal primitive shapes – but may 
not own NOZZLEs or SUBEQUIPMENT. 

The sub-volume (SVOLModel) element is similar to the VOLM element, except that it is owned by a 
VOLM element and cannot itself own SVOLM elements. 
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These elements can be displayed, used in interference checks, and drawn on hidden-line drawings.  
They may have user specified weight and centre of gravity, and user defined attributes. 

They can be created using Utilities>General>Create, which offers Volume Model, Subvolume and 
also Primitives to populate them. However, it is anticipated that users will also use Volume Models to 
store 3D models imported from other CAD systems (see chapter 22 - AVEVA Mechanical Equipment 
Interfaces). 

Picking the Primitives option leads to the primitive creation form – see section 11.2. 

3.7 Drawing (PADD) database 

3.7.1 User-defined Line Styles and Fill Styles  
The major change to the PADD database is to implement the splitting of colour from style for lines 
and fill, instead of bundling them together in the pen attribute. A new top-level Style world element 
(STYLWL) can own Linestyle and Fillstyle Tables (LSTYTB, FSTYTB) beneath which the 
definitions of user-defined Linestyles and Fillstyles are stored, as shown below.  

STYLWL, LSTYTB, and FSTYTB are all classified as ‘primary’ elements and can thus be claimed. It 
is envisaged that the creation and maintenance of STYLWL hierarchies will be the responsibility of 
the DRAFT Administrator (rather than general users) as is currently the case with the existing user-
defined pens. 

 

3.7.2 User-defined Line Styles 
At its simplest, the definition of a LINEST is provided by a width and a pattern description. Line 
width is defined by the LWIDTH attribute (maximum value 2.0mm). The pattern can be defined by a 
pattern repeat distance (attribute PATREP) and one of: 

• PATNAM attribute: a system pattern name (i.e. one of the standard 10 PDMS or 5 Tribon 
linestyle names such as DASHED or DASHDOT); 
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• PATDEF attribute. This is a sequence of integer numbers that define the relative lengths of the 
pattern’s alternating dashes and gaps. The sequence must start with a dash; gaps are denoted by 
a negative number.  

PATNAM and PATDEF are mutually exclusive: setting one will unset the other. 

3.7.3 User-defined Fill Styles 
A user-defined FillStyle will generally be defined by 1 or 2 HPATTE elements (Hatch Patterns). If 
more than 2 are created the third and subsequent ones (in database list order) will be ignored. Each 
HPATTE is defined by four attributes: 

• HANGLE:  the angle of the hatching lines on the Sheet 
   (degrees measured counter-clockwise from the horizontal) 

• HSEPAR:  the separation of the hatching lines: 0 for a solid fill.  
   (specified value is used on hard-copy output;  
   on screen, spacing is device-dependent but related to the value) 

• HOFFSE:  the offset of the hatching lines from the origin of the Sheet 

• HSTYLE:  the linestyle used to draw the hatching lines.  
   (Currently only ‘Solid’ is supported, any other value is ignored) 

The FILLST element also has a SOLFILLED logical attribute. If set TRUE, the FILLST represents 
Solid Fill and the definitions of any HPATTE elements are ignored. Of course there is already a 
‘SOLIDFILLED’ system hatch-pattern: this option has been included so that the FILLST can be 
referenced by the ALTDEF of another.   

3.8 Links to documents & external data  
A new database hierarchy under a Link World (LINKWL) links external and internal documents to 
design objects, and allows these linked documents to be opened from the Explorer. This enables the 
user to locate all the relevant drawings, documentation or vendor data. 

The links are defined by LNDESC elements that can optionally be grouped in LNFOLD folders and 
classified using LNCLAS classes. 

Normal access will be via the links user interface or other applications. 

3.8.1 Manipulating Links 
Documents may be linked to Design objects by clicking Display>Link Documents>Add Link. This 
starts an Add-in that allows you to create various types of links and set their options. An example is 
shown below: 
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You can enter a link’s name and description and category-specific information. The category also 
determines how links of this category are presented, including their text representation and icons (see 
below).  

 
Links may also be manipulated from the command line, using the DLADD & DLREMOVE syntax: 

DLADD <selatt> 

For example, to assign Link Descriptors /MYDOC1 and /MYDOC2 to the current design element: 
DLADD /MYDOC1 /MYDOC2 

Alternatively, if current element is a Link Descriptor, the following command assigns this LNDESC 
to /PANEL1 and /PUMP1: 

DLADD /PANEL1 /PUMP1 

Link Descriptors are created and their attributes set in the usual manner. To link to an external 
resource you should set the URL thus: 

URL ‘file:///Docsys/MyDocument.doc’ 

You can use the LNKREF to set a link to an internal database reference e.g. a drawing: 
LNKREF /DRAWING1 

The whole process of linking a document to /PUMP1 might look like this: 
NEW LNDESC /MYDOC 

URL ‘http://aveva.com/all_about_vm12_link_documents.pdf’ 
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DLADD /PUMP1 

The DLREMOVE command is similar. it is possible to remove an association both by removing a link 
from a LNDESC to a database element or by removing a link from a database element to a LNDESC.  

3.8.2 Classifying links 
Each LNDESC can have a number of Link Classes assigned. To classify a link you have to: 

• Create a Link Class element (LNCLAS) somewhere in the links hierarchy. 

• Assign the class to the LNDESC with a DLADD command. 

If current element is a LNDESC, the following command classifies it as a /MYCLASS1 and 
/MYCLASS2 document: 

DLADD /MYCLASS1 /MYCLASS2 

To remove classification information from a LNDESC, you can use the DLREMOVE command. 

3.8.3 Related pseudo attributes 
A number of pseudo attributes allow the retrieval of information on relations between Link 
Descriptors, Link Classes and model elements: 

LNKDOC  Link Descriptors (e.g. documents) linked to a database element 

LNKELE  Database elements linked to a Link Descriptor  

LNKCLS  Classes assigned to a Link Descriptor 

LNKDOC  Links classified with a specific Link Class 

3.9 Robust Merging  
The database system has been overhauled to improve reliability and eliminate database corruption, 
especially when merging changes.  Related faults reported by users have also been addressed. Care 
has been taken to minimise disk space usage and allow for future developments. 
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4 General System Enhancements 

4.1 Enhanced COPY command  
The COPY command has been enhanced to make it easier to copy moderately large quantities of data. 
A particular requirement is to copy several tree structures and maintain the reference attributes 
between the copied items. This might be used, for example, to: 

• Copy a piping zone and an equipment zone, while maintaining the references between the 
nozzles and the branches.  

• Copy within the catalogue where the referenced items are not under the same hierarchy. (An 
SCOM can be owned by a CATE but reference GMSE and PTSE items which are elsewhere in 
the catalogue.)  

To simplify this sort of operation, it is now possible to group COPY commands, using the commands: 
COPY START 

COPY (as many as required) 

COPY END 

The renaming option has also been improved by adding two new options:  

• PREPEND adds a string at the start of the name 

• SAMENAME allows the same name if copying to a different database 

The new syntax is: 
COPY START 

COPY ALL OF <gid> -- RENAME <name> <name> ---TO <gid> 

                   |- PREPEND <name>-------| 

                   |- SAMENAME ------------| 

COPY MEM OF <gid> -- RENAME <name> <name> ---TO <gid> 

                   |- PREPEND <name>-------| 

                   |- SAMENAME ------------| 

COPY ATT OF <gid> -- RENAME <name> <name> ---TO <gid> 

                   |- PREPEND <name>-------| 

                   |- SAMENAME ------------| 

COPY LIKE OF <gid>-- RENAME <name> <name> ---TO <gid> 

                   |- PREPEND <name>-------| 

                   |- SAMENAME ------------| 

COPY ADJ <selatt> -- RENAME <name> <name> ---> 

                   |- PREPEND <name>-------| 

                   |- SAMENAME ------------| 

COPY END 

 

Note that the COPY ADJacent command does not have a TO <gid> as it is not required. 



 
 

  
 

46 

4.2 Extended UNDO/REDO functions  
The system now allows the user to UNDO and REDO a wider range of commands in DESIGN and 
DRAFT. However, these functions are not available in PARAGON. 

4.3 Enhanced pseudo attribute queries  
Queries for pseudo attributes may have a qualifier. This qualifier was limited to: 

• An integer and a reference for POS/ORI/DIR attributes 

• An integer for all other types 

The qualifier is now much more flexible, in order to allow for more sophisticated queries. 

For more information, refer to section 23.4 on PML. 

4.4 Increased system limits  
Various constraints, throughout the system, have been relaxed during the PDMS 12 overhaul. 

4.4.1 Database size  
The maximum size of a PDMS database has very rarely been reached but has been increased to just 
less than 4,000GB. This is an increase by a factor of 2048 and larger than most, if not all, current 
physical media. The change has necessitated a change to the internal file pointers used for locking – 
and is one reason why data may not be written to any database using PDMS 11 and PDMS 12 
simultaneously! 

4.4.2 Number of Databases in a Multiple Database 
The number of databases (DBs) per MDB has increased over the years from 5 to 300; this has now 
been increased to 1000. 

Please note that, with the use of Extracts, there may no longer be only one file associated with each 
DB. The total number of files that PDMS can handle has been increased from 512 to 4096. This 
means that an MDB with all 1000 DBs will be able to open an average of 4 Extract files per DB – 
probably with some DBs using more, and many using no, Extracts. 

4.4.3 File names 
PDMS filenames may now be longer and contain the space and the dollar ($) characters. 

The length of the filename is currently 260 characters but it is intended to raise this to 1024 in PDMS 
12.1, when it will also be extended to handle filenames including Unicode (non-Latin) characters. 

The dollar character is used by Windows for the default share name for a drive – older versions of 
PDMS require it to be entered as ‘$$’. This is no longer necessary if the filename is specified in the 
appropriate manner. 

Note for command line users: 

The use of spaces and dollars has been implemented using a new filename atom, as the name atom is 
delimited by a space. The filename atom is delimited by a double-quote (“) character at each end in 
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order to permit the use of spaces. Where this is not required, the existing name atom may also be 
used. 

For example: 
slist "C:\Program Notes.txt" 

4.4.4 File width  
PDMS can now read/write a line containing up to 1024 characters from a text file; the limit was 
previously 255.  

Lines of a file read using a FILE object and .readrecord() are read into PML variables, which in turn 
can be used for input. The limit on the contents of PML variables has now increased from 254 to 1023 
characters. The limit on FILE objects has been increased from 10 to 20, though it’s still important to 
use .closefile() as soon as possible! 

4.4.5 Tabs in Macros 
<TAB> characters may now be used in PDMS macros in place of spaces, whereas formerly they were 
allowed only within a <text> atom. This should simplify import of data and make for more readable 
PML applications.  

4.4.6 Searchpaths  
Searchpaths can also now contain spaces, as long as the semi-colon ‘;’ is used instead as a delimiter.  

For example, the following (all on one line): 
set PDMSUI=C:\Local PDMS\Appware;M:\Project PDMS\Appware; 
Q:\Company PDMS\Appware 

will search in turn for: 
C:\Local PDMS\Appware/macro 
M:\Project PDMS\Appware/macro 
Q:\Company PDMS\Appware/macro 

Searchpaths defined using the space delimiter will continue to work as before; a search path with just 
one entry that includes a space needs a terminating ‘;’, for example: 

set PDMSUI=C:\Program Files\AVEVA\VPD\PDMS12.0\PDMSUI; 

Note: this may need changes to PML applications if they need to handle the new format searchpaths. 

4.4.7 Environment variables  
The limit on the length of Environment variables containing a searchpath has been increased from 
1024 to 5120 characters. If this limit is exceeded, nothing will ever be found in the final path! This 
has caused problems in the past for users with extensive additions to PDMSUI. Note that excessively 
long paths will also adversely affect performance. 

Environment variables are now expanded recursively, so a searchpath can itself contain references to 
other environment variables.  

For example, the following (on one line): 
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set MYPATH=%ROOT%\Standard Version; %ROOT%\Update Version; 
%ROOT%\Latest Version 
set ROOT=C:\Program Files\AVEVA; 

may be referenced in PDMS: 
$m%MYPATH%\mac 

which will check in turn for: 
C:\Program Files\AVEVA\Standard Version\mac 
C:\Program Files\AVEVA\Update Version\mac 
C:\Program Files\AVEVA\Latest Version\mac 

Note that two successive % characters within a filename are now both removed – as % is not a valid 
part of a pathname. 

4.5 Data Access Routines & Compilers 
Users of Data Access Routines (DARs) are warned that system changes such as increased accuracy in 
PDMS 12.0 have necessitated changes to the compile options and the FORTRAN compiler, though 
the C compiler is unchanged. Any DARs programs will need to be rebuilt. 

Warning: Users’ DARS and PML applications will need upgrading if parameterised properties are 
used.  

Prior to PDMS 11.6.SP4, a DARs program had to navigate to the relevant CMPD or TUBD element 
and then query the real attribute, in order to obtain a property for a piping component or similar. 
DARS has been updated so that this still works for existing data or for simple expressions; however, it 
will give the wrong answer if more complex expressions are used.  

The type of expression that will not work is one which uses PARA or DESP while a simple expression 
is similar to (33.5 * 8.6).  

To upgrade any such DARs applications, use the pseudo attribute PROPRE of the Design element, 
with the qualifier of the property required. 

4.6 Logging in to PDMS 

4.6.1 More flexible username 
A PDMS username may now be longer and contain a much wider selection of characters (up to fifteen 
characters, excluding |’@$/*). This does mean that its entry is case-sensitive; old-style (word) 
usernames may continue to work on the command line, but not using the entry form. 

4.6.2 Windows NT authentication 
PDMS projects can now be set up to allow users to be validated using their Windows Login (NT 
authentication). Please refer to the Admin chapter. 

The PDMS login form has been modified so that if the project is running authentication and the user 
is an authenticated user with general access, no password is required. 
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The Project, Username and MDB forms have all been enhanced and now include column headings 
and additional information. If the project is running authentication and the user is authenticated the 
username form is only populated with the authenticated user names. 

The login process remains unchanged for FREE Users and projects not running with authentication 
on. The Login form has been modified to allow users to change their PDMS passwords from the 
Login form.  

4.6.3 Passwords      updated *12.0.SP5* 
Users can now change their passwords from the PDMS Login form, with these conditions: 

• A GENERAL user in a project using NT authentication can modify his password without 
having to specify the password in the login form. 

• A FREE user must always specify his password to highlight the change button and change his 
password even if NT authentication is on. 

• The Change Password form now asks for confirmation of the new password: 

If NT authentication is not in use for this project, all users must enter their password before the 
change password button is highlighted. 

The password change function in Monitor has been modified similarly. 

From PDMS 12.0.SP5, user passwords are no longer visible in any part of the system. 

Support has been provided for generation of encrypted PML scripts that perform project entry such 
that user credentials cannot be read or edited. In addition execution of these generated scripts can be 
restricted to a set of Windows users, host computers, and to a time period. Please see section 6.9. 

As an additional security feature it is now necessary to confirm the Change Password dialog is shown 
below: 

 
All modules provide the ability to query project users via menu Query > Project > User. This form 
does not show the user password text even if the current user has Free privilege. 
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A new pseudo-attribute PassQuality is available to users with Free privilege; it returns an integer 
value, with the following interpretation: 

0 User has no password set 
1 User has legacy password (very unlikely to appear) 
2 User has pre 12.0 SP5 encrypted password, limited length. 
3 or more User has newly encrypted password. Higher numbers suggest more secure passwords. 

Stricter login security at 12.0.SP5 also affects PDMS Admin and Software Customisation. In 
particular, it is expected that some problems will occur where customer’s applications expect to obtain 
user password text when running as a Free user. Please refer to updated manuals – Administrator User 
Guide, Administrator Command Reference Manual, Monitor Reference Manual, Software 
Customisation Reference Manual – and to section of this document. 

4.6.4 Project Identifiers  
A longer project identifier (the project ‘number’) of up to 8 alpha-numeric characters can be used in 
PDMS as an alternative to the 3-letter Project code. The project number can be used wherever the 
Project code is currently valid, but must be a text string: 

PROJECT text  Long Project identifier (<8 char.) 

PROJECT word  Project code only (3 char.) 

This includes the following syntax: 
 PROJECT <project>  For project selection 

 COPY <dbname> FROM <project> … 

 INCLUDE <dbname> FROM <project> … 

 REPLICATE <project> 

The Project Creation wizard allows projects to be created using a project number, although the 
underlying make.exe program still uses the Project Code. The PDMS Login form has been modified 
to accept the project number: 

  
The Project Code is displayed as a paragraph gadget to the right of the Project Number. The Project 
text field will accept either the project number Sample or the project code SAM and is case 
independent. If the project code is input the display will show the project number. 

Other forms associated with project login have also been revised to suit. 

Note: The Project Code must still be used with Data Access Routines and the Global Daemon 
(admind).  
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4.6.5 Restoring views  
The use of the binary files (.bin and .disp) for string screen layout has been removed, along with the 
relevant user syntax to save and restore them. New mechanisms save the contents of graphical view 
gadgets automatically at session close and allow users to (optionally) restore them at start up. 

The pull down menu for restoring the layout has been replaced with a toggle that highlights if the 
user’s view file for a relevant module has been located. Ticking the toggle will restore the views after 
entering the module. 

The Modules menu now highlights the Restore Views option if the appropriate user’s view file exists 
for the appropriate module; if it does not exist, the option is greyed out. 

  
 

4.6.6 PDMS Console window    *PDMS 12.0.SP5* 

PDMS uses DOS-style command windows for certain output, both an echo of the batch file on initial 
start-up and the ‘console’ when changing module. 

The default icon for PDMS, as used in the Start menu, has been changed at SP5 to start minimized as 
its contents are not usually of interest. It may of course be shown using the task bar if required, as 
might be the case if the system does not initialise correctly. 

The console may also be suppressed if required. However, it is currently used for certain output such 
as that during module changes and for the obsolescent SPECON module. Users who wish to suppress 
it can use the –noconsole switch as follows: 

Option 1: revise the line in the BAT file to start PDMS Monitor thus: 

cmd/c "%monexe%\mon" %args% -noconsole 

Option 2: revise the shortcut used to start the bat file by adding the –noconsole argument. 
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5 User Interface 

5.1 Common Application Framework  
The Common Application Framework (CAF), based on Microsoft .NET Framework and used in 
PDMS since version 11.6, has been enhanced to support the definition of application menus and 
toolbars from an XML file. This is a more flexible approach for product add-ins that makes it possible 
to reduce the dependence on PML and improve the start-up performance. It is possible to implement 
its command objects in C#, PML and unmanaged code and there is a GUI to support the creation and 
modification of the XML menu and toolbar definitions.  

PDMS menus and toolbars have been replaced with an XML definition and the necessary PML 
command objects have been implemented. The appearance is slightly different but the behaviour 
should be very similar. Customisation will necessarily be somewhat different.  

Note that not all menus and toolbars have been converted to use the new system at PDMS 12.0. 

5.2 Drawlists  
It is now possible to create additional drawlists in order to display different content in different views. 
By default, a newly created 3D view uses the global drawlist; however, it may instead be linked to a 
‘local’ drawlist.  

Graphical handles and model editing are available in both local and global views. The handle appears 
in all views that are linked to the same drawlist. Selection can take place in all views linked to the 
same drawlist but multi-selection cannot take place across views of different drawlists. 

Current element highlighting and Clash graphical feedback appear in global views only. 

A new button on the Design 3D View form provides access to the new drawlist functions. A 
secondary mouse click offers an option to create a new local view of the current graphical selection. 
The new view will be created with its own drawlist containing only those objects in the graphical 
selection, as highlighted in green. 

  
 

Other options can: 
• Create a clone of the current view, using the same draw-list, which may be either global or local 
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• Give further information about the draw-list and current graphical selection using a Drawlist 
form, which also enables items to be added and their visual representation to be changed 

• Change view representation settings using a Representation form 

It is now possible to add a primitive to a 3D view without adding the owning top level element. 

The properties and contents of each view will be saved on exiting PDMS. On entering PDMS, the 
user will be given the option of restoring the views and their contents. 

5.3 Colour table  
The PDMS colour table has been extended to provide the complete set of 256 (numbered) colours in 
the AutoCAD Color Index (ACI), in order to improve compatibility with AutoCAD. There are now 61 
named colours, which use names from the X11 definitions and are now all mapped to ACI. This 
means that some of the PDMS named colours have changed somewhat; one or two are now 
indistinguishable as ACI has relatively few light colours. For details, please see Chapter 8 of the 
DRAFT User Guide. 

5.4 Attributes form  
A new attributes form, enabled using the Attributes Utility entry on the Display menu, displays them 
in categories and hides ‘invisible’ attributes. By default all attributes will be visible and there will be 
no categories set. Attributes without a category will be assigned a default categorisation. Attributes 
are read-only on the form: it is not currently possible to add or delete attributes using it.  

The form can be docked, floated, and resized and tracks the current element by default. There are 
various options for the display: for example, it can be simplified by collapsing unwanted categories.  

Attribute invisibility and categorisation options are set up in the Lexicon module.    
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An attribute of data type “hyperlink” displays the pathname of the hyperlink beside the attribute 
name.  A pop-up menu option enables the referenced url to be accessed. Any document will be 
opened outside PDMS and will respect external access rights. 

5.5 Search Utility     *12.0.sp4* 
The PDMS Search Facility enables the user to search for model items in all the graphical applications 
(DESIGN, DRAFT, etc) and list the search results in a table. To display the Search form select: 
Display>Search Utility.  

The results of the searches are displayed in the new Grid gadget – see below. The Export to Excel 
menu option enables them to be saved for future use, in a specified file (.XLS format). These results 
have been made more useful at PDMS 12.0.SP4 by making them editable, in either a single cell or 
bulk edit mode. Movement around the grid and the selection of cells for editing follow the usual 
Windows conventions. In addition, the search form now has an option to save the search criteria for 
future use. 

For details, please see the updated Getting Started with PDMS manual. 

5.6 Tabular grid gadget     *12.0.sp4* 
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There is a new GridControl gadget, which is a C# component based on the Infragistics UltraGrid 
control. This is widely used in the user interface, for example displaying the results of database 
searches. It may also be used by the user in any customisation, by using PML.NET facilities. It can be 
bound to different types of data sources (for example a list of database items and attributes) and used 
to import data from an Excel spreadsheet.  

Once the data is in the grid, the user can select rows and columns in the grid, apply further filters to 
the list, and select items for action (for example, "Add to 3D View"). The methods used for 
navigation, filtering and selection within the table are similar to those used in Office applications, 
notably Excel. 

The picture shows a set of PIPE and EQUIP items in the grid, with attributes: Name, Type, Position, 
Description, and PSPEC. A pop-up menu is displayed on the selected items. Notice that the attribute 
“Position” is invalid on PIPE items, and this is indicated in the grid with an appropriate icon. 
Similarly, PSPEC is invalid on EQUIP items. 

 

Several new methods are available for the Grid Control at PDMS 12.0.SP4, including the ability to 
edit attribute values, both in single edit mode and in bulk edit mode. This is particularly useful in 
conjunction with the expanded search facilities (see above). 

For details, please see the updated Getting Started with PDMS manual. 

5.7 Windows file browser  
The standard Windows file dialog is now used for all file operations and may also be used in PML 
applications. For the latter, see section 23.5.1. 

5.8 Windows printing 
The standard Windows print dialog is now used for all print operations.  
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6 Administration 

6.1 Admin user interface 

6.1.1 Admin menus 
The project menu has been modified to include the ability the switch ‘NT authentication’ on or off: if 
on, the Windows login information will be used in place of any PDMS login. 

  
The default bar has been modified to show the status of authentication: 

 
NT authorised users can be shown from the query menu; if NT authentication is not operating, the 
menu entry does not appear. 

  

6.1.2 Admin Elements form 
This form now allows the creation and modification of NT Authorised users if this is enabled for the 
project. Creation or modification allows you to pick the permissible PDMS user names set the default 
for that user. 
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The system will check to confirm deletion of an NT authenticated User: 

  
NT Authenticated users can be listed, along with their details: 

 
 

Please see later section on User Interface changes targeted at Global in 12.0.SP4. 

6.2 Project Creation Wizard     *12.0.sp2* 
This new program simplifies the process of setting up PDMS projects by using a series of Wizards to 
aid the Project Administrator’s job. 

It is an additional .NET program (.exe), comprising a set of forms and DLLs, which simplifies the 
process of creating a new project from scratch. It uses the PDMSMAKE utility to create the initial 
systems databases in a specified project directory, and creates an example batch file that can be edited 
into the Users’ evars.bat files.  

 
 

If PDMS is installed to the default directory, the wizard is started by running the projectCreation.bat 
file in the PDMS 12.0 executable directory C:\AVEVA\pdms12.0. 
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6.3 Project Setup – Spreadsheet input 
The process of setting-up a PDMS project has been simplified by allowing the Admin data to be 
imported from Excel spreadsheets. It is now possible to import and create the following Admin 
Elements: 

• Project Users 

• Project Databases 

• Project Teams 

• MDBs 

• Data Access Controls 

Excel Import is available from the main menu Utilities > Import Admin Elements… 

The import form allows the user to select the Excel file to be imported using a file browser. After 
selecting the file, the user can use Select Sheet to pick a worksheet. Once this is done, the contents of 
the Excel Sheet are shown in the Grid. 

  
The form gadget has the following options: 

• Validate Sheet – On Clicking the Validate Sheet button, the grid content is validated. The 
Import button is enabled only if the validations are successful. Note that the Excel file format 
is fixed and should be similar to the Sample spreadsheet provided.  

• Import – Imports the grid contents: the sequence is as follows:  

1. Create the MDBs by selecting the MDB Sheet 
2. Create the Teams and Databases by selecting the CATALOGUE DBS sheet 
3. Create the Roles and PEROPS for all disciplines 
4. Create the Scopes from SCOPE sheet.  

Scopes can be created before creating the Roles or Teams and Databases. 
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5. Create the ACRs by selecting the ACRS sheet 
6. Create the login Users by selecting the LOGIN USERS sheet: this will assign the Access 

Control Rights for the users if the ACR elements are available.  

6.4 Access Control Assistant  
The purpose of the Access Control Assistant (ACA) is to assist administrators in defining and 
managing the control of users’ access to data. It is simply accessed from the Admin menu bar. 

Full details are given in the Administrator User Guide – Chapter 11 Data Access Control. 

6.5 Permissible Database Operations 
Data Access Control (DAC) roles have been extended with additional Permissible Operations 
(Perops) in order to allow users to protect the intellectual property (IPR) contained in their databases. 
These new operations are available to users when Access Control is enabled, unless they are 
specifically disabled; this is unlike the operations previously controlled with DACs, which are not 
available unless explicitly enabled for a user. 

The new controls allow a user to issue data to a third party but control its use; they cover: 

• Data Listing (the OUTPUT command) 

• Copying elements between databases 

• Export to Review (and other targets, accessed via the EXPORT command) 

• External access via Data Access Routines (DARs), which cannot access data in a protected 
database 

In addition, read access to certain attributes is restricted to obstruct an unauthorised user from writing 
their own data listing functions in PML  

Protected databases are marked so that restricted users cannot copy data from that database into 
another project, even through a physical copy of the database file. It is also possible to set (or clear) an 
expiry date for a protected database. 

These facilities can be controlled using the new Access Control Assistant (ACA) in the Admin 
module or by using the following commands. 

The CHANGE command can now change the protection on a named database, and optionally control 
expiry by specifying a future date, using the standard date format used in existing commands. The 
new syntax is as follows: 
CHANGE dbname PROTection [ ON | OFF ] [ EXPires future-date ] 

The CREATE DB command has been similarly extended: 
CREATE DB dbname dbtype PROTected [ EXPires future-date ] 

The Admin GUI has also been extended to cover the new features.  

6.6 User-Defined Element Types  
A brief description of User-Defined Element Types (UDETs) is given in section 3.4.1in the chapter on 
Database Enhancements. 
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6.6.1 Creating a UDET definition 
A UDET may be created in the dictionary database using LEXICON syntax. It must be created below 
a UDET world (UDETWL), or a UDET group (UDETGR). The database hierarchy is UDETWL > 
UDETGR > UDET. 

For example: 
NEW UDETWL /MYUDETWL1 

NEW UDETGR /MYUDETGR1 

NEW UDET /MYUDET 

The only attributes on a UDETWL or UDETGR are name and description. 

The new UDET must be based on any visible element type in the Design, Draft, Catalogue or 
Property databases. The BASETY attribute indicates the system type from which the UDET is 
derived, for example a UDET based on the equipment element is set thus:  

BASETY EQUIP 

Instances of this UDET will have all the system attributes of the base type, but not its UDAs unless 
specifically set. 

Once instances exist, changing the BASETY will result in invalid UDET instances. DICE will output 
an error for such circumstances. 

6.6.2 Allocating the UDET name 
The UDNAME attribute is used to hold the UDET name, in a similar manner to UDAs. This name 
will then be used for identification in the constructor modules, for example a UDET set up thus:  

UDNAME ‘MYUDET’ 

will be identified by the syntax :MYUDET in constructor modules. The UDET identification always 
starts with a colon. 

The UDNAME name may be up to 50 characters long; unlike UDAs there is no minimum 
abbreviation. 

6.6.3 Redefine the allowed member list 
By default, the UDET will have the same allowable member types (UDMLIS) and allowable owner 
types (UDOLIS) as its base type, but these lists may be reset. The types in the new list must be either: 

• a system type allowed on the base type. 

• a UDET derived from a system type allowed on the base type. 

For example, a :MYBOX is defined based on a BOX and a :MYNBOX is defined based on an 
NBOX.  

For :MYBOX: 

The default owner list is: EQUI STRU PTRA SUBE SUBS TMPL 

The default member list is: NBOX NPOLYH NCYL NSLC NSNO NDIS NCON NPYR NCTO 
NRTO NXTR NREV 
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The allowed member and owner lists may be redefined using the UDOLIST, UDMLIST attributes. 
The list may be completely redefined or the keywords ‘ADD’ or ‘REMOVE’ may be used to add to 
remove particular entries. 

For example : 

UDOLIST SITE ZONE   Define SITE, ZONE as  the only valid owners 

UDOLIST ADD SITE ZONE Add SITE, ZONE as  valid owners 

UDMLIST REMOVE ALL Remove all allowed member types 

The allowed owner list and member list for a UDET may be any or all of the system types allowed on 
the BASETY and/or any UDET based on these system types. For example, for :MYBOX you could 
not add a ZONE to UDOLIST, or a EQUI to UDMLIST. It is up to the user to ensure that the 
UDOLIST and UDMLIST on different UDETs match up. 

For example, if we decide that a :MYBOX can only go under a SUBE, and that a :MYNBOX can 
only go under a :MYBOX or a BOX. This is achieved as follows: 

For :MYBOX  
UDOLIST SUBE 

UDMLIST :MYNBOX   

For :MYNBOX the values will be reset as follows: 
UDOLIST :MYBOX BOX 

Changing the allowed owners/members for a UDET could invalidate some existing instances. These 
are reported as warnings in DICE. 

6.6.4 Extending the ZONE hierarchy 
Zones may own UDETs based on a ZONE and vice versa, though recursive structures are not 
allowed. 

For example, we can create two new UDETs based on a ZONE, called :PIPEZONE and 
:SMALLPIPES. We can then allow :PIPEZONE below a ZONE, and :SMALLPIPE below a 
:PIPEZONE. 

Since :PIPEZONE, and :SMALLPIPES are both derived from ZONES, we have a three level 
hierarchy of zones. 

6.6.5 Changing allowed references 

UDA reference attributes 
The valid list of element types that a UDA may reference is held in the REFLIS attribute in its 
definition. This list may hold UDETs as well as system element types. For example, a UDA with a 
REFLIS holding EQUIP :PUMP may reference an EQUI or a :PUMP but not a :VESSEL, even if 
both the :PUMP and the :VESSEL are derived from the EQUI element. 

System reference attributes 
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It is not possible to redefine the valid lists for system reference attributes. A system reference attribute 
may point to any UDET derived from a valid system type. For example, an HREF on a BRANCH can 
reference a :MYNOZZLE since this is derived from a NOZZLE. 

6.6.6 Allocate UDAs to a UDET 
UDAs may be added to the UDET in the same way that they are allocated to system element types. In 
other words, a UDET may appear in the ELELIST for a UDA definition. 

For example, three distinct pipe UDETs have been derived as follows: 
UDET :PipeLagged 

UDET :PipePainted 

UDET :PipeHeated 

The user can add allocate different UDAS to each UDET, such as : 
UDET :PipeLagged 

 UDA :insulation 

UDET :PipePainted 

 UDA :colour 

UDET :PipeHeated 

 UDA :insulation 

 UDA :colour 

UDAs are allocated to UDETs using the ELEADD command in the UDA definition. 

6.6.7 Hiding system attributes 
The UDHLIS array will hold the list of system attributes to hide when displaying a UDET. For 
example, a UDET based on a branch needs to hide its iso-related attributes. This would be done as 
follows: 

UDHLIST BSTA HWRF TWRF BRLO RLSTOR TSFBR DELDSG 

The ADD and REMOVE keyword can be used in association with UHDLIST, though there are some 
attributes that cannot be hidden, such as NAME, OWNER, LOCK. 

6.6.8 Deleting a UDET definition 
A UDET definition may be deleted, in which case object instances of this type will then no longer be 
recognised. They will default back to the original system type, and any extra UDAs will be lost. 

6.6.9 UDATLS pseudo-attribute on a UDET 
An extra pseudo (read only) attribute on a UDET is the UDATLS, a list of all attributes (including 
UDAs) valid for this UDET. 
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6.7 Lexicon User interface 
There is now a graphical user interface for Lexicon, with a Bar menu that enables the creation, 
modification and deletion of UWRL (UDA World), UGRO (Group of UDAs) , UDETWL (UDET 
World), UDETGR (Group of UDETs) elements. 

These administrative elements enable the user to group together similar items. The UDA and UDET 
maintain the creation and modification of each item type. 

 
The Lexicon Hierarchy form can maintain the whole hierarchy. The Explorer allows the administrator 
to navigate the Hierarchy and allows modification or deletion of administrative elements.  
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6.8 Global Admin user interface    *12.0.sp4* 
Many improvements have been made to the ADMIN user interface, with additional information added 
to many of the forms when used on Global projects. These are summarised in this chapter. 

6.8.1 Add locations to the Databases & Extracts form 

The Admin Elements form (view Database & Extracts) has been modified to include the primary 
location. It is also possible to Sort on this field. 
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6.8.2 Changes to Create Databases form 

The Create Database from has been modified to include a larger Description box, and also to clearly 
identify the underlying database type. 
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6.8.3 Changes to Create Location form 

The Create Location form has been modified to use drop-down lists for selecting the Parent, Group 
and Administrating Location fields. A check button has also been provided to validate the hostname. 
Please note that validation is done by this testing the connectivity to the hostname. 

 

6.8.4 Changes to Create MDB form 

The Create MDB Form has been modified to include the Primary location; it is possible to Sort on this 
field. The number of databases displayed has been increased and the form will also give feedback 
when data is changed.  

 



 
 

  
 

69 

6.8.5 Changes to Database Allocation (By Location) form 

The Database Allocation (By Location) form has been modified to include the Primary location. It is 
also possible to Sort on this field. 
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6.8.6 Changes to Database Integrity Check Form 

The Database Integrity Check form has been modified to include the Primary location for each 
database; it is possible to Sort on this field. The number of databases displayed in the list has also 
been increased.  
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6.8.7 Changes to Extract Data Control form 

The Test Project Communications form is available on the Extract Data Control Form in the 
Constructor modules so that Users can check that the daemon is running before undertaking Global 
Extract Operations.  
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6.8.8 Changes to the main Admin form 

The Locking and Isolation buttons on the main menu have been removed and replaced with status 
icons that cannot be accidentally clicked ON/OFF. The functionality is now available through the 
Project menu of the main form. 

 

6.8.9 Changes to Command Transaction 
The Number of transactions on the Command Transaction form has been increased to 15, removing 
the need to display a scroll bar to reveal 1 additional transaction. 

 
 



 
 

  
 

73 

6.9 Password Security    *12.0.SP5* 
User passwords are now not visible in any part of the software. As a result, any form or query that 
displayed passwords has been changed.  

Restrictions on the length and content of passwords have been relaxed: it is now possible to have 
passwords of 15 characters (increased from 6) and including any characters except |’@$/*. 

Support has been provided for generation of encrypted PML scripts that perform project entry such 
that user credentials cannot be read or edited. Execution of these generated scripts can be restricted to 
a set of Windows users, host computers, and to a specified time period. 

Key Points to note: 

• Passwords are not recorded in any output of project users: in particular Admin export, 
replicate and data listing. If user details are imported into a new project, “copy” users will be 
created, but will not be able to log in until the administrator actively sets the passwords. 

• Free users (project administrators) can no longer query the password of a project user. This 
means that the only action available if a user forgets their password is for the administrator 
to reset the password and inform the user of the new password. 

• Existing appware that uses the Free user capability to query any user’s password (for 
example to automatically generate batch scripts, or to switch user without requiring 
password entry) will no longer work. New PML functions have been introduced to support 
this capability via automatic generation of encrypted PML scripts. 

• Once a project user password has been set or reset at 12.0 SP5 it will not be possible for that 
user to log in to the project using earlier versions of PDMS. 

6.10 Generation of command scripts   *12.0.SP5* 
An entirely new form has been introduced to allow generation of encrypted command scripts. This 
form, activated from a new button on the Admin main form, is shown below: 
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If a User is selected in the main Admin form element list, that user will be specified in the Command 
Script Generation form; if an MDB element is selected, the MDB option will be checked and that 
MDB specified in the form. 

The new form requires entry and confirmation of the correct password for the specified user, and 
requires entry or selection via Browse dialog of an output filename. MDB selection is optional, as is 
the selection of an input command script. The Input option is only available if a PML Publisher 
license is available, as this is used to generate the encrypted script. 

A set of Windows usernames and a set of host computer names can be entered into the two lists. 
Optionally a full or partial time period can be specified using the Before and After checkboxes and 
date controls. Clicking OK in this form records the specified conditions to be applied or edited later. 

On clicking OK in the Command Script Generation form, an encrypted command script is written to 
the output filename specified (with confirmation if that file exists). When executed in Monitor this 
command script will: 

• Enter the current project 
• Login as the given user with the given password (if correct) 
• Optionally, select the given MDB 
• Optionally, verify that the Windows user executing the batch script is in the set specified in 

the conditions. If this fails then the batch job will terminate immediately. 
• Optionally, verify that the host computer name is in the set specified in the conditions. 
• Optionally, verify that the current time falls within the time period specified in the conditions. 
• Optionally, execute the command script given as Input. 

6.11 Anticipated Customisation Issues *12.0.SP5* 
It is expected that some problems may occur where a customer’s application expects to be able to 
obtain user password text when running as a Free user. This section attempts to identify typical 
example scenarios where this is likely to arise, and in each case recommend an approach to resolving 
the problem using new alternative functions. 

6.11.1 Automatic Generation of Command Scripts 

The following PML script writes the project entry commands required for a batch job to enter the 
project as the selected user. This will no longer work due to a change in behaviour of the line marked 
in bold. 
 !proj = CURRENT PROJECT 
 !projcode = !proj.code() 
 !user = CURRENT SESSION.user() 
 !username = !user.name 
 !password = !user.password() 
 !contents = ARRAY() 
 !contents.append( |PROJ | & !projcode ) 
 !contents.append( |USER | & !username & |/| & !pass ) 
      !contents.appendArray( !body ) 
 !file.writefile( ’OVERWRITE’, !contents ) 
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A free user would have run this successfully; otherwise an error would have been generated: 
(2,203)   Insufficient access rights for user defined attribute PASS 
on element USER <username> 

If the application was run by general users, it will already have been necessary to prompt for the 
required password. It will now be necessary to prompt for password text even for Free users, unless 
generating scripts for the current user only; in this case the PML object PMLUSERLOGIN can be used 
directly. Otherwise it is recommended that the PML object PMLSECURELOGIN be used as suggested 
below. 
 !proj = CURRENT PROJECT 
 !user = <select user name> 
 !password = <prompt for password text> 
 !scriptgen = object PMLSECURELOGIN() 
 !scriptgen.Project( !proj.code() ) 
 !scriptgen.User( !user ) 
 !scriptgen.Password( !password ) 
 !filename = ’C:\temp\projectentry.mac’ 
 !scriptgen.SaveToFile( !filename ) 

!contents = ARRAY() 
 !contents.append( |$M | & !filename ) 
 !contents.appendArray( !body ) 
 !file.writefile( ’OVERWRITE’, !contents ) 

6.11.2 Switch Users Without Password Entry 

The following PML records the current user name, switches to a Free user with a known username 
and password, and uses the Free user privilege to record the password for the original user. This 
allows the script to automatically return to the original user when the Free user actions are complete. 
This will no longer work due to a change in behaviour of the line marked in bold. 

 !!username = CURRENT SESSION.user().name 
 user SYSTEM/XXXXXX 
 admin 
 /$!!username 
 !!password = PASS 
 $* Admin actions ... 
 monitor 
 user $!!username$!!password 

The recommended approach is to make use of the new PML object PMLUSERLOGIN as follows. 

 !usercontext = object PMLUSERLOGIN() 
 !!usercontextfile = ’C:\temp\currentuser.mac’ 
 !usercontext.VerifyNonInteractive( FALSE ) 
 !usercontext.SaveToFile( !!usercontextfile ) 
 user SYSTEM/XXXXXX 
 $* Admin actions ... 
 monitor 
 $M /$!!usercontextfile 
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6.12 Schematic database licensing   *12.0.SP5* 
From PDMS 12.0.SP5, the use of the Schematic (SCHE) database requires a separate license feature, 
which is now included in all license files with the relevant schematics products as follows: 

• AVEVA Diagrams 
• AVEVA Schematic Model Manager (formerly known as P&ID Manager) 
• AVEVA Schematic 3D Integrator (formerly known as P&ID 3D Integrator) 

This change will not affect customers who make no use of these products, but those who do may 
require an updated license file for 12.0.SP5, in order to have continued access to the relevant 
schematics functions and related data. The database is not accessible without such a license. 

One seat is required for each user reading or writing the Schematic database. The license is checked 
whenever an MDB containing one or more current Schematic databases is opened, whichever product 
or application is used. This means that if such an MDB is opened from a Design application, it will 
take out a license for Schematic database access, whether or not any Schematic function is to be used. 
If a license is not available, an error message will be given and the database will not be opened. 

To ensure that Schematic database access licenses are used only when required, one of the following 
approaches should be adopted: 

1. (Recommended) MDBs are structured in such a way that Schematic databases are only 
included in MDBs where they will be required. Users of other MDBs will therefore not take 
out a Schematic database license, leaving them for those who need them.  

2. Schematic databases are deferred in the MDB and activated only when required using the 
Current command in Monitor or the MDB command mode. 

If Integrator is not being used, an alternative is to revise the module definition for Design so that it 
does not access the Schematic databases. This can be achieved using the Admin Project > Module 
Definitions > Advanced Settings form: 
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7 Global Enhancements    *12.0.sp4*  

7.1 Improved Global Update operations 
One of the main reasons for a new version of Global is to improve the Update algorithm for 
performance and functionality. 

7.1.1 Faster Updates 
The performance of updates has been improved to shorten the time taken to propagate data between 
locations. This has been achieved by making 3 improvements to the updating algorithm: 

Larger packets: The network line speed is the key bottleneck when propagating data, access to disk 
(read/writing files) is relatively quick. Therefore data is handled in larger blocks (a factor of 10 has 
been applied). 

Compression: Data is compressed / uncompressed into memory buffers before and after data is sent 
down a network connection. 

Concurrency: Updates have in previous versions run sequentially, one database at a time. Databases 
are now propagated five at a time. 

The net result of these changes is that bandwidth is more fully utilised and the length of time taken for 
updates has been reduced. The results of compression are more obvious on slower lines.  

The chart below shows typical improvements over various line speeds. The bars marked ‘None’ give 
an indication of the performance of earlier releases; those marked ‘All Enabled’ show the improved 
version. 

Update Timings

21

30

59

112

67

112

150

360

66

206

321

675

68

195

367

705

121

306

478

862

0 200 400 600 800 1000

2048

512

256

128

Li
ne

 S
pe

ed
s 

(k
bp

s)

Time in Seconds

None Enabled
Concurrency Enabled
Larger Packects Enabled
Compression Enabled
All Enabled

 
Please note: These results are taken over a clean line, with no error, delay, or extra loading. Therefore 
it is possible that actual timings may not reflect those shown here. 

The times shown above are based on a realistic customer scenario. The project used contained 839 
databases (with 807 databases containing changes). A total of 2,818 sessions have been spread out 
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unevenly amongst the databases. A total of 277758 pages (542Mbytes) of data have been sent with 
one particular database containing 120 Mbytes of data.  

7.1.2 Overlapping Updates 
Scheduled Updates to the same location will not start if the previous update has not completed. In 
previous versions it was possible for daemons to become overloaded with update events if one or 
more daemons were not running. This could lead to an overloading of commands that caused a 
bottleneck in Daemon operations. Preventing updates from overlapping will stop the build-up of 
updates and allow the daemon to run more smoothly.  

Duplicate Updates will no longer be possible; however, the performance improvement for 
concurrency should remove the need for this. This only affects updates between identical pairs; 
updates to other locations are not affected.  

7.1.3 Non-Direct Scheduled Updates 
In previous releases of Global, scheduled update events happened directly between 2 locations and 
ignored the network hierarchy. Thus, if a scheduled update was created at location A to update with 
location C, the update process would ignore Location B (as shown in the diagram below): 
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Scheduled update events will now include Location B as it is on the route to Location C. In this 
example, 3 actual updates will now commence in turn. Location A will update with Location B; 
Location B with Location C; and then once more Location B will update to Location A, thus ensuring 
that Location A, B and C are as up to date as possible (as shown in the diagram below). This is 
extended to incorporate as many locations as defined between the location initiating the update event, 
and its target location.  
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7.1.4 Update/Synchronise a subset of databases 
It is possible to update or synchronise a subset of databases rather than an individual, or all databases. 
These selections can be based on a list, a DBSET, a MDB or a Location.  

New Syntax: 
UPDATE DBLIST <update-list> WITH <loc> 

SYNCHR DBLIST <update-list>  

SYNCHR DBLIST <update-list> AT <loc> 

 

DBLIST may include several items, including one or more MDB, DBSET DB or various other 
options. 

For full details, please refer to the PDMS 12.0.SP4 ADMIN Command Reference Manual. 
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7.2 Improved Recover functionality 

7.2.1 New Recover TO ALL locations 
A new Global command has been added to allow a Global Administrator to recover a 
database to all allocated locations. This functionality is available from the HUB, the Primary 
location of the database, or the administering location of the location where the database is 
primary.  

This process should be used with care, as it may take some time. 

New syntax: 
RECOVER <dbname> TO ALL/LOCATIONS 

RECOVER <dbname> AT <locname> TO ALL/LOCATIONS 
 

 

7.2.2 Extended Recover to include Global database 
The Global database can be recovered to a single location or ALL locations – this functionality is only 
available at the HUB. New syntax is: 

RECOVER GLOBAL TO ALL/LOCATIONS 

RECOVER GLOBAL [AT <locname>] [FROM <locname>] 



 
 

  
 

82 

7.3 Improved Messaging 
We have continued to improve the messaging system within Global, as with previous releases.  

7.3.1 New - Daemon Messages numbered 
We have now used the PDMS message module system to number Global messages. A new module 
(102) has been created to report Global specific errors. Extract error messages share Module 43 with 
PDMS so that Users should see the same error messages whether it is a local or remote extract 
command (please note that remote commands still uses the transaction database).  

These messages can be extracted by using standard PML. 

7.3.2 Reduced Console Messages 
Messages reported in the Daemon ‘console’ window have been reduced. However, this is an ongoing 
task, so some messages are still echoed to this window. 

7.3.3 Extended Update Messages 
The inter-DB macros, transfer of other Data and pre and post execution scripts (EXECA and EXECB) 
now run in their own operations enabling better reporting of messages, success and failures. 

7.4 Improved Offline Locations 
The offline location functionality has been revisited to improve the robustness, a number of problems 
have been identified and resolved – see Chapter 4. 

7.5 Synchronise Drawings command 
A new command allows the Global Administrator to synchronise drawing files (for PADD databases) 
without the need to modify the Drawing database itself.  

New Syntax: SYNCHRONISE <dbnam> DRAWINGS/ONLY [FORCE/PICFD] 

It is possible to override the PICFD attribute by using the FORCEPICFD option.  

Note: This command can only be used for individual databases and cannot be used on a subset of 
databases. 

7.6 New Query remote Banner 
It is now possible to query the Global Daemon banner at remote locations allowing system 
administrators to be sure that a compatible daemon is running (including patch releases). Please note: 
that it is not possible to query banners of a previous version. 

New Syntax: 
 QUERY REMOTE <locnam> BANNER 
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7.7 Extended Remote Merging 
Minor improvements have been made to the Remote Merge functionality within Global. It is now 
possible to remote merge the Global database. 

Also Remote Merge can be scheduled at given time using the syntax: 
REMOTE <locnam> MERGE <dbname> AT <time> . . . 

A Timed Merge button has been added to the Global Merge form: 

 
 

Clicking the button causes this form to be displayed: 

 



 
 

  
 

84 

7.8 Improved Create Satellite functionality 
On creation of a new satellite the system DB is allocated to all online and un-initialised locations.  

Also the automatic expunge has now been removed (except for the new system DB) which would lead 
to spurious Reverse propagation errors. 

7.9 Changed – Default settings 
The daemon uses an internal loop to process commands, this progresses the state of the command, and 
its sub-commands and operations through the actions that the command must carry out. This is 
configured by the attribute setting LEVENL located on the LCTIML element.  

The default setting has been changed from 5 seconds to 1 second, and should result in the commands 
completing in a timelier manner. For existing projects this value will need to be changed by hand and 
can be found in the Transaction Timings menu option located under the Settings menu option of the 
main form: 

 

7.10 Improvements to Drawing Files 

7.10.1 Removal of Drawing File limit 
The restriction of the limit for propagating drawing file of 500 per database has been removed. All 
drawing files are propagated in one go now.  

7.10.2 Better support for Extracts 
Drawing Files that are referenced from Extracts are now handled better; drawing file deletion is now 
protected if 2 extracts share the same drawing file.  

7.10.3 Better Management of Final Designer Files 
Final Designer files are managed better for databases with non-propagating drawing files.  

7.10.4 Improved Allocate Drawing Files 
The allocation of the Drawing files has been decoupled from the main allocation process. This means 
that the allocation of the database can complete whilst the drawing file allocation can take longer. 
This allows the database to be accessed without having all the drawing files available.  
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8 Catalogue & Specification 

The user interface for all aspects of catalogues, specifications and material properties has been 
extensively revised. In addition, the PDMS 12.0 Catalogue data structures provide capabilities for 
new disciplines and support various new features elsewhere in the system. An introduction to the new 
facilities is provided in the new Catalogues and Specifications User Guide. 

8.1 Integrated user interface  
A completely new GUI for Paragon, together with associated database enhancements, provides a 
much enhanced method of building and editing the Component Catalogue, Material Property and 
Specifications to be used on a project. This covers the Piping, Equipment, Steelwork and HVAC 
disciplines. 

The new user interface includes new forms to manage pipe specifications, selection tables, part 
families and categories. The General application provides a common set of menus for non-discipline 
specific activities; there are also individual applications for each discipline. Several of these new 
applications use Selection Tables instead of Specifications.  

8.1.1 Catalogue Explorer 
There is also a new Explorer that provides access to the Catalogue, Properties, Design and DRAFT 
(PADD) databases. This allows references to be made to other catalogue elements, properties 
elements, design templates, and DRAFT symbol sets. 

8.1.2 Storage Areas 
The new Storage Areas form, available from the Settings menu, is used to define where various types 
of data are to be stored, on a per discipline basis. For each entry, the form indicates the allowable type 
of storage element, and enables selection by entering a name or by navigating to the element and 
clicking on a CE button. The storage element does not take effect until the OK or Apply button is 
clicked. 

From the File menu on this form, the user can save and load settings for all PDMS users, for the 
project, or for themselves only.  

The settings are stored in the file cat-refdata.pmldat in one of the directories: 
%pdmsdflts% 

%<proj>dflts%, e.g. %samdflts% 

%pdmsuser% 

Only administrative users may save to the first two locations. 

8.1.3 Create menu 
This can be used to create the storage elements, both top level and lower level, and other data such as 
Geometry Sets (GMSE) etc. 

8.1.4 Catalogue search tool 



 
 

  
 

86 

There is a new Search form can be used for a variety of purposes. This example shows it invoked 
from the DRAFT Symbol Set form. 

 

8.2 Parts, Part Worlds and Families  
There is a new concept of Part elements (GPART), grouped in Part Families (PRTELE), which are 
stored in a Part World (PRTWLD). The GPART element has the same standard attributes as a SPCO, 
including CATREF, DETREF, MATXT, CMPREF and BLTREF, along with other attributes. It is 
also possible to add user-defined properties to each individual part. 

Parts can be added to the new Selection Tables for selection in the design model: these can be used for 
all disciplines except piping. For the piping discipline, it is possible to add Parts to Piping 
Specifications in the same way as SPCOs, and there is a utility for converting PDMS 11.6 piping 
specifications to use Parts. 

It is also possible to select Parts in the design model directly from the catalogue, using filtered 
searches. 

Part Families are managed via the new Part Family form, available from the menu entry Modify > 
Part Family. Multiple versions of this form can be shown concurrently, allowing different Part 
Families to be viewed simultaneously.  
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The Part Family list allows the user to select some or all of the parts in the family for modification. 
Information displayed and updated in the lower panels then applies to all the parts selected.  

A different Part Family can be displayed using the CE button and a Part Family viewed earlier in the 
current session can be selected from the list alongside the CE button. 

The General Attributes and References links control which data are displayed in the lower panel. 

New parts can be created using the various Create links. Parts are created relative to the current 
selection in the list. Selected parts can be deleted using the Delete button. 

8.2.1 General Attributes 
The Attributes view displays the key part attributes. If other attributes are to be modified, this can be 
achieved using the Modify Attributes form invoked via the Edit All Attributes button.  

When multiple parts are selected, any data item that is not the same for all selected parts is indicated 
by the text “<Multiple values>”, as shown in the Attributes view alongside. 

Any updates will be applied to all selected parts. Updates will not be applied for fields that contain the 
text “<Multiple values>”. 

8.2.2 Reference Attributes 
The References panel displays the reference attributes for the selected parts – Catalogue ref, Template 
ref, DRAFT Symbol Set ref, Detail Text, Material Text, Bolt ref. and Component ref. Selecting a 
reference in the list displays the current setting. This can be changed by entering the name of a new 
reference element, by navigating to the new reference element and pressing the CE button on this 
panel, or by pressing the Search button to search for an appropriate reference element. 

Each reference attribute has its own display in the right hand side of the panel. These are shown below 
for a flange (except for the template which is shown for a pump). Data shown inactive are read-only 
on this form. The reference element itself may be modified by pressing the Edit 3D Model button on 
the panel. 
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The various editing options invoke various specialised form, such as the Category form for 3D editing 
or the DRAFT Symbol Set Form for the DRSSREF. 

For full details, refer to the Catalogues and Specifications User Guide – Chapter 4 Working With 
PARAGON Applications. 

The Search button on each Reference panel brings up the Search panel, containing the Search control. 
This panel appears with the appropriate search criteria for attribute concerned; the user can make any 
desired changes and then press the Find button. If a result row is selected, the Use button will be 
activated; this returns to the Reference panel with the chosen value ready to Apply Changes. The 
Back button returns to the Reference panel unchanged. 

8.3 Autonaming 
Auto Naming is now available under the menu Settings > Naming. It works in the same way as Auto 
Naming in Design.  

Naming rules are stored in the file %pdmsdflts%\cat-nam.pmldat. Element type rules are stored in the 
file %pdmsdflts%\cat-element-rules.pmldat 

A basic example set of rules is included for reference. 

8.4 Specifications and Selection Tables  

8.4.1 Pipe Specs 
Piping specifications are managed by the new View Specification form, available from the menu entry 
Modify > Specification in the Pipework Application. When first displayed, this lists all SPCOMS in 
spec order. Columns list the selectors and references – this view replaces the Specon text output. 
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Items in the table can be sorted by column by clicking the column heading in the usual spreadsheet 
manner. The view can also be toggled between an ‘Engineering View’ and a ‘CAD view’. 

8.4.2 Piping Tables 
In addition to the COCO (Connection Compatibility) and the Nominal Bore/Wall Thickness tables, 
there is a new Branch/Reducer Table in the PARAGON database. 

New form controls are available to enable easy configuration and maintenance. These controls allow 
you to create, modify and delete table information without having an immediate effect on any active 
databases. When you have finished the modifications, you can either Apply the changes, Reload the 
control to the initial state or just cancel the form. 

The pictures overleaf show the Nominal Bore and Branch/Reducer tables. Full details of the new 
forms are given in the Catalogues & Specifications User Guide. 
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Nominal Bore table 

 
Branch/Reducer table 
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8.4.3 Equipment Specifications  
Equipment specifications may now be used to select Equipment templates. These specifications may 
reference components (SCOM) containing parameters for a family of equipment components.  

Parameterised obstruction volumes and maintenance volumes can of course be incorporated into the 
template definition. 

8.4.4 Selection Tables 
All applications other than Pipework (i.e. Steelwork, Equipment and HVAC) use the new Selection 
Tables, managed by the new Selection Table form, available from the menu entry Modify > Selection 
Table. This form allows the user to control all the data required to define a Selection Table, its 
Questions and Answers. Multiple versions of this form can be shown concurrently, allowing different 
Selection Tables to be viewed simultaneously. 
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The Selection Table form allows the user to select some or all of the rows in the table for 
modification. Information displayed and updated in the lower panels then applies to all the rows 
selected.  

A different Selection Table can be displayed using the CE button; a Selection Table viewed earlier in 
the current session can be selected from the dropdown list alongside the CE button. 

Parts from a Part Family (see below for Part Family form description) can be added using the Add 
Items (from CE) link label (the current element must be a Part Family, i.e. a PRTELE that has GPART 
members). Selected rows can be deleted using the Delete Selection link label. The link labels control 
the data displayed in the lower panels. 

8.5 Symbolic representation of design objects  
The catalogue component SCOM can now reference 2D symbols as well as 3D geometry. These can 
be used in DRAFT in place of, or in addition to, the 3D picture – see section 16.6 Symbolic 
representation of model objects.  

The database structure is analogous to the point and geometry references, which point to PTSETs and 
GMSETs. The SCOM now has a DRSSref that points to a DRSSET in a CATE, STCA, SECT or 
STSE. These DRSSETs have references to DRSYLK elements in a DRAFT (i.e. PADDLE) database. 
These are the templates for the 2D design symbols that are referenced by the Catalogue. 

It is envisaged that most users will use a standard DRAFT symbol library in such a database in a 
manner similar to the master discipline catalogues, probably in a master project such as the sample 
MAS project. In this way, the data structures in the PADDLE database for symbols and symbol 
libraries can be reused and the DRAFT design symbols can be made available in user projects by 
including a foreign reference to the relevant MDB in the master project. This makes the 2D design 
symbols available throughout the organisation but prevents most users from modifying them. 

As the DRAFT design symbol libraries will be stored within a Foreign project database (e.g. MAS), 
then it will be the responsibility of the system/project administrator for the Foreign project to 
distribute them globally. The PDMS Global application only distributes databases for a given project. 
Thus if MAS is required at another location, then the system/project administrator must either make 
that a Global project or otherwise arrange for its distribution. 

Use of Sheets and Overlays should be avoided within the design symbol database since these will 
complicate distribution of these libraries. 

It should be possible to use a normal reconfiguration for a project in which elements of a master 
DRAFT design symbol database are referenced from the Catalogue in this way.  

8.6 Allowable angle attribute for ppoints  
A new attribute (ALLANG) is available on PTAX, PTMI, PTCA & PTPOS elements. Its primary 
purpose is to allow additional data checking for HVAC ducting. 
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9 Design Changes  

9.1 Associations  
The system now allows the user to create, modify, view and report positional, dimensional, or 
geometric associations between multi-disciplinary elements, and provides graphical feedback on 
invalid associations. 

Associations are stored in DESIGN databases but remain independent of the objects that they link. 
They may therefore be stored in an independent DESI database, with no design data, that is accessible 
for writing to all users who can create Associations. This means that, for example, a user with access 
to Equipment may relate its position to a structural object without having to have any access to the 
structure itself.  

Associations (ASSOC) are organised in groups (ASSOGP) in an Association World (ASSOWL) and 
contain a number of objects defining the relationships and the related objects.  They also reference a 
master Association Definition, which defines the various types of Association and the rules under 
which they operate. These are also in a separate database, to which the users’ access may be restricted, 
if required.  

The diagram shows the relationship between Association Definitions, Association (Instances), and 
Design elements participating in Associations.  All references are one way.  A design element may be 
referenced by many Association Instances; an Association Definition may be referenced by many 
Association Instances. 
  

 
 

Associations are quite complex but will most often be incorporated in an application for use by the 
end user. For example, PDMS 12.0 uses them in the Hole Management and Equipment Associations 
applications. 
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9.2 Hole Management  
The Hole Management System provides additional functions for penetrations and allows control and 
reporting of data associated with a ‘managed’ hole, which may include multiple penetrating objects. It 
uses the new ‘Association’ functions to: 

• Manage the communication of hole data between disciplines  
• Check data consistency on request providing relevant user feedback 
• Allow discipline communication of data for managed holes  
• Generate reports on managed holes 

The old Penetrations application menu bar has been removed from all discipline utilities menus, but 
can be reinstated by defining the global PML variable !!USEOLDPEN in the product start-up. 
However, this application has not been fully tested at this release. 

Hole Management uses some new terminology, which is summarised here: 

Managed Hole The elements and data being managed by the Hole Management system 

Virtual Hole The modelled representation of the required hole shape 

Real Hole The model geometry of the hole 

Penetration  Model geometry added by the Penetrations application 

The Application is accessed using the new utilities menu bar commands Utilities>Pipe Penetrations 
in the Piping application, Utilities>HVAC Penetrations in the HVAC application, and 
Utilities>Steel Penetrations in the Structural applications. Each Penetrations menu has a sub-menu 
with Create, Modify and Seal Plates commands, for example:  

  
Details of the application can be found in chapter 4 ‘Multi Disciplinary Penetration and Hole 
Management’ in the Design Common Functionality User Guide.  

9.3 Plant Grids  
A new Plant Grid Systems option on the utilities menu enables the creation, modification and 
display of both local and project wide grid systems. These grids are stored in the database and may be 
either linear or radial. Extensive options are provided for regular or irregular spacing, position and 
orientation, labelling, and for setting their extents.  

A menu option enables the display of any picked position in coordinates relative to the currently 
selected grid. The pick uses the standard position toolbar so any element, ppoint, graphic, etc. can be 
picked. The picked position is displayed in both world and grid coordinates (note that the designer can 
make use of this information to define clipping planes by selecting gridlines that include the region of 
interest – see below). 
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A wide range of options, including both 2D and 3D lines and various labelling options, enables the 
display of grids to be suited to the task in hand. 

9.4 Six plane clipping of volume view 
The volume view clipping menu (secondary mouse click on the Clipping & Options button on the 
view frame) has been extended with a Planes… option. This provides an alternative to the clipping 
box: up to 6 individual planes may be defined to clip the model. These may be aligned on plant items 
such as panels and beams, or by selecting grid lines. 

The Clip form enables the planes can be defined and enabled. Up to 6 clip planes can be defined, at 
any angle, to suit irregularly shaped areas. The direction of a plane is considered to point into the 
region of interest. 

Once plane position and direction have been obtained from the picked item, the plane can be enabled. 
It can then be finely adjusted using the nudge and slide gadgets with the graphics changing as you 
move the slider. The reverse direction button is useful, for example where a floor plate is picked and 
the view must be above or below it. 

9.5 Data Listing 
Improvements have been made to DATAL function to support project copying, by making it possible 
to navigate the database when creating elements. In order to provide this, the additional keywords 
LOCATE and REPLACE have been added to the NEW command. 

9.5.1 Changes to NEW syntax 
The NEW command to create elements now includes 2 optional keywords: 

The LOCATE keyword will navigate to an element with the specified name and type; if it does not 
exist, it will be created. The newly created element will always go at the end of the current list. NEW 
LOCATE EQUI /VESS1 creates new elements in /VESS1. 

The REPLACE keyword will replace an existing element with the specified name and type; if it does 
not exist, it will be created. If the named element already exists, it will be deleted, and re-created at 
the same point in the hierarchy with the same reference number. If not, it will go at the end of the 
current list. For example NEW REPLACE EQUI /VESS1 will overwrite /VESS1. 

In either case, both the name and element type must match.  

9.5.2 Support for Long arrays 
Integer arrays up to 8192 long are now supported in PDMS. These may be input using the APPEND 
syntax to extend an array; and Data listing output splits the array across a number of command-lines 
using the APPEND syntax: 

ELDATA 1 2 3 4 5 6 7 8 9 

ELDATA APPE 10 11 12 

Use of APPEND avoids the need to specify a start point explicitly. 

It is not possible for the entire array to be extracted in a single expression (other than through Datal 
output). However use of the NUMBER qualifier allows parts of the array to be extracted: 
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Q ELDATA NUM 1 to 1000 

Q ELDATA NUM 8192 

Q var !!CE.DTLTST[8192] 

The error (2,136) will be returned for an unqualified array if the attribute is larger than that allowed 
for expressions (1000) 

Note that APPEND syntax can only be used for integer arrays. 

9.5.3 Changes to OUTPUT command 
OUTPUT syntax now includes new options LOCATE and REPLACE. Both may be used together to 
locate the new element at the required position in the hierarchy. Elements above the selected elements 
will be included in the output with the LOCATE keyword, and the selected elements will be included 
using the REPLACE keyword. For example, if both keywords are used: 
 NEW LOCATE SITE/ATEST 

 NEW LOCATE ZONE /ZONE1.EQUIP 

 NEW REPLACE EQUIP /VESS1 

These options are not available with OUTPUT CHANGES syntax. Note that this functionality is less 
powerful than OUTPUT CHANGES, since only the selected elements will be replaced; members of 
these elements will be newly created. 

Both OUTPUT and OUTPUT CHANGES now begin with the syntax INPUT BEGIN and end with the 
syntax INPUT END. The list of elements and attributes to be output can be modified using two new 
attributes DTLLIS and DTLELE. 

• DTLLIS specifies a list of attributes to be output. The default is the attribute list ATTLIS. 

• DTLELE specifies a list of elements to be output; if unset, the current element is used. 
Otherwise, the current element must be included explicitly if required. 

9.6 Changes to EXPORT command   *12.0.SP5* 
The Review Export file format has a new option to enable the export of insulation and obstruction 
translucency and colours from PDMS to Review – but please note that Review 12.0.SP2 or later is 
required to display this new format. This gives the Review user browsing the PDMS model a quick 
and simple way of producing a useful display, with the option of including translucent insulation 
and/or obstruction geometry. 

The new syntax to export representation is: 

EXPORT REPR/ESENTATION ON 

EXPORT REPR/ESENTATION OFF 

When set ON, the Design colours defined by the Export Autocolour rules, with translucency of 
insulation or obstruction primitives set using the Representation settings, will be exported.  

This new option is not currently supported in the Design GUI. 
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9.7 Enhancements to Drawlist & Explorer  *12.0.SP5* 
The Drawlist now tracks changes automatically and the Refresh lists button has been removed. 
Update Display and Reset buttons have been removed and Visual properties are now applied 
individually after they are changed. The Remove button has become Remove selection. 

It is now possible to add or remove, from the Drawlist, a primitive only rather than the significant 
element. This can be done from the Explorer using new context menus under 3D View to Add Only 
or Remove Only. Alternatively, primitives can be added by keeping the <CTRL> key pressed while 
Dragging and Dropping from the Explorer to the 3D view. 
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10 Engineering Disciplines 

All the engineering applications have had major improvements, which are detailed below. In addition, 
there are some upgrades common to several or all of them, which are listed in this chapter. 

10.1 Organisation by system  
Pipes, Equipment, HVAC & Cable Trays may now be organised by system as well as in the usual 
geographical SITE, ZONE… structure. These systems may be used for reporting, display and other 
operations.  

The systems are set up by administrators (see section 3.2) and then populated by designers. 

The contents are manipulated using the System Explorer:  

 
An Explorer pop-up menu allows you to access a system in the 3D view and a Utilities menu option 
allows you to modify the system. 
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11 Equipment 

The PDMS 12.0 ‘Equipment’ Discipline has the following new features: 

11.1 Design Template Application  
The Design Template Application has been extensively improved and incorporates the use of more 
advanced GUI tools. Templates are created using the Create>Template… menu. The Template 
Information section is unchanged from earlier versions of PDMS. Aspects that have been updated 
include:  

• Design Templates with no geometry – may now be created  

• Primitive creation and manipulation 

• Search tool 

To create a Design Template containing no Design geometry, leave the Copy a Model to this Design 
Template box unchecked, and press the OK button. 

The Parameterisation form (Modify>Parameterisation…) has been updated and now provides: 

• Repeat element rules 

• Local Name definition functions 

• A rule definition form with a list of properties available  

• A new GUI for Design Parameter rules and Easting, Northing, Upping rules in the attributes 
list at the bottom of the parameterisation form. 
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11.2 Primitive Creation 
A new primitive creation form is accessible from the Equipment application from the 
Create>Primitives menu.  This form is also used for the new Volume Model. 

 

 

Template Information 

Copy Design Model 
into Template
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Picking a primitive type will lead to a further form – for example, the box creation form, for entry of 
the appropriate attributes.  

 

  
 

11.3 Selection from specification  
Equipment templates can now be selected via a specification and changes in the template can be 
propagated to all instances of that item in the project.  

This allows modifications to a Design Template master to be propagated to its linked instances. In 
previous releases, this was not the case as the instances are copies of the master. This is different from 
catalogue components as instances of a catalogue components change as soon as the master catalogue 
component definition is changed. 

The system now determines which Design Template instances need to be updated by comparing the 
last session date of the Design Template master with the session date for each of its Design Template 
instances. When the user requests that an instance is updated, the system will try to maintain electrical 
connections and connection to nozzles. Other connections, such as associative dimensions on 
drawings and Associations must be resolved by the user. 

There are some changes to the Design Template definition that cannot be propagated to Design 
Template instances, where it is not logically possible to resolve the instance with the new master 
definition. For example, changing the meaning or order of Design Parameters; removing connection 
elements (e.g. nozzles) from the master where that item has been connected in an instance. In such 
cases, it will be necessary to delete the instance and create a new instance from the new Design 
Template master. 

It is possible to disconnect a Design Template instance from its master definition. If a Design 
Template instance has been disconnected from its master definition it will not be updated by Design 
Template propagation. 
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The Design Template change propagation form is shown by using the Utilities>Propagate Changes… 
menu command. 

The form below shows all linked instances of Design Template /ADV/VESS004. All of the instances 
are marked as Suspect. This means that the master Design Template has been modified either in the 
same session or in a subsequent session to the last modification to the Design Template instances, and 
consequently they should be considered for propagation of changes. 

Note that Design Template instances may be updated only if the user has full access to modify each 
instance. If any instances are claimed by another user, or modification is prevented by Data Access 
Control then the update will fail. 

 

 
 

List of Template Instances

Date of session when last modified 

The State column indicates whether 
the instance needs to be updated 
before the Update operation, and 
reports the success or failure of the 
operation when the update has 
finished 

The Message column reports on 
Update failures after the update 
operation has finished 

Filters the Design Template 
instances shown in the list according 
to the State column 

Message area for information about 
individual Design Template 
instances 

Display selected Instances in a 3D 

Print preview of the current content of 
the table on the form 

Performs the Update operation
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11.4 Associations Utility  
The Equipment application now allows users to apply geometrical constraints between a piece of 
Equipment and its surroundings for subsequent design checking. This uses the new Association 
system (see section 3.6) that stores constraints between geometrical features (e.g. Ppoints, Design 
Points and Plines) on Equipment and other significant Design elements. It should be noted that 
Associations are passive relationships that do not necessarily fully constrain an object in the model, so 
the system reports broken constraints but does not modify the model to resolve them. 

An Equipment Association is a design rule that can be checked by the system. The system requires 
that a set of Association Definitions is loaded into each MDB where Associations are to be used. The 
MAS project supplied includes a new database MASTER/ASSOCDEFN (DBNO 7027) that contains 
the Associations used by the application. Users who wish to use Equipment Associations should load 
this database, or its Association Definition World, into their project. They do not need to load the data 
if they do not intend to use this utility; it can be loaded at a later stage of the project if required. 

The Equipment Associations utility in the Utilities menu provides the ability to create, modify, 
delete and view details of Equipment Associations. It will report success if a design constraint is 
satisfied by the model, and it will report failure for a design constraint that is not satisfied by the 
model. 

11.5 Equipment Reports  
A new Equipment Report option is available from the Utilities menu. This initiates a form that 
enables users to pick and sort the required attributes in the Columns tab for inclusion in the report 
shown in a grid control in the Output tab. 
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The grid control provides facilities for filtering, sorting and modification of columns, and export to 
Excel. 

11.6 Import Equipment from file  
Equipment data may now be imported from a CSV format text file, formatted according to certain 
rules. This allows Equipment tags and descriptions to be imported from another system. It is 
anticipated that this function will be used near the beginning of a project to pre-populate a Design 
database with a list of Equipment. The geometry of the imported equipment will not be defined by 
this method, but may be supplied using the usual GUI. 

The Utilities>Import Equipment… menu command first shows a standard file browser to pick the 
file to be loaded. Pressing the Open button displays the content of the selected spreadsheet in the 
following form. 
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At this stage, this is just a preview and no data has been loaded. The icons give an indication of the 
status of the data and whether or not a piece of equipment with that name already exists in PDMS. If it 
already exists, or the system detects another error, it will not be created. 

Pressing the Load All Data button will process all of the rows with no error that create a new element 
or modify an existing element. Pressing the Load New Data button will process only the rows that 
create new elements. 
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12 Piping 

The Piping application has the following new features: 

12.1 Split Pipe at Defined Boundary 
A new ‘Pipe Splitting’ option in the piping utilities menu allows a pipe to be split into two separate 
pipe elements at a defined planar boundary. Pipes may be split into segments within the same branch, 
new branches or new pipes – with many options for achieving the desired result. At split points, the 
system allows break components such as flanges sets or couplings to be inserted. Multiple pipes may 
be split on a single plane such as a wall or bulkhead.  

12.2 Change Pipe Bore or Specification  
A new ‘Component bore/specification’ option in the Modify menu allows the bore or specifications 
(piping, insulation or tracing) of one or more components in a pipe or branch. This will display a form 
with details of selected pipe or branch.  
 

 
 
After selection of the appropriate items, a popup menu offers a means of making the changes: 
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12.3 Pipe Component Assemblies  
The system now allows standard pipe component assemblies to be defined and stored for reuse (select 
and instance). These assemblies are prototypes of a design configuration which can be re-used in 
multiple design situations. The development has two main roles: 

• To provide a building and storage mechanism for piping assemblies. This saves assemblies 
for use as required but ensures that they are not picked up for clash checks or design reporting. 

• To provide a selection and insertion mechanism to enable the assemblies to be used. 

Data for piping assemblies is stored in the new Application Data World (APPLDW), which contains a 
data structure similar to the design database. This allows it to be treated as a separate entity from the 
point of view of clashes and reporting. 

Assemblies are defined using Utilities>Piping Assemblies… 

Assembly Creation & Administration Application 

• Create assembly & define origin 

• Define bore range and available specification 

• Note: a user function may be called 

 

Assembly Instances 
When an assembly is inserted into the design, it is a similar item to the assembly prototype but may 
use different bores and specifications in the context in which it is placed. As a consequence, the 
components created by inserting an assembly are individual design items with no reference back to 
the original assembly. Normal UNDO capabilities are available, but the user cannot select an inserted 
assembly as a single entity. 
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12.4 Improved Mitred Pipe Bends   
The modelling of multi-segment mitred pipe bends has been improved and allows more accurate pipe 
cut-lengths to be reported. This has been achieved by adding an NCUTS attribute to the BEND 
element. Like RADIUS and ANGLE, it is always available for definition and query, but does not 
always affect the model – that depends on the catalogue.  

 

 
NCUTS is taken into account only if: 

• The catalogue item has no GMSET (so implicit bend geometry is required) 

• The catalogue parameters do not have a zero-or-positive value for parameter 4  
(if CPAR(4) is zero-or-positive, it is used as the number of cuts) 

The maximum number of cuts is treated as 25. If the number of cuts is zero or negative, the bend is 
treated as pulled rather than mitred. 

Dynamic Ppoints are implemented along the mitre-cuts by extending the associated pseudo-attributes 
to cope with the extra qualifiers: 10, 11, 12, 13, … as appropriate. 

As a 25-cut mitred 180-degree bend would have 130 Ppoints, the SIZE attribute of %PPLS %PPVI 
has been extended from 100 to 200. The following pseudo-attributes are supported: 

• PPLS/T   List of valid p-points 

• PPCOU/NT  Number of valid p-points 

• PPOS/ITION  P-point position 

• PDIR/ECTION  P-point direction 

• PPCO/NNECTION  P-point connection type 

• PPSK/EY   P-point pskey 

• PPBO/RE   P-point bore 

• PPVIF/LAG  P-point visibility flag 

• PPEXST   P-point existence flag 

12.5 Automatic Generation of Pipe Spools 

NCUTS 3 NCUTS 0 NCUTS 1 
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PDMS 11.6.sp4 introduced the automatic generation of pipe spool definitions within the design 
function, from the start of the pipe modelling activities. It also introduced the Production checks 
utility which validated the design for bending and fabrication of the spools. 

(Note that these spool definitions differ from those defined in the separate spooler module, which can 
be used to define ‘spool’ isometrics that can also be used for other purposes. The new spool elements 
cannot yet be drawn by Isodraft, but can be used to produce to-scale pipe fabrication sketches.) 

The PDMS 11.6 development did not however provide a mechanism for spool naming; this omission 
has now been rectified. Spool names are derived on spool creation using the standard PDMS auto 
naming functionality. There is also an individual spool renaming capability and a rename all option.  

12.5.1 Auto-Naming 
Auto-naming enables new spools to be named when they are generated, using the auto-naming rules, 
which need to be set up for PSPOOL elements. If auto-naming is turned off, spools will be given 
default names (Spool1, Spool2...). 

Auto-naming is controlled by clicking on the “Define Auto-Naming Preferences” link under “Setup 
Production Checks”; feedback shows whether it is currently “ON” or “OFF”: 

 
To turn it on, tick the checkbox and click apply, when you will then be taken back to ““Setup 
Production Checks”. The back button will take you back to “Setup Production Checks” with no 
changes are applied. Naming rules can be set up by clicking on the “Define Naming Rules…” link. 
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12.6 Router 
The Advanced Pipe Router product is now included with PDMS, as standard. 

12.7 Bending checks  
(First introduced at PDMS 11.6.sp4) 

A new option allows you to check pipe pieces and pipe spools for production readiness against 
welding machines, bending machines, pipe cut lengths on drawings and reports, and defined stock-
lengths of tubing. 

Fabrication checks run against available stock length and fabrication machines. 

• Fabrication machines are currently limited to bending and auto welding. 

Pipes designed and checked in this way may be detailed using the new pipe-sketch facility – but not 
yet with Isodraft.  

12.8 Pipe Sketch ADP 
Automatic Drawing Production (ADP) has a new option to produce pipe sketches automatically using 
production-checked pipe-spool data from the Design application (see above). The sketches include 
dimensioned scale drawings of a pipe spool along with tables of relevant manufacturing data.  

Pipe Sketch drawings are based on a Template Drawing, which contains views and layers like any 
other DRAFT Template; for other Drawing information the Template Drawing references a Backing 
Sheet. Users will generally have their own Sketch Templates for Pipe Sketches. 

12.9 Pipe Data Table     *12.0.sp5* 
Pipe data tables provide a lookup for bore related data, with a Pipe Data element for each bore size in 
the piping spec. It is currently designed to hold data on wall thickness, corrosion allowance and flange 
allowance; other values could be added in future if required.  

The tables are set up in Paragon: 
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Typical data: 

 
These tables refer in turn to Wall Thickness and Corrosion Allowance tables, which behave in a 
similar manner. 

12.10  Wall Thickness Table    *12.0.sp5* 
This is based on the nominal tables introduced in PDMS 12.0 and replaces a text based system with 
tables, which are simple and easy to implement but flexible enough to cater for multiple wall 
thicknesses. 
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12.11 Linking Pipe Spec to Wall Thickness *12.0.sp5* 
At Pipe Spec level there is an attribute PDAREF. Setting this on a spec is all that is required to enable 
Pipe Data Tables.  
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Each SPCOM also has a PDAREF attribute which takes priority over the spec PDAREF, thereby 
overriding the spec level wall thickness. This enables different wall thicknesses at the same bore and 
caters for multiple tubes, thick walled elbows, unavailable material etc. 

12.12 Design Queries     *12.0.sp5* 
A number of new Queries allow access to the evaluated wall thickness or corrosion allowance at the 
various ppoints. The old Q WALTH continues to work in the same way, for compatibility. 

Similarly, there are new queries for flange allowance and also for the pipe data table references.  

12.13 Flange Allowances    *12.0.sp5* 
An SCOM now has a COMPTYPE attribute. If set to ALLO, a loose flange allowance ALLOW 
attribute will be calculated according to an expression in the PDATAB, according to the bore size. 

A typical example might be: 
PFLALLOWANCE (10*ATTRIB PWALLT(1)) 

When such an allowance flange is selected, the allowance value is calculated and added to the allow 
attribute of the flange, and its loose attribute set to true. 

12.14 Bend Radius Enhancements  *12.0.sp5* 
There is a new attribute BENDMACREF at ZONE level, which can be set to the appropriate bending 
machine. 

This enables the bend radius to be obtained from either the pipe spec or the bending machine: 
• First priority is the radius set in the spec selectors 
• Second priority is to check the zone for a fabrication machine group and validate the bend 

against this. 

This operation is performed when the CompType on the relevant SCOM is VAR. 

Each bending machine has a series of dimension elements with attributes of OD and Bend radius. 
When an attempt is made to get a bend radius from the bending machine, these dimensions are 
searched to find an appropriate tube OD.  

The actual bend radius is calculated by multiplying the OD by the BRAD; if no matching dimensions 
are found the radius cannot be calculated and the radius must be set by the user. 

A new pseudo attribute DFBRAD at bend returns the machine derived radius if available. 

12.15 Enhanced Production Checks  *12.0.sp5* 
A number of enhancements have been made to improve the pipe production checks: 

• Pipe Spools and Pipe Pieces are now visible in the Design Explorer.  

• Option on the production checks form to delete all spools in a pipe  
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• Validation and spooling log file to help track down errors. The Pipe Production Checks form 
has a new link label under “Pipe Tasks” called “View Log”. This opens a viewer with tabs for 
validation and spool generation; the output can also be printed or sent to a file. 

• Feed Excess warnings now advise the user of additional material needed for the bending 
process, both at spool generation and on the production checks form. 

• Stock Length Read Only 

• Auto naming is now on by default for spool creation. Pipe spools can now be renamed from 
the results panel on the production checks form, as well as the main view.  

• Introduction of two extra spool types 

• New attributes are now available for use on pipe spool drawings. 
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13 Structural 

13.1 Access, Stairs & Ladders (ASL)    *12.0.sp5* 
This is a completely new application that replaces the old ASL application.  It features: 

• Fully Parametric Stair Tower, Stair Flight, Stair Landing, Platform, Ladder, Cage, Handrail 
and Gate steel assemblies using Structural steel objects 

• New database architecture with meaningful names such as Stair, Ladder, Cage, Rail, Tread… 
and attributes using engineering terminology 
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• Standards are easily 
configurable by the 
Administrator 
(Settings>ASL Standards) to 
conform to Design 
Specification; ANSI, BS, 
DIN, Project, User standards 

• Graphical picking of ‘Work 
Points’ is used for creation 
and modification  

• System performs intelligent 
evaluation of engineering 
criteria with relevant user 
feedback 

 

 

 

 

 

 

Please note that a number of shortfalls are present in the new Access, Stairs & Ladders application at 
PDMS 12.0. To address these shortfalls, a number of improvements have been identified. The 
proposed improvements are currently being planned and release dates will be communicated to the 
customer base in Q1 of 2010. 

Until the proposed changes are implemented it is recommended that the old primitive-based ASL 
application, as delivered with previous releases, is used for engineering projects in a production 
environment. Details of how to do this are given in section 2.9.1. 

13.2 Enhanced member splitting 
There is a new UI for splitting Steel members, including Profiles and Plates, without the need for a 
sub-application switch. 

13.3 Enhanced Mitred ends  
There is additional functionality to support User-defined connections for End-cut, Snip, Cut-out, Slot, 
and Mitre that connect GENSEC, SCTN to a Planar Panel. 
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14 Heating & Ventilating (HVAC) 

See the HVAC User guide for more information. 

14.1 Organisation by module & system 
In common with other disciplines, HVAC may now be organised in an alternative hierarchy. Please 
see section 10.1 Organisation by system . 

14.2 Splitting  
This provides a simple way to split an HVAC system into different sections, using the following 
operations: 

• Define a list of HVAC branches to split 
• Create a split plane  
• Create markers (split ATTAs) at the positions derived by the intersection of the split plane 

and the implied tube of HVAC branches in the list 
• Split the HVAC system at the markers 

The HVAC Designer form to be used is Modify > Split HVAC…  
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14.3 HVAC Model Integrity Checks  
HVAC model integrity checks have been improved to check branch connection alignment, as well as 
bolt hole and bolt circle diameter on circular ducts. 

Three new functions are available from Utilities>Data Consistency and check whether HVAC branch 
connector components are fitted correctly to the main branch:  

• Connected – Aligned with main 

• Connected – Central on Main 

• Connected – Flush or Central on main 

            
 
In order to avoid misaligned holes, the orientation of circular ducts can be checked by setting the 
PZAXIS Y and ROTANG ((360 / DESP[number]) on the connecting ppoints of circular components, 
where DESP[number] is the number of holes in the flange.  

14.4 HVAC Spooling  
HVAC can now be split into spools, identified automatically, so that they can be selected and drawn 
in DRAFT. The HVAC Spool (HSPOOL) element is a collection of HVAC elements that are to be 
fabricated together as a single spool.  

A new HVAC Spooling application, accessed from HVAC Designer Utilities menu, allows them to 
be created and maintained in the database hierarchy. A property named WKSF is used in the grouping 
of the HVAC elements into an HSPOOL hierarchy. HSPOOLs are stored in an HSLIST below the 
HVAC element. 

14.5 HVAC Sketches  



 
 

  
 

119 

The system can produce HVAC sketches that include dimensioned, scale drawings of an HVAC 
spool. These include MTO/Assembly Tables and End Point Tables and are similar to the piping 
sketches introduced at PDMS 11.6.sp4. The user interface allows the selection of User Defined 
Templates and Backing Sheets and also enables them to be printed. 

The HVAC Sketch form is accessed from DRAFT ADP Create>HVAC Sketches and allows the user 
to identify the spools from a level in the Design hierarchy. He can also select the drawing template, 
which may be user-defined, and the database location for storage of the sketches. 

 

14.6 HVAC Catalogue  
The sample HVAC catalogue has been extended, notably in the following areas: 

• Flat Oval tube representation  

• Flexible ductwork representation 

• User-defined Joints  

• User-defined Stiffeners 

It allows for accurate Weight, Centre of Gravity and Material reports. 

14.6.1 Flat Oval tube representation  
Flat oval implied tube is now shown correctly, rather than as a box. The Surface area calculation is 
also accurate. The Catalogue TUBE element now has a PAXIS attribute, similar to BOXI, to allow 
this to work. 

Note that HVAC implied tube is intended to be a temporary state in the design sequence, and should 
be filled with real components for production. 
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14.6.2 Flexible ductwork representation 
The representation of flexible ductwork has been modified to show ribs, which is particularly useful 
for DRAFT drawings. These ribs are visible in levels 9 to 10: 

       

14.6.3 User-defined Joints  
Prior to PDMS 12.0, there was a fixed set of joints, such as FJ25, FJ30, RE etc. (see manual for full 
list). It is now possible for the user to define the joints for rectangular, circular and flat oval ductwork. 

There are 6 new sections (SECT) in the HVAC catalogue database. 
/CADCHVACCATA-Joints-RECT  
/CADCHVACCATA-Joints-CIRC  
/CADCHVACCATA-Joints-FOVA 
/CADCHVACCATA-Joints-RECT-Imp 
/CADCHVACCATA-Joints-CIRC-Imp 
/CADCHVACCATA-Joints-FOVA-Imp 
These sections hold dataset elements (DATASET) for each joint, and each dataset has 7 data 
elements: …/DESC; …/CODE; …/ALPH; …/NUME;  …/HVJA; …/HVJB; …/HVJC 

The data in these data elements define a joint and all its relevant information to be used and displayed 
in the Joints form. The joints provided in the standard product are the same as before but now use this 
new mechanism so administrators can easily remove or create joints. 

A PML object HVACJOINTS is the only place that controls the HVAC Joint storage location and is 
therefore easily modified. 

14.6.4 User-defined Stiffeners 
Prior to PDMS 12.0, there was a fixed set of stiffeners, such as 25, 30, 40 etc. It is now possible for 
the user to define the stiffener sizes and codes. 

There is a new section (SECT) in the HVAC catalogue database. 
/CADCHVACCATA-Stiffeners  
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This holds dataset elements (DATASET) for each stiffener, and each dataset has 7 data elements: 
…/DESC; …/CODE;  …/HVSA; …/HVSB; …/HVSC; …/CONFIG; …/SHAPE 

The data in these data elements defines a stiffener and all its relevant information to be used for 
stiffener creation. For example: 

Stiffener     100 $<100x100x10 Angle$> 100 100 10 

The codes above are numbers such as 25, 30, 40 etc but a code can be any text such as abc123, 
xyz789 etc. 

14.7 Surface Area and Weight 
Surface area and weight are now calculated each time an HVAC component is created or modified. In 
previous versions, this was done from the Utilities>Surface Area & Weight… menu.  

 

 

 

 

 

15 Cable Design     *12.0.SP5* 

AVEVA is a new add-on product for the design of cables, including their routing in cableways and 
through penetrations. Automatic routing is possible. Output includes cable schedules with routes, 
cable cutting lists and material take off. 

Cable Design was introduced at PDMS 12.0.SP2 and has been continually enhanced in the light of 
early use on project work. It appears as a Design application but a separate Cable Design license is 
required for using the new (3D) cable objects in this application. 

For details, please refer to the new AVEVA Cable Design User Guide.  

Cable diagrams are covered in the AVEVA Diagrams User Guide – as from PDMS 12.0.SP5, they are 
licensed separately, as part of AVEVA Diagrams. 
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16 Drawing Production Enhancements 

16.1 DRAFT start-up     *12.0.sp2* 
On entry to DRAFT the graphics of all Symbol Libraries (SYLB) are loaded ready for use as required. 
Earlier versions of PDMS scan all PADD databases in the MDB for SYLBs; for large MDBs this may 
be time consuming. At PDMS 12.0, the database has been enhanced to remove the need for this scan: 
this should lead to faster DRAFT entry. The Upgrade Script for PDMS 12.0 DRAFT will update 
databases created at 11.6 (or earlier) in order to enable this new feature. 

A new command (Q SYLBTABLE STATUS) checks the status of the databases in the current MDB. 
It lists all top-level DEPT and LIBY elements and reports whether they have been successfully 
upgraded. In the event that an upgrade has not been successful, a new command (UPDATE 
SYLBTABLE) will update all writeable PADD databases in the MDB. 

16.2 AXES symbol 
A system AXES symbol that automatically indicates the world axes. 

16.3 Colours & Line-styles  
Colour has been separated from the pen definition so all attributes in the DRAFT database that stored 
pen numbers have been replaced by style and colour attributes. In addition, there is a full 256 colour 
palette with direct mapping to the AutoCAD colour palette. Please see note on Colour Table changes 
in section 5.3. 

Line styles are now database driven rather than through default files and can be defined in very fancy 
ways e.g. squiggles, multi-line, with text. User-defined Styles are stored in the database rather than in 
macro files. 

An Upgrade command is provided; this sets the values of the new style and colour attributes based 
upon the value of the replaced pen attribute. It also attempts to create database LINESTYLE and 
FILLSTYLE elements to replace existing user-defined pens.  

These changes should make the control of pens in DRAFT far easier. No longer will users have to set 
up large numbers of pens to offer a reasonable range of line pattern, thickness, and colour 
combinations. By removing colour from the 'bundle' of attributes it will be easier to specify graphical 
representation styles more directly, thus 'Dashed' or 'ChainedThick' rather than by a number that 
combines style, thickness, & colour. 

16.3.1 Line, Fill & Marker Styles  
All DRAFT pen attributes (a total of  20, & usually of the form **PN) have been replaced, 
generally by both style & colour attributes. Thus LLPN has been replaced by LLSTYLE & 
LLCOLOUR. The 3 text pen attributes (TPEN, DTPN, PTPN) have been replaced by colour attributes 
only. The existing pen attributes remain and their values can be queried (but they will not be visible in 
a Q ATTS listing nor in the Attributes pane). The syntax to set them remains but now has no effect.  

User-defined pens were set up by macro at module-entry time; the new Line & Fill Styles are now 
defined in the database in a hierarchy headed by a STYLWL. SETPEN and associated commands 
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defining LinePatterns, LinePicture, & HatchPatterns, are now obsolete and have no effect. However 
their syntax is still available because the upgrade mechanism requires the SETPEN definitions in 
order to create database LineStyles & FillStyles to match the macro-defined pens. 

There are 17 style attributes: 15 line-style attributes for linear primitives; 1 fill-style attribute for area 
primitives; and 1 mark-style attribute for marker primitives. 

The 15 line-style attributes may be set to one of: 

• the system-defined line-patterns (10 from PDMS and 5 from Tribon M3), called 'SOLID', 
‘TCHAINED', ‘DASHDOT’ etc., with an optional linethickness qualifier;  

• a user-defined Linestyle - specified by Linestyle number (1-255) or name;  

• the special values of 'OFF', 'DEFAULT', UNCHANGED', 'TEMPLATE'.  
These are allowed exactly as they were for the equivalent pens in previous releases. 

The fill-style attribute may be set to one of: 

• 'SOLIDFILLED' or one of the system-defined hatch patterns (thus: 'SYSTEMPATTERN 5'). 
There are currently 18 of these, of which 1-10 are the same previous releases and the other 8 to 
various cross-hatching and parallel line patterns;  

• a user-defined Fillstyle - this may be specified by Fillstyle number (1-255) or name;  

• the special values of 'OFF', 'DEFAULT', UNCHANGED'.  
These are allowed exactly as they were for the equivalent pen attribute. 

The mark-style attribute may be set to either of: 

• one of the system marker types (thus 'STOP', 'CROSS', etc) followed by a scale (1-8);  

• the special values of 'OFF', 'DEFAULT'.  
These are allowed exactly as they were for the equivalent pen attribute.  

See also DRAFT database changes – section 3.7.1. 

A PML object handling the unbundled colours and styles has been added. Users’ PML forms may of 
course require adjustment to cover these changes. 

16.4 TrueType Text fonts  
True-Type Fonts are now available in place of the PDMS ones; before use, they must be set up in 
Admin as a font family. Once defined, they may not be mixed on the same SHEET with PDMS fonts. 
Picture elements now have a flag identifying them as PDMS or TrueType font.  

The user can set up the TTFONT elements in the database.  

Draft supports the emboldening, italicising and underlining of TrueType fonts. The user can use the 
new %b /%b (emboldening ON / OFF) and %i /%i (italics ON / OFF) codes in the intelligent text 
string, when a TrueType font is in use. 
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16.5 Printing and output formats  

16.5.1 Direct printing and graphics file formats 
There is a new option in both DRAFT for direct printing to a Windows printer and for producing PDF 
file, Windows Enhanced Metafile (EMF) and other various image file types (TIF, TIF G4, TIF LZW, 
JPG, PNG, GIF, BMP). The PLOT command syntax has been expanded with new options (PRINT, 
PDF, IMAGE, METAFILE) and parameters to handle these. For details, please see the DRAFT User 
Guide. 

In order to configure these new options, the DRAFT administrator has additional options to configure 
a revised plotter defaults file (\PDMSUI\dflts\plotter_user_defaults and 
\PDMSUI\clib\plot\plot_dflts). There is also a new form to configure the plot viewing options, if 
required. 

The plot viewing form has been updated:  

  
Click Plotters for Plot Configuration: 

 
 Click Configure viewers for this form: 
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16.5.2 Configurable CAD output formats    *12.0.SP4* 

16.5.2.1 MicroStation format output  
This has been updated to provide an option for MicroStation v8 DGN output – please refer to the 
DRAFT User Guide section 7.4. 

16.5.2.2 AutoCAD format output      *12.0.SP5* 

This new option provides, in addition to DXF output, a direct output of a DWG file suitable for 
AutoCAD (releases 2000 through 2009) – please refer to the DRAFT User Guide section 7.5. 
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Please note that a warning may be given on import to AutoCAD – this is expected and does not cause 
any known problems! 

 

16.6 Symbolic representation of model objects  
Design items may now be represented symbolically in a 2D View as part of the drawing of the 3D 
model. This could particularly useful for some of the drawings produced for architectural, electrical, 
and instrumentation disciplines. 

The Design Symbol may either replace or add to the normal geometric representation of the item. 
Design symbols can consist of geometrical elements or text, including Intelligent Text hash-codes, or 
can be a combination of the two.  

The Representation Rule (RRUL) functionality has been enhanced to allow these 2D symbolic 
representations to be specified. 

Templates for design symbols are stored in the DRAFT database using the Symbol and Text Template 
elements (i.e. SYTM and TXTM). However the data defining which templates to use for a given 
design item, and under which circumstances, is stored in the Catalogue database. This allows several 
templates to be associated with a given design item so that it can be represented differently in 
different types of Views. Thus the representation of a Lighting Fitting, for example, could depend 
upon both the View direction (i.e. Plan or Elevation) and upon the View classification (e.g. Layout, 
Cabling, etc). 

A simple example is shown below: 
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Design symbols are specified as ‘scaled’ or ‘non-scaled’ symbols. The size of scaled symbols depends 
upon the View scale, whereas non-scaled symbols are a fixed size irrespective of paper size and View 
scale. Since a change in View scale (which is relatively unusual) will always be followed by an 
UPDATE DESIGN command, no separate update is provided. 

Design symbols are created as Design Symbol (DESSYM) database elements. The DESSYM is a new 
element type, based on (a soft-type of) the SLAB. These are added as members of a Design Symbol 
Layer (DSLAYE) element. The DSLAYE is a new element type, which is a soft-type of LAYE and 
will thus be a member of a View. One (only) DSLAYE element will be created per View during the 
UPDATE DESIGN process; this will be removed if it ceases to own any DESSYMs. Thus these 
symbols will be created as part of the annotation of the View (rather than design graphics).  

Although design symbols will be created, deleted and modified as part of the annotation of the View, 
users will have less control over these elements than other forms of annotation. DSLAYEs and 
DESSYMs will be created and deleted automatically and the user will have no control over these 
operations. There is also less access to the attribute values of a DESSYM. 

DESSYMs will not be created for any design item whose origin falls outside the View rectangle or 
whose Origin (or datum point) is excluded by the action of section planes. Where only a symbolic 
representation is required (i.e. when a normal geometric representation is not required in addition to a 
design symbol), no attempt will be made to determine whether the design item would have been 
hidden by the action of the hidden-line removal process. (There is no way of determining this without 
actually doing a preliminary UPDATE DESIGN with the items fully drawn.)  

16.7 DRAFT Drawing file storage 
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Previous versions of PDMS have used a single Folder to store all the DRAFT picture files in a project, 
as specified by an environment variable, for example %XYZPIC% for project XYZ. A similar system 
is used for Final Designer files, for example %XYZDWG%. 

To improve performance for projects with a large number of drawings, PDMS 12.0 splits the picture 
file folder into 32 sub-folders and allocates files on a pseudo-random basis using the SHEET database 
reference. The algorithm used is to take the modulus of the second part of the reference number and 
32. For example, a sheet with the reference =15773/4101 will store its picture file in sub-folder 05 (= 
4101 mod 32). 

This should be transparent to the end user, but pseudo-variables are provided to assist the 
administrator in case he needs to locate the files. These are: 

PICF/ilename – full path to the DRAFT picture file 

16.8 AutoDRAFT     *12.0.sp2* 
AutoDRAFT has been updated to work with AutoCAD versions 2006 and 2007. It now supports the 
full new range of PDMS colours 1 – 272, rather than the first 12 colours only. This includes the full 
range of AutoCAD colours, 

There are currently some restrictions relating to the new or changed functions in both PDMS & 
AutoCAD, which are being investigated further: 
• AutoDRAFT does not yet support the output of Unicode text.  
• The Backing/Overlay sheet editor and the Symbol Editor will import TrueType fonts that are 

registered in the PDMS project. These fonts must be defined in AutoCAD in a custom text style 
named 'TTFNn' where 'n' stands for the number assigned to the given font in the PDMS project 
(e.g. TTFN5 or TTFN19).  

• Only TEXT entities (single-line texts) can be imported into PDMS. MTEXT entities (multiple-
line texts) are not handled.  

• POLYLINE entities are not imported into PDMS 

16.9 General Automatic Drawing Production (ADP) 
General ADP is set up by default to use PDMS fonts, as in previous releases. In version 12.0.sp2 it is 
also possible to use TrueType fonts.  In order to create drawings with True-Type Fonts, it is necessary 
to modify the setup by changing certain default files to match, as indicated below. 

Note that TrueType fonts and PDMS default fonts cannot be mixed in a drawing.  Users must ensure 
that the Department and Registry are set up with the right type of font before creating a drawing. 

16.9.1 %PDMSUI%\DFLTS\DRA-GEN-SYSTEM 
This file contains references to the standard Draft libraries; 

16.9.1.1 # Master Library References 
SYMB     /DRA/MAS/SYMBOLS/GEN             # Symbol library area (LIBY) 

SLAB     /DRA/MAS/LABELS/GEN              # Symbolic label library area (LIBY) 

PESYMB   /DRA/MAS/LABELS/GEN/PIPE/END     # Pipe End Symbol Template (SYTM) 

BSRF     /DRA/MAS/BACKS/MET               # backing sheet library (SHLB) 

TAGTMPLT /DRA/MAS/LABELS/TAG              # Auto tagging template library area (LIBY) 
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PIPLAB   /DRA/MAS/LABELS/GEN/USERDEF      # ADP pipe label prefix 

16.9.1.2 # Project Library References 
DLLB     /DRA/PRJ/DRAWLISTS         # Drawlist library (LIBY) 

OSRF     /DRA/PRJ/OVERS/MET         # Overlay sheet library (SHLB) 

RRSF     /DRA/PRJ/REPR/GEN          # Representation rules (RPLB) 

LRUL     /DRA/PRJ/STYL/LOCAL        # Local styles (RPLB) 

TAGRULE  /DRA/PRJ/AUTOTAG           # Auto tagging rule library area (LIBY) 

CLRF     /DRA/PRJ/CIRCULATION/GEN   # Circulation list library (CLLB) 

TMPLT    /DRA/PRJ/TMP               # DRWG Template registry prefix 

TMPLTDEF /DRA/PRJ/TMP/PIPING/A0     # Default DRWG or SHEE Template name 

HRSF     /DRA/PRJ/HRUL/GEN          # Hatching Rep rules (RPLB) 

HRUL     /DRA/PRJ/HSTYL/LOCAL       # Local hatching styles (RPLB) 

CRSF     /DRA/PRJ/CHANGE/RULESET    # Change Rep rules (RPLB) 

Each of these entries must be modified to reference the equivalent True-Type library, even for  
manual creation of True-Type drawings. Users who are using AVEVA default files should set the as 
follows, as supplied at 12.0 onwards; 

16.9.1.3 # Master Library References 
SYMB     /TT/DRA/MAS/SYMBOLS/GEN          # Symbol library area (LIBY) 

SLAB     /TT/DRA/MAS/LABELS/GEN           # Symbolic label library area (LIBY) 

PESYMB   /TT/DRA/MAS/LABELS/GEN/PIPE/END  # Pipe End Symbol Template (SYTM) 

BSRF     /TT/DRA/MAS/BACKS/MET            # backing sheet library (SHLB) 

TAGTMPLT /TT/DRA/MAS/LABELS/TAG           # Auto tagging template library area (LIBY) 

PIPLAB   /TT/DRA/MAS/LABELS/GEN/USERDEF   # ADP pipe label prefix 

16.9.1.4 # Project Library References 
DLLB     /TT/DRA/PRJ/DRAWLISTS            # Drawlist library (LIBY) 

OSRF     /TT/DRA/PRJ/OVERS/MET            # Overlay sheet library (SHLB) 

RRSF     /TT/DRA/PRJ/REPR/GEN             # Representation rules (RPLB) 

LRUL     /TT/DRA/PRJ/STYL/LOCAL           # Local styles (RPLB) 

TAGRULE  /TT/DRA/PRJ/AUTOTAG              # Auto tagging rule library area (LIBY) 

CLRF     /TT/DRA/PRJ/CIRCULATION/GEN      # Circulation list library (CLLB) 

TMPLT    /TT/DRA/PRJ/TMP                  # DRWG Template registry prefix 

TMPLTDEF /TT/DRA/PRJ/TMP/PIPING/A0       # Default DRWG or SHEE Template name 

HRSF     /TT/DRA/PRJ/HRUL/GEN             # Hatching Rep rules (RPLB) 

HRUL     /TT/DRA/PRJ/HSTYL/LOCAL          # Local hatching styles (RPLB) 

CRSF     /TT/DRA/PRJ/CHANGE/RULESET       # Change Rep rules (RPLB) 

Customers who use their own libraries will have to create True-Type equivalents or convert them. 

16.9.2 Default files prefixed ‘dra-genadp-’ 
These must be modified to set any library references to True-Type equivalents; 
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16.9.2.1 dra-genadp-equilocn 
var !!CDSCHEDLIBY |/TT/DRA/PRJ/ADP/SCHED/PGA| 

var !!CDTAGGLIBY  |/TT/DRA/PRJ/ADP/TAGGS/PGA| 

16.9.2.2 dra-genadp-piping 
var !!CDSCHEDLIBY |/TT/DRA/PRJ/ADP/SCHED/PGA| 

var !!CDSCHEDDEF  |/TT/DRA/PRJ/ADP/SCHED/PGA/Nozzle_1| 

var !!CDTAGGLIBY  |/TT/DRA/PRJ/ADP/TAGGS/PGA| 

var !!CDTAGGDEF[1]|/TT/DRA/PRJ/ADP/TAGGS/PGA/Instruments| 

16.9.2.3 dra-genadp-plotplan 

16.9.2.4 dra-genadp-skew_gdp1 

16.9.2.5 dra-genadp-sort_gdp1 
By default the library references for these files are unset 

16.9.2.6 dra-genadp-supports 
var !!CDSCHEDLIBY |/TT/DRA/PRJ/ADP/SCHED/PGA| 

var !!CDSCHEDDEF  |/TT/DRA/PRJ/ADP/SCHED/PGA/Pipe_Support| 

var !!CDTAGGLIBY  |/TT/DRA/PRJ/ADP/TAGGS/PGA| 

var !!CDTAGGDEF[1]|/TT/DRA/PRJ/ADP/TAGGS/PGA/Instruments| 

16.10 Projection Line Direction – Syntax change *12.0.sp5* 
The PLDI attribute can be set by specifying a point on the SHEET through which the LDIM's first 
projection line will pass. The syntax for this option has had to be altered slightly. It is now: 

PLDI THR/ough <sheet_pos> 

or, by cursor: 
PLDI THR/ough @ 

The change is the introduction of the word 'THROUGH'.  
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17 Piping Isometrics 

17.1 Flow Arrows 
Isodraft places flow arrows on the isometric with their direction governed by the BRANCH attribute 
FLOWDirection. The function is controlled using the FLOWARROWS command (please see 
ISODRAFT Reference Guide). The arrows can be placed automatically or positioned using 
ATTAchments with their ATTYpe attribute set to FLOW. 

The settings for FLOWD are either BACK for flow from tail to head or FORW for flow from head to 
tail.  

Two new settings are now handled by Isodraft: OFF to allow the arrows to be turned off or BOTH to 
indicate a two-way flow. Any other setting will continue to be treated as forward. 

Examples of 2-way flow arrows are shown below: 

  

17.2 Weights on Isometrics 
This allows the user to add a weight column to the isometric material list and provide a summary total 
for the fabrication and erection material plus an overall total for isometric material weight. 

17.2.1.1 User Interface 
The user interface provides the following new options: 

WEIGHT on the Material List Column Definition 

The ‘Material List Column Definitions’ form displays the option ‘WEIGHT’ in the list of available 
Component attributes. 

Total Weight Option 

If this option is selected, three checkboxes are displayed:  

TOTAL FABRICATION  □ 

TOTAL ERECTION  □ 

TOTAL COMBINED  □ 

Weight Conversion Factor 
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In addition, a Conversion Factor (pre-populated with a value of 1.0) may be specified. 

Command Syntax 
This mechanism generates the following syntax in the ‘Options file’: 
Column c OTHER Heading 'WEIGHT' WEIGHT with Width www [TOTAL 
FABRICATION] [TOTAL ERECTION] [TOTAL COMBINED] Factor f 

OUTPUT 
• For the total weights, a new text element is optionally placed below each material column. 

• All of the above texts have been given a text number and added to the alternative text list so that 
they may be modified to a different language. 

• A ‘---‘string shows that no weight can be found for the component. 

• The weight column and extra weight text is output to the MATLISTFILENAME file if selected. 

 

 

Example Material List 
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17.3 Isodraft SKEY Enhancements 

17.3.1 New UNBW SKEY 
A new SKEY UNBW (Butt Weld union) is now available. It has the same GTYPE, Plotted Symbol 
and P-points as the existing Socket Weld and Screwed Fitting Unions (UNSC and UNSW).  

17.3.2 New FY** SKEY 
A new SKEY FY** (‘Y’-type Filter/ Strainer with ** = BW, CP, SW, FL, SC, PL) is now available.    

Plotted 
Symbol 

P-points

This is in addition to the existing filter/strainer SKEYs FI**, FA**, FO** and FR** with ** = BW, 
CP, SW, FL, SC, PL. 

17.3.3 TEE / OLET SKEY Enhancement 
Certain existing TEE/OLET SKEYS have been enhanced to allow the user to indicate the presence of 
an offset P3.The P3 connection of the TEE/OLET must be connected directly to a pipe/tube. 

Affected SKEYs are HC**, TS**, Y1**, Y2**, Y3**  
(with ** = BW, CP, SW, FL, SC, PL) and TPUL, TEBW, TESO, TERF, TESW.The default 
behaviour is that, if an offset P3 configuration is present, a new ATEXT characterising the offset is 
output on the drawing. This new ATEXT is number 233 in the list of ATEXTs and its default value is 
‘BRANCH OFFSET BY’ followed by the nonzero relative coordinates of the offset. 
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17.4 Improved Continuation Sheet Options 

17.4.1 New Annotation Options 

 
17.4.1.1 Show Coordinates across Sheets. 
An extra clause ‘SHEET’ has been introduced to the ‘COORDINATES’ command to specify that 
spatial coordinates are to be shown at sheet breaks on the same isometric: - 

Coords ON AT Sheet 

This may be accomplished automatically by a new checkbox ‘Sheets’ option on the Annotation 
Options form (highlighted above as 1). Checking this box will display the appropriate coordinates. 

17.4.1.2 Switch on Continuation Sheet Information at Sheet Breaks 
A new CONTSHEETS command is introduced which takes effect when one isometric drawing is 
located on several sheets. It allows the User to specify that the sheet number of the continuation sheet 
be shown at the sheet break when the connection goes from one sheet of a drawing to another. This 
option may now be set using the new checkbox option on the Annotation Options form (highlighted 
above as 2). Clicking this checkbox will toggle between:  

CONTSHEETS ON 

Continuation sheet numbers between sheets are switched on. 
CONTSHEETS OFF 
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Continuation sheet numbers between sheets are suppressed. 

This is not to be confused with the CONTNOTES command which specifies continuation notes at the 
end points on drawings when the connection goes to another isometric. 

17.4.1.3 Specify Additional Pipeline Attributes to be Shown at Sheet Breaks 
An extra clause, ContUdefText (continuation user-defined text), has been introduced to the 
‘CONTSHEETS’ command to specify that further pipeline attribute or user-defined attribute (UDA) 
information may be shown as part of the continuation sheet information displayed at sheet breaks. The 
format of the constructed text string is controlled by the User and may contain arbitrary text and 
carriage returns: 

CONTSHEETS ON ContUdefText 
'LATTR1''arbtext1''LATTR2''arbtext2''' 

where LATTR1 and LATTR2 are valid Pipeline attributes and arbtext1 and arbtext2 are two arbitrary 
text strings. The sheet number of the continuation sheet is automatically appended to the user-
specified string. Therefore, the example specified above would output the string 
XXXXarbtext1YYYYarbtext2n for continuation sheet n where XXXX is the value of LATTR1 and 
YYYY is the value of LATTR2. 

This may be accomplished automatically by a new text box on the Annotation Options window 
(highlighted above as 3). In the text box the User is able to add something like:- 

LATRR1’/’LATTR2’-‘ 

where LATRR1 and LATTR2 are valid Pipeline attributes 

This will generate XXXX/YYYY-n for sheet n where XXXX is the value of LATTR1 and YYYY is 
the value of LATTR2.  

A more concrete example of the use of the CONTNOTES, ContUdefText option (combined with the 
COORDINATES option) is as follows. The specified options: 

Coords ON AT Sheet 

ContSheets  ON ContUdefText '''Name=''NAME'' 
Type=''TYPE''&/Lock=''LOCK'' Owner=''OWNER'' PSPE=''PSPE'' 
pg''' 

will display at the sheet break of an isometric: 

E 12250 

N 13500 

EL +2735 

Name =100-C-10 Type=PIPE 

Lock= Owner=PIPES PSPE=A3B pg3 

The COORDINATES option specifies the output of the first three lines. Note that the user-defined 
text occupies the last two lines because a carriage return ‘&/’ is specified. The value of the ‘Lock’ 
attribute is not output because, in this case, it is invalid. The continuation sheet page 3 specified 
indicates that this text would be expected to be located on sheet 2 of an isometric at the sheet break 
continuing onto sheet 3.  



 
 

  
 

136 

Note that a valid non-null string specified by the ContUdefText option will always be output at sheet 
breaks, irrespective of whether the CONTSHEETS option, specifying whether the continuation sheet 
number is displayed or not, is set to ON or OFF.   

17.5 Placing of Dimension Labels 
 

 
 

A new DIMLABELS command is introduced, which allows the User to control the appearance of 
dimensions labels displayed on isometrics. This option may be set to either of the two options 

DIMLABELS IN 

Dimension labels are shown within the dimension line (the default). 
DIMLABELS ABOVE 

Dimension labels are shown above the dimension line. 

This option may also be set by toggling between the two Dimension Labels options (IN/ABOVE) on 
the Dimensioning Options form (highlighted above). The effect of this option on the appearance of 
dimension labels is indicated below 

 

IN 

 
178 

ABOVE 
 

178 
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18 Schematic 3D Integrator 

18.1 Introduction 
This is a new product at PDMS 12.0 and was originally called P&ID 3D Integrator. The Integrator 
provides schematic and 3D model data in an integrated environment, enabling quick and easy 
browsing and reporting on that data. Schematic data will usually have been imported using the P&ID 
Manager product. 

Integrator can also perform the following key functions: 

• Compare 3D model objects against their corresponding schematic objects, highlighting any 
inconsistencies in connectivity or attributes according to easily configured rules. 

• Build 3D model objects using data from their corresponding schematic objects, connect 
objects such as equipment and pipes, and set key attributes such as tags and process data 
using easily configured rules. 

• Link 3D model objects with their corresponding schematic objects, enabling verification of 
consistency of the 3D design against the schematic. 

Full details can be found in the AVEVA Schematic 3D Integrator User Guide. Note that SCHEMATIC 
MODEL Manager is not covered in this document; please refer to the AVEVA Schematic Model 
Manager User Guide. 

18.2 Updates for *12.0.sp3* 

18.2.1 Spec Queries Configuration 
Prior to 12.0.SP3, Integrator searched all specs on start up to validate any selectors used within rules 
in its configuration file. This no longer takes place, enabling faster start up of the Integrator add-in. 
Instead, a new configuration section has been added for Spec Queries, to allow administrators to insert 
an individual selector or to find all selectors available. 

The example here shows a single query for STYP as provided in the out-of-the-box configuration file. 
Any selector used in the file must be included in the Spec Queries section, so that it can be recognised 
as allowable syntax by Intellisense. If Integrator reports syntax errors in the configuration file, it may 
be that there are rules defined using selectors that have not been entered in the Spec Queries section. 
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18.2.2 Upgrading Existing Projects 
Integrator requires the file ProjectConfiguration.xml to be available in the folder 
<project>dflts\ModelManagement. If this folder does not exist, as might be the case for an upgraded 
project, administrators will need to create it and ensure the appropriate environment variable, e.g. 
xxxdflts, is set. The Integrator configuration file should then be copied from the installed executable 
folder. 

If syntax errors are reported on start up or following Integrator > Show from the main menu, the 
ProjectConfiguration.xml file is an old version and must be modified or replaced. 

For more information, please see the example in the supplied samdflts project folder. 

18.2.3 Robustness and Usability 
A number of fixes have been implemented to improve product robustness and usability. 

Error trapping code in the customisable IntegratorProjectHandler.pmlobj has been improved to trap 
commands with syntax errors containing quotes. 

Objects in the Integrator 3D view coloured by the compare function now revert correctly to those 
colours when no longer highlighted by selection in the main table. 

When the Integrator 3D view has not yet been displayed, a build of cable only will no longer show 
this view. This is because the cable has not yet been routed, and so has no representation and there is 
nothing to see. 

An effect of mouse-over on a diagram symbol with an arrowhead giving a disproportionate 
magnification has been fixed. 

An incident of Integrator reporting unset dbref when determining tube spec during build of a pipeline 
has been fixed. 

An incident of Integrator reporting internal error 1115 when building equipment or cables with core 
connections has been fixed. 

An incident of Integrator hanging when building equipment and encountering the error No valid 
HREF on SCSEG has been fixed. 

An incident of Integrator reporting internal error Key already exists when comparing pipelines has 
been fixed. 

An incident of Integrator reporting incompatible types assigning an attribute value to a nozzle when 
building equipment has been fixed. 

18.3 Updates for *12.0.sp4* 
P&ID 3D Integrator has been renamed Schematic 3D Integrator. This reflects its capability to handle 
a range of schematic diagrams for piping, HVAC and cables. 

18.3.1 Duplicate Naming 
Integrator supports duplicate names for objects in the schematic and design databases. For example, 
an SCEQUI and an EQUI can have the same name, allowing a duplicate equipment tag on the 
diagram and in the 3D model. 
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Integrator takes advantage of this with the supplied default configuration using duplicate names for 
equipment, sub-equipment, nozzles, electrical connections, offline instruments, inline instruments, 
valves and cables. 

The special treatment of the DISTAG attribute, to override any rule defined for name, has been 
removed. If this functionality is still required, a rule group should be defined with the condition 
DISTAG ne ‘’, containing a rule to set NAME from DISTAG of source. 

18.3.1.1 Compatibility Constraints 
Once duplicate names have been used, the project data and configuration rules should not be used 
with versions earlier than 12.0.SP4. 

Duplicate names should be used with care. There are no constraints for equivalent type checking 
between the schematic and 3D databases. For example, it is possible to have the same name for an 
SCEQUI and a VALV. 

18.3.2 Key Attributes 
From version 12.0.SP4, Integrator can use a combination of several attribute values to identify 
matching 3D objects for a source schematic object. 

For example, several pipes may be matched to a single schematic pipeline according to their values 
for line number, bore, pipe specification and duty. Any attributes may be identified as key attributes 
for a particular type in the configuration rules. Objects that have all their values for their key attributes 
matching the values generated by the rules will be shown as matching in the compare report. 

In the Configuration Explorer, define rules for key attributes by setting their compare action to 
matchaskeyattribute. 

18.3.3 Comparing Piping Networks 
Integrator 12.0.SP4 includes a large number of fixes to improve its capability to compare networks of 
piping. This applies in particular to the situation where: 

• The 3D piping model has been created separately from the schematic model 

• A schematic pipeline has been modelled in 3D by multiple pipes 

• Branches are divided up differently in the 3D and schematic models but the networks are 
consistent 

• Some branches have been modelled in reverse flow order 

18.3.4 Diagram Viewer Toolbar 

This has been improved to enable easier investigation of differences reported by Integrator. The 
toolbar has been moved from the main toolbar area to the Diagram Viewer. 

 
 The information button provides tooltip help describing pan and zoom key combinations. 
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 The options to reset diagram colours have been added to the Integrator main bar menu. 

18.3.5 Compare Report Options 
The Integrator Compare Report View menu has new options, to enable easier investigation of 
differences reported by Integrator 

In addition to the modal settings to zoom to and highlight in the diagram and 3D views, there are new 
modal settings to navigate to the schematic or 3D object as it is selected in the compare report (which 
navigation is performed depends on which tree, schematic or 3D, is visible in the tree panel). 

There is also a new option to show equipment translucent in the Integrator 3D view. This can make it 
easier to see nozzles and piping components, particularly if they have been created inside the 
equipment and would otherwise be invisible. 

 

18.3.6 Compare Status Attribute 
Integrator has a new Compare Status pseudo attribute CMPSTS that returns a description of the 
compare status of any linked schematic or 3D object, or of its linked ancestor. This is included in the 
Main Table by default. 

 

18.3.7 Loading Large Data Volumes 
At 12.0.SP4, Integrator’s performance when loading large numbers of objects into the main table has 
been dramatically improved. Integrator will now load a table of 30,000 schematic equipment rows 
with 14 attribute columns in around 25 seconds. 
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Whenever a main table is reloaded, if it will have more than 1000 rows, Integrator will ask the user to 
confirm that he wants to continue. If they do not, they will get an empty table. 

 
 If they choose to continue, a bar will indicate the progress of the operation: 

 

18.3.8 Edit Modes in Tables 
You can edit attribute data in the Main and Subtype Tables by selecting an appropriate Interaction 
Mode. In Single Cell Edit mode, clicking on a cell places that cell in edit mode. In Bulk Cell Edit 
mode, double clicking on a cell places that cell in edit mode. A single click on a cell selects the cell 
itself, and standard Windows selection methods (left mouse click plus Ctrl and Shift keys) select 
multiple groups of cells. A left mouse drag operation can also be used to select multiple cells. In Bulk 
Cell Edit mode, Fill Down, Fill Up and Copy/Paste operations apply to all cells currently selected. 

 
Read only cells are shown with grey background (or the selected colour if Feedback Colours have 
been changed). Cells may be read only for a variety of reasons, including data from a read only 
database, an object claimed by another user, or non-editable attributes such as Owner or Type. In Bulk 
Cell Edit mode, Name is read only. Following an edit, the results (success or failure) are displayed 
using cell colours and tooltips. These can be cleared by selecting Reset Cell Feedback. 

18.3.9 Upgrading Existing Projects 
This version of Integrator has a new ProjectConfiguration.xml file in the installed executable folder. 
The main change is to use duplicate names for tagged items in the schematic and design databases. 
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Existing projects may copy the new ProjectConfiguration.xml file to the 
<project>dflts\ModelManagement folder and then modify it according to their own requirements. 
Alternatively, the existing file may be modified if required. Administrators should ensure the 
appropriate environment variable, e.g. xxxdflts, is set. 

If syntax errors are reported following Integrator > Show from the main menu, the 
ProjectConfiguration.xml file is an old version and must be modified or replaced. The probable reason 
is that there are rules defined using selectors that have not been entered in the Spec Queries section. 
Here is an example with STYP added. 

 
If existing projects have their own copy of the HVACStypeTable.xml file in the 
<project>dflts\ModelManagement folder, this should be deleted. Integrator will then look for this file 
in the installed executable folder. This file should only be copied to the 
<project>dflts\ModelManagement folder if it is to be modified to suit project requirements. 

18.4 Updates for *12.0.sp5* 
There are many enhancements at SP5, which are fully detailed in the updated Integrator User Guide. 

18.4.1 Bar Menu 

The Integrator main bar menu has some new entries and some changes in terminology and order. The 
main addition is for Comparison Categories, described below. 

18.4.2 Comparison Categories 

The new Comparison Category settings allow you to specify which categories of differences will be 
reported against which types of objects. By ignoring certain categories, they will not be reported, and 
you can focus attention on priority differences. 

Select Bar Menu > Settings > Comparison Category to display this form. 
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The Comparison Category settings allow you to switch off certain categories of differences for certain 
types of objects. You cannot switch off the reporting of non-matched main type objects such as 
pipelines and equipment. The Key Attributes column applies when matching by key attributes 
according to the configuration rules, and the Key Attributes text panel lists attributes included in 
such rules. The Spec Attributes column applies to all specification attributes including PSPE, SPRE 
and CATR. 

Note: This will not set the Comparison Category to be used - that is done from the Main Bar Menu > 
Comparison Categories sub-menu selection. 

 

 

Selecting Default means all differences will be reported. For example in the report shown below there 
are a number of differences reported on NAME and SPRE of components. 
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If a Comparison Category is defined to ignore differences of Names, Spec Attributes and Other 
Attributes, the report then appears as below. Note that the Comparison Category used is included in 
the report title (it also appears in the title of the Main Table). The differences concerned no longer 
appear as comments or as red icons, and will not participate in the aggregation of differences reported 
up the hierarchy (the worst case report). The actual data will still be visible in the report content. 

 
 

The Comparison Report also has a menu option to display (in a read only form) the current settings 
for the comparison category used in the report (note these may have changed since the report was 
made). 
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For use in macros, a new command line method has been provided to select a comparison category. 
To use it, call the new method then call the existing compare method. 

!!integrator.setreportvisible(false) 
!!integrator.setreportpath(!reportFilename) 
!!integrator.setComparisonCategory(‘NoNameOrOtherAttributes’) 
!!integrator.compare(!items) 
 

18.4.3 Auto Linking Matched Objects 

Integrator can automatically link all matched objects from a comparison report. Click on Edit > Link 
all matched elements. 
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Integrator will work through the report content prompting to link matched objects. 

 

You can choose to link or skip individual objects, or click Yes to All to automatically link all 
matches. On completion, the report will indicate newly linked objects in cyan and any failed or 
skipped links in red. 

 

A log of the linking actions is output to the command line. 

 

For use in macros, a new command line method has been provided to set a flag to auto-link matched 
objects. To use it, call the new method to set the flag then call the existing compare method. 

!!integrator.setreportvisible(false) 
!!integrator.setreportpath(!reportFilename) 
!!integrator.setCompareAutoLinkMatches(true) 
!!integrator.compare(!items) 
 

18.4.4 Auto Update of Attributes 

Integrator can automatically update attributes on matched or linked objects from a comparison report. 
Click on Edit > Copy All to 3D. 
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Integrator will work through the report content updating any attribute differences on linked or 
matched objects. On completion, the report will indicate newly updated objects in cyan and any failed 
or skipped updates in red. 

 

A log of the updating actions is output to the command line. 

 

For use in macros, a new command line method has been provided to set a flag to auto-update 
attributes. To use it, call the new method to set the flag then call the existing compare method. 

!!integrator.setreportvisible(false) 
!!integrator.setreportpath(!reportFilename) 
!!integrator.setCompareAutoUpdateAttributes(true) 
!!integrator.compare(!items) 
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18.4.5 View Diagram Dialogue 

The new View Diagram dialogue allows you to browse for diagrams using the tree panel or search for 
diagrams using the search controls. 

 

Click on the Search button with blank text in the Search For field to get a list of all diagrams 
available. 

Select Diagram or Pages to see one entry per diagram or one entry per page. 

Select By Diagram Name to perform a wildcard search using the name of the diagram. Select By 
Content to perform a search using the name of an object such as schematic equipment to find the 
diagrams it appears on. 

Select the required diagram or page. If the Preview option was checked, and either a page was 
selected or a single page diagram was selected, then the diagram will be displayed in the Preview 
panel. Use the pan and zoom functions to inspect the diagram.  
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18.4.6 Diagram Viewer Settings 

The Diagram Viewer has an additional button on the toolbar for its own Settings form. 

 

 

The settings for selection and mouseOver colours have moved here from the earlier Settings form. 
The middle sections allow you to control where the diagram tabs appear, the number of recent 
diagrams that will be remembered, and the number of tabs that can be displayed simultaneously. The 
Set CE from diagram option controls whether the current element will track the object you click on in 
the diagram viewer. 

18.4.7 Diagram Viewer Context Menu 

The Diagram Viewer context menu has a new option to view the selected object on other diagrams. 
This is active only if the object appears on more than one diagram. 
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18.4.8 Comparison Report Options 

The Comparison Report has some new features. The tree panel shows folders for Equipment, Piping, 
HVAC and Electrical. 

 

The new Edit menu has a Find CE in Report option which focuses the report on the current element 
(if it is contained within the report). 

 

The context menu has a Find in Report option as well Navigate to. The former focuses the report on 
the connected object and the latter sets it as the current element. 

 

The report has a drop site for linking, at the base of the report. An object can be dragged from the 
drawing viewer, design explorer, or from the report grid panel, and dropped in the drop site. If 
dragged from the report grid panel, the drag must start on either the Schematic Element cell or the 3D 
Element cell to determine which object is dragged. A subsequent drop onto the drop site will either 
replace the object selected for linking, or offer to link to it, depending on the relative types. 
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The context menu offers the option to link a pair of matched objects. 

 

The context menu offers the option to select an object for linking (which adds it to the drop site for 
linking) … 

 

… and then select another object and link to the saved selection. 
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18.4.9 Schematic Multi Cable 

Integrator can handle Schematic Multi-Cables (SCMCAB). Integrator builds the individual cables for 
a Schematic Multi-Cable. There is no 3D equivalent of SCMCAB. 

When a Schematic Multi-Cable (SCMCAB) is selected in the Diagram View, all its child Schematic 
Cables (SCCAB) will be selected in the Main Table. When an SCCAB that is a member of an 
SCMCAB is selected in the Main Table, its owning SCMCAB will be selected in the Diagram View. 
Its sibling SCCABs may be automatically selected in the Main Table via the right click option Select 
All Cables in Multi-Cable. 

18.4.10 Comparing SUBEs and NOZZles 

Integrator will report unmatched 3D SUBEs for information and not as errors, on the basis that there 
are likely to be more sub-equipment in 3D than on a diagram as there will be more detail. However, 
unmatched SCSUBEs will be reported as errors. 

Integrator will match nozzles at different levels in the hierarchy, for example a NOZZ in a TMPL 
below a SUBE may be matched to an SCNOZZ directly below an SCEQUI. This allows nozzles in 
3D to be grouped on SUBEs even though there is no parallel schematic hierarchy. 

18.4.11 Branch Linking 
Object types BRAN and SCBRAN no longer have the pseudo attributes schlnk and deslnk as they are 
not linked directly like other object types. This is because the relationship can be many-to-many in a 
complex piping network where the branches are divided up differently in 3D and schematic. 

BRAN and SCBRAN have the array pseudo attribute bralnk which uses the owning SCBRANs or 
BRANs of the member components to generate the possibilities. 

18.4.12 Highlight Colour 

Integrator now has its own highlight colour used when 
an object is selected in the Main Table or Comparison 
Report. Since the Graphics Settings highlight colour is 
typically set to red, which indicates an error for 
Integrator, a more suitable colour such as Ivory can be 
used for the Integrator highlight colour. It is set in the 
Compare Colours section of the Project Configuration 
Explorer. 
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18.4.13  Comparing Flanges, Couplings and Unions 

By default, flanges, couplings and unions are treated as insignificant for compare. This can be 
changed in the Project Configuration Explorer Defaults. 

 

If the diagrams show these items then they can be set true so that they will be treated as significant for 
compare. 
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19  Schematic Model Manager   *12.0.sp5* 

AVEVA Schematic Model Manager is a new product at PDMS 12.0.SP5, which replaces AVEVA 
P&ID Manager and is used to import P&ID data into PDMS Schematic databases. The P&ID data 
may have been exported from AVEVA P&ID, or from other supported P&ID systems, and is 
imported via an XML file, the content of which complies with ISO 15926.  

Please note that Schematic Model Manager 12.0.SP5 does not fully support the use of UDETs in the 
Schematics database. In particular, there is a limitation that it cannot create instances of UDETs on 
import. 

Schematic Model Manager, unlike its forerunner P&ID Manager, is accessed via the PDMS login 
dialogue or by the module change mechanism. This section notes other significant changes from 
P&ID Manager. For full details, please refer to the Schematic Model Manager user guide. 

19.1 Edit Elements 
A new grid based data entry and editing feature has been added to support the bulk entry and editing 
of schematic elements such as Equipment.  This is accessed via the schematic explorer right click 
menu, or from Edit> Edit Members.   

The grid includes features such as fill down, and is designed to support the manual creation and 
editing of schematic items. 

 

19.2 Line List Configuration 
To support the generation of line related project deliverables, pseudo attributes have been added to 
line related elements.  These pseudo attributes are: 

Element Pseudo Attribute Type Purpose 
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SCPLIN 

SCBRAN 

LLDIAGRAMS 

 

Text Calculated value. This is the combined DIAREF attributes of the 
SCSEGMENT elements within the SCBRANCH and any 
subsequent branches between the branch and LLTBRANCH, 
formatted as a text field to meet the user’s format requirements 

SCPLIN 

SCBRAN 

LLENTRY 

 

Bool Determines if the SCPLINE and SCBRANCH should be used in a 
line list deliverable.  Pipeline and Branch selection may be user 
defined using a rule or manually set. 

SCPLIN 

SCBRAN 

LLFROM 

 

Text Derives   the text which indicates the source of the  SCPLINE or 
SCBRANCH.  The method used to derive the contents is user 
defined 

SCBRAN LLTBRANCH 

 

 Derived value.  This is the SCBRANCH element where the main 
flow from the current branch terminates or leaves the current 
SCPLINE.  This enables the user to get at the attributes at the end of 
the line list entry such as the terminating BORE size (TBORE OF 
LLTBRANCH) 

 
SCPLIN 

SCBRAN 

LLTO 

 

 Derives the text which indicates the destination of the SCPLINE or 
SCBRANCH.  The method used to derive the contents is user 
defined. 

The derivation of the values held in these pseudo attributes can be user defined using the line List 
Configuration form, which is accessible from Tools> Line List Configuration. 

 

The pseudo attributes may be used as part of the output of a Search or Report, for inclusion in a line 
related search or report, with: 

• Configurable from and to values  
• Derived and calculated field containing a list of diagrams a line related element spans. 
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• Derivation and replacement of “from” and “to” values.  For example where a pipe ends at a 
component such as an end cap the “to” reference can be replaced with the component type 
name “End Cap”. 

19.3 XPath Prover 
Attribute mappings between source data and schematic database attributes are configured and 
maintained using attribute mappings.  These mappings use XPath, a language that describes how to 
locate specific elements (and attributes, processing instructions, etc.) in an XML document, and which 
may be used to calculate and derive values. 

Schematic Model Manager (and Lexicon) now supports the proving of XPath expressions directly 
from the attribute matching feature, to determine what the results of the XPath expressions will be 
without the need to import a diagram. 

The XPath Prover can be accessed from Tools> Attribute Mappings and then opening an attribute 
mapping condition or source attribute. 

 
 

A Source file may be selected and the attribute mapping trialled against this file to determine what the 
results of the mapping will be, without the need to import the file. 

19.4 Saved Searches 
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Two new Line deliverable related saved searches have been included with Schematic Model Manager, 
for use in conjunction with the Search tool.  These saved searches may be used for reporting purposes 
and can be directly exported to CSV or MS Excel format from the search results grid, for use as the 
basis for deliverables. 

In addition Schematic Model Manager users may create and save their own searches, for use 
generally, or as the basis for project reports and deliverables. 

These searches use the new line related pseudo attributes. 
• Line List – SCBRAN 
• Line List – SCPLIN 

These are in addition to the Schematic Model manager saved searches already provided: 
• Connected Off Page Connectors 
• Equipment List 
• Instrument Index 
• Manually Connected Page Connectors 
• Pipe Specials 
• Release to 3D Status – Off 
• Release to 3D Status – On 
• Unconnected Off Page Connectors 
• Valve Count 

19.5 Set Release Status 
This feature has been added to support the visualisation and management of schematic element release 
to 3D status and allow Better management of the release of schematic data for use in Design.  It is 
accessible from Tools> Set Release Status. 
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Child items of an element are grouped and their release status may be changed collectively at group 
level.  Information relating to elements Release Status is shown graphically, along with data relating 
to the last release related activity carried out on each element. 

19.6 Support for XMpLant 3.3 
Schematic Model Manager now supports version 3.3 of XMpLant in addition to version 3.2.  
Attribute mappings may be defined for each version and run in parallel,  to support environments 
where both formats are being generated by different source drafting tools, but imported into the same 
Plant (or Marine) project. 

19.7 Support for Colour SVG 
The Schematic Model Manager import routine, and the Diagram Viewer now support colour SVG 
representations of P&ID. 

By default colour SVG files are generated on import.  This feature may be disabled by selecting 
Tools> Project Options> Import Configuration and un-checking the Import diagrams in colour 
check box. 
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19.8 General Improvements 
Incorporation of core system functionality, such as check CE, enables users to carry out key schematic 
and element creation and management tasks from Schematic Model Manager, reducing the need to 
use other modules. 
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20 AVEVA Diagrams    *12.0.SP5* 

The following enhancements have been included in the 12.0.SP5 release. 

20.1 Visio 2007 support 
From SP5, Diagrams is supported only on Visio 2007; it will not be possible to run it with Visio 2003. 
Visio 2007 provides some new features, for example ‘Auto Connect’, ‘Link Data to Shapes’.  

20.2 Enhanced Instrumentation Support  
The Schematic data model has little support for designing advanced instrumentation diagrams. 
Typically, users need to define separate lines/systems (instrumentation loops) which are clearly 
differentiated from Pipelines and the main flows. However, in some cases, inline components such as 
valves, may need to participate in both the main flow as well as in an instrumentation loop. 

The Diagrams application allows users to create low and high level control systems. There are now 
several special elements in the database that can be easily used to create an instrumentation data 
model. Those elements can be grouped into schematic loops and can be easily found and modified. 

20.3 Title block 
New Title Block shape has been introduced for annotating a diagram or template. Its behaviour is 
similar to Multi-label, but it cannot be connected to any shape – instead it displays db attributes of the 
containing drawing. A shape for Title Block can be created using the Import Shape Wizard and then 
be dropped on a drawing as any other shape. 

20.4 Multi-cables 
A new SCMCAB schematic db element type has been introduced. It represents Multi-cable; is to be 
placed below SCGROUP and can own a number of SCCABLE elements. The quantity of cable 
members and values of their attributes are controlled by appropriate attributes of SCMCAB. On the 
drawing SCMCAB is represented by Multi-cable shape which can be created using Import Shape 
Wizard and then dropped on the drawing like any other shape. Multi-cable is usually represented by a 
single connector line. 

20.5 Support for Imperial Units 
AVEVA Diagrams now supports the use of Imperial units. 

Attribute values and input fields are presented according to the current units setting.  

It is now also possible to enter units with numbers in the input fields – if a unit value is specified the 
system will try to interpret that value and convert it to the current units setting. 
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20.6 Cable Connection to Nested Symbol 
This new feature makes it possible to establish a connection between Cable or Multi-cable and 
Equipment item using symbols being part of the Equipment shape’s group.  
• By connecting the Cable element to a connection point on a symbol being part of the Equipment, 

Sub-equipment or Electrical Connection group. 
• By dragging a symbol that is already connected to a Cable element into the Equipment, Sub-

equipment or Electrical connection group (the behaviour of the Containing Group should be set to 
Accept dropped shapes and nested symbol should be set to the Add shape to group option). 

Also automatic disconnect in db is supported when the Cable element is disconnected from the nested 
symbol or the symbol is moved out of the Equipment item group. 

20.7 Line List Configuration 
For more information refer to Status Control / Line List Configuration in this User Bulletin. 

20.8 The Default System can be Unset 
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A new Unset button has been added: 

 

20.9 Pipe Splitting  
Pipelines with sub-branches (branches having both HREF and TREF set to the split-of branch) may 
now be split in a better way. The sub-branch(es) are moved to the new pipeline in the split operation. 

20.10 ReSelect Method 
A new option, Spec Search, has been implemented. This option is available from the context menu 
and gives a possibility to re-select SPREF in the diagram in an easy way. The option can be useful 
when i.e. specification will change or the user removes a current SPREF by accident.  

 

20.11 Out-of-Spec Components 
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A new setting ‘Allow out-of-spec’ is available to control selection of inline elements. When Use 
Specification is set True, it is possible to determine the type of SPREF via the ‘Allow out-of-spec’ 
option. 

 
If ‘Allow out-of-spec’ is set to False the system accepts only SPCO elements, otherwise GPART and 
SCOM are also accepted.  

20.12 Default Placement for Auto Labels  
A possibility to set default placement for auto labels has been added. There are two separate options 
for connector and 2D shapes and the user is able to specify if the label should be placed behind the 
shape, in front of it or let Visio decide: 
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If label is set behind shape being annotated (SendToBack), the shape can be selected more easily. 

20.13 Default Layer for Annotation 
The Default layer for annotation shapes can now be set in Diagrams Defaults: 

 
After the annotation shape is dropped on the drawing, it will be automatically added to the layer set in 
Defaults. If a layer with the given name does not exist, it will be created. 

If it is necessary to have separate layers for different annotation types, it is possible to set the Default 
layer locally (for master of shape) using the Import Shape Wizard. 
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20.14 Import Shape Wizard for Electrical Connections 
A new option has been added to Import Shape Wizard which controls whether Electrical Connection 
shape should have ‘Add to group on drop’ property set to true: 

 
If the user checks this option it allows easier connection to Equipment item as Elconn is included 
automatically into the group if an Equipment group accepts dropped shapes. 

20.15 Import Shape Wizard for Equipments  
A new option has been added to Import Shape Wizard which control whether Equipment or Sub-
equipment shape should have ‘Accept dropped shapes’ property set to true: 
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If the user checks this option it allows easier connection to the Equipment item as other shapes are 
automatically included into its group (if they have ‘Add to group on drop’ set to true). This 
functionality also gives better support to ‘Cable connection to nested symbol feature’ as there is no 
need to manually change Equipment properties. 

20.16 Connecting Cables to Plain Symbols 
When a Cable element is connected to a 'plain symbol’ which is not a part of equipment/sub-
equipment group the 'Add to group on drop' property of that symbol could be automatically set to true. 
It provides better support for the 'cable connection to nested symbol' feature. The behaviour is 
controlled by default settings possible to set separately for Cables and Multi-cables: 
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20.17 Storing Options Files in Project Defaults Folder 
Diagrams options files (DiagramsDefaultSettings.xml and DiagramsAttributePresentation.xml) were 
previously read from the installation directory and it was not possible to have them project-specific. 

This has been changed and now, if there is a need to have project-specific settings, the files could be 
manually copied by the administrator to %XXXdflts%/Diagrams/ and the application will use 
settings from there and ignore files in the installation directory. The XXXdflts is an environment 
variable pointing to the defaults folder for project XXX.  

20.18 Improvements to ‘Quit Work warning’ 
The warning message displayed when closing diagram with unsaved changes has been improved: 

 
Also other messages containing the phrase ‘Quit Work’ have been changed: “Quit Work starting: …” 
and “Quit Work completed” are now replaced by the following: 

 

20.19 Autoname (Auto Rename) Offspring Only 
Two additional options were added (toolbar and menu): 

• Autoname Offspring Only. 
• Auto Rename Offspring Only. 
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20.20 Diagrams Saved to DB After Create / Open 
To better support integrity between data on drawing and db representation, changes have been made 
to ‘New drawing’ and ‘Import drawing’ functionality. Now, after a new drawing is created or 
imported, there is a prompt for name and db location in order to save the document to the database – 
the standard ‘Save as’ dialogue is used: 

 

• There is a possibility to import a drawing (or create new one) without saving it to the database 
(by clicking the Cancel button), but then the document is considered read-only and any db-
related changes to its content are not allowed. 

• The user is informed about such possibility in the title bar of the dialogue. 
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20.21 New and Edit Members Commands in Explorer 
The New and Edit Members commands were missing in the Explorer context menu. To solve the 
problem changes have been made to use the common Schematic Explorer context menu instead of the 
one defined in Diagrams.uic. Now the missing commands are available and the Schematic Explorer 
context menu is consistent in all modules. The functionality is displayed as seen below: 

              
In addition, the Edit Members option has been added to the Edit menu and the duplicated Edit 
Elements Utility has been removed from the View menu. 

   

20.1 Reference List Addin  
A new Reference List feature is now available, accessed through the View menu: 
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The Reference List window shows a list of elements referenced by the Current Element: 

 
 



 
 

  
 

171 

 

21 Status Control     *12.0.SP5* 

21.1 Description 
Status Control provides control of model object status that fits with project processes and systems. It 
affects most of the PDMS Modules (as well as their Marine equivalents): Design, Spooler, Paragon, 
Draft, Diagrams, Schematic Model Manager, and Lexicon. 

Status Control enables the user to control and report on the status of individual model objects as they 
progress through their lifecycles. It can be applied to any model objects, e.g. tagged items, catalogue 
components, drawings, etc. Consider for example the following workflow. 

 

The Status Control data model defines a workflow, such as the example above, as a Status Definition 
owning a set of Status Values.  
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21.2 Setting up object status  
Individual model objects reference the Status Values via Status Link objects, as illustrated below. 
Status data is stored on Status Link objects so you do not need write access to the model object in 
order to set its status. Status Link objects are distributed globally with the model objects to which they 
refer. They are not visible to the end user, but the status data is available as pseudo attributes. 

 

Status Definitions are configured in Lexicon. 
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Model objects are controlled in the constructor modules using the Status Controller. 
 

 
 
 
 
 
 
 
 
 

21.3 Using status values 
From the Status Controller you can display Status History, navigate to a selected object, or drag and 
drop it into the 3D graphical view. Autocolours can be configured to reflect status values. 
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You can also display a variety of charts for Statistical Reporting purposes. 

 

Status Control can be tightly coupled with Data Access Control. For example, it can be configured so 
that only certain users may approve an object, or to prevent changes to an object once it has achieved 
a particular status. 

It should be noted that records of the full Status history depend on the relevant sessions being 
preserved in the database. Users should therefore be aware that information can be lost if databases 
are reconfigured or have their sessions merged. 

21.4 Customisation 
Customisation is supported for PML and C# developers with a rich set of objects and methods. Status 
Events provides a means for projects to add functionality such as additional checks before changing 
status (and abort the change if necessary), additional actions after a change (such as cascading values 
to dependent objects), and to synchronise external systems on Savework and Flush of database 
changes. 

21.5 Summary 
For more information, please refer to the Status Control Guide. The documentation suggests an 
approach to upgrading status data created by AVEVA Model Manager.  
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22 AVEVA Mechanical Equipment Interfaces  

22.1 Introduction     *12.0.SP5* 
These new interfaces provide both an import and an export function for PDMS using the STEP 
Application Protocol (AP) 203 format. Full details are given in the new AVEVA Mechanical 
Equipment Interface manual. 

22.2 Import       *12.0.SP5* 
The new import interface enables the import of geometric models of Mechanical Equipment (to either 
an EQUI or VOLM element) in order for them to be included in PDMS for accurate clash detection, 
visualisation and drawing production. Imported models are stored in new GENPRI and GENCUR 
geometric primitives designed for this purpose; they enable the storage of B-spline solids and curves 
rather than the simple geometric shapes used by the PDMS CSG modeller.  

 

Although the system has been optimised for the incorporation of these new primitives, it is obvious 
that the use of very complex models may have a detrimental effect on performance. It is 
recommended that the models are simplified as much as possible before import so that only the 
appropriate geometry is transferred. It may be appropriate to use ‘skin’ operations in the originating 
system to remove unnecessary internal geometry.  

The new primitives may not be edited in PDMS, though their attributes may be set, nor subjected to 
any Boolean operations such as penetration by holes (negative volumes). The imported models may 
be drawn in Draft alongside ‘native’ geometry and behave in a similar manner for sectioning etc. It is 
of course more appropriate to draw the detailed drawings of these models in the originating system. 
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The interface currently transfers the geometry but does not maintain a detailed assembly tree or many 
of the other details such as names and colours in the STEP file. It is possible to import a folder 
hierarchy to provide some structure in the PDMS model. 

Models may be imported to a holding area for organisation, for example by engineering function, and 
for addition of geometry. This geometry might include connection points for Drafting dimensions and 
Design Associations; primitives representing reserved space for clash checking; and nozzles for 
piping connections. The imported primitives may themselves be modified to change name, drawing 
level and obstruction level attributes to conform to company standards. It is obviously beneficial to 
arrange for the appropriate (minimum) number of primitives to be used for clash detection and 
drawing representation at the various drawing levels. 

22.3 Export       *12.0.SP5* 
The new Export interface allows any part of the PDMS model to be exported in STEP AP203 format, 
perhaps for use by suppliers. It should be noted that much of the non-geometric information will be 
lost. It is therefore not recommended that users export and re-import, though this will work for the 
geometry only. Re-imported models will be stored in the new primitives and not as regular PDMS 
geometry. 
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23 Customisation 

23.1 PML.NET  
The AVEVA Design Platform now allows the free mixing of compiled .NET assemblies and PML 
scripts within the same application. PML can call .NET assemblies and .NET can call PML A 
specialisation of a .NET User Control can be included within a PML form to provide more advanced 
GUI features than is possible with PML alone. 

This allows use of a mix of technologies for developing new applications that benefit from PML for 
customisable and extensible user interfaces, and from .NET for a sophisticated user interface, with 
good performance and security. 

The platform uses ‘.NET reflection’ to create a PML class definition and invoke methods so that the 
.NET object behaves just like any other PML object. The .NET User Control exposes its object model 
and events to PML, so that a user can add PML scripts to extend or customise the form’s initiation 
and action. 

  
 

23.1.1 Note for developers of .NET assemblies  *12.0.SP5* 

This applies mainly to those who have written PML.NET applications for PDMS 12.0.SP3 or earlier 
releases. 
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In order to allow these applications to work through service pack and fix release updates, for PDMS 
12.0.SP4 and later, the service pack and patch versions have been removed from all published .NET 
interface assemblies and PMLNet.dll. For these assemblies, the assembly version will therefore 
remain at 12.0.0.0 for all versions of 12.0 (the file version will contain the full version number 
including the service pack and patch).  

To avoid rebuilding assemblies which reference 12.0.3.0 or earlier versions of PMLNet.dll this 
version may be redirected to 12.0.0.0 using the <bindingRedirect> element in the .exe's config file. 
For example, you could use a des.exe.config file such as this: 
 
<?xml version ="1.0"?> 
<configuration> 
  <startup> 
    <supportedRuntime version="v2.0.50727" /> 
  </startup> 
  <runtime> 
      <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1"> 
       <dependentAssembly> 
         <assemblyIdentity name="PMLNet" 
                           publicKeyToken="17c64733a9775004" 
                           culture="neutral" /> 
         <bindingRedirect oldVersion="12.0.3.0" 
                          newVersion="12.0.0.0"/> 
       </dependentAssembly> 
      </assemblyBinding> 
   </runtime> 

</configuration> 

23.2 XML Toolbars and Menus 
A new way of defining Toolbars and menus in XML simplifies their customisation; the commands 
may be defined in PML, C++ or C#. 

23.3 Enhanced pseudo attribute queries 
Queries for pseudo attributes may have a qualifier. This qualifier was limited to: 

• An integer and a reference for POS/ORI/DIR attributes 

• An integer for all other types 

The qualifier is now much more flexible, in order to allow for more sophisticated queries. 

23.4 PML enhancements 

23.4.1 PDMS expression enhancements  
Any number of qualifiers may be passed when querying an attribute. The facility is available 
only when using the ‘attribute’ method, which now takes an array of qualifiers in addition to 
the attribute name. 
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Examples: 
To query PPOS 1: 

!q=object array() 

!q[1] = 1 

q var !!ce.attribute('PPOS', !q) 

To query list of nominal bores: 
!q=object array() 

!q[1] = 'BORE' 

q var !!ce.attribute('NOMBMM', !q) 

To query Equipment members: 
!q=object array() 

!q[1] = object elementtype('EQUI') 

q var !!ce.attribute('MEMBER’, !q) 

The qualifiers may be any of the following types: 
• Real 
• Logical 
• String 
• DBREF 
• ElementType 
• Attribute 
• Position 
• Direction 
• Orientation 

The new qualifiers may be used instead of existing mechanisms for entering qualifiers, though the 
existing mechanisms will continue to work. 

23.4.2 Generic qualifiers 
Generic qualifiers are now handled in the expression library. They go in brackets and are comma 
separated, for example: 

MYATT(1, /VESS1 , 99, ATTID XLEN, N 100 E 50, true)  

The qualifier may be one of the following: 

• Any expression resulting in a  string, real, logical, element, pos, dir, ori 

• ATTID keyword followed by attribute name 

• TYPEID keyword followed by element type 

Notes: 
1) The ATTID, TYPEID keyword is needed to differentiate between passing an attribute or element 
type name rather than passing the result of a query. For example: 

(a). MYATT(DESC)  

(b)  MYATT( ATTID DESC) 
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(a) would give a string qualifier containing the value of DESC. E.g. ‘My description’ 

(b) would give an attribute qualifier denoting the ‘Description attribute’. 

2) There is a slight change in the query functionality. Previously ‘Q MEMBER(BOX)’ would be 
treated as ‘Q LEN’ followed by ‘Q (BOX)’. Now it will be treated as a query of MEMBER with 
qualifier of BOX. In the unlikely event that this causes a problem, the workaround is to change the 
query to be: 

Q (MEMBER) (BOX) 

As with the PML changes, the existing qualifier syntax will still work. 

Examples 
To query Equipment members:  

q MEMBER(TYPENAME EQUI) 

To query when description was last modified: 
q LASTMOD(ATTNAME DESC) 

To query PPOS 1: 
q PPOS(1)    

To query list of nominal bores: 
q NOMBMM(‘BORE’) 

23.4.3 IFTRUE 
A new construct has been added to the <expre> syntax: 

IFT/RUE ( logical1, typeX1, typeX2 )       -> typeX 

where typeX1 and typeX2 are two arguments of the same type, which may be Logical, Logical 
Array, Real, Real Array, ID, ID Array, Text, Position, Direction or Orientation. 

The result is the value of the typeX1 expression if logical1 expression is true, otherwise it is the 
value of typeX2. 

23.5 General PML enhancements  
This section summarises changes, removals and enhancements, which are detailed in the Software 
Customisation User Guide and the Software Customisation Reference Manual. 

23.5.1 File Browser  
The PMLFileBrowser class provides a PML.NET wrapper onto the standard WinForms open/save 
file dialog to enable it to be called from PML.  

For example, 
Import ‘pmlfilebrowser’ 

Using namespace ‘Aveva.Pdms.Presentation’ 

!f=object pmlfilebrowser('OPEN') 
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!f.show('C:\temp', 'xxx', 'save my file', false, 'txt files 
(*.txt)|*.txt|exe files (*.exe)|*.exe', 2) 

 

q var !f.file() 

Note that the File() method returns an empty string if the dialog is cancelled. 

23.5.2 List gadget enhancements 
Single column and multi-column List gadgets now appear the same, and the number of columns is 
deduced from the user specified headings or list display text. Interactive behavioural differences 
between them have been removed. The COLUMN keyword is now redundant. The ZEROSEL 
keyword now implies a single choice list. 

Single choice Lists: 

• De-selection of the current field is now supported for Lists with the ZeroSelection option. 

• UNSELECT events are now available for all list types in Open callbacks. 

• Re-selection of the selected field is now an optional attribute. 

• Deletion of fields now supported. 

23.5.3 Option gadget enhancements 
• General Changes 

• ZeroSelection property is now valid for Option gadgets (as for Lists). 

• Interactive de-selection is not supported. 

• UNSELECT events are now available in Open callbacks. 

• Re-selection of the selected field is now an optional attribute 

• Deletion of fields now supported. 

• Popup (context) menus now supported 

23.5.4 New ComboBox 
There is a new gadget ComboBox. This is a combination of an option list and an editable text field 
(similar to a Windows ComboBox). This allows interactive addition of new items to the list and 
enhanced location options for long lists. 

23.5.5 Frame gadget enhancements 

Frame type ‘Panel’ 
This allows the definition of a rectangular panel within a form which can contain any PML gadgets. 
The panel has the following properties: 

• By default, it has no visible enclosing box, though it may optionally be given an indented 
appearance. 

• It has no displayed tag text. 
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• It supports the standard frame gadget notion of a radio button group. 

Frame type ‘FoldUpPanel’ 
This is a rectangular panel with a visible title bar, and border. It offers the ability to show and hide the 
contained gadget’s when the title bar is picked. It can contain any PML gadgets except another Fold 
Up Panel. 

There are some restrictions as to how and where this can be used, as the expanding and collapsing has 
a positional affect on gadgets not contained within the panel. 

New Tabbed Page Frame attributes  
New Visible property allows a tabbed page to be selected and given focus. 

When a tabbed page frame’s tab is interactively selected, there is now a HIDDEN event raised for the 
currently shown page, followed by a SHOWN event for the newly selected page. 

23.5.6 Alpha view gadget enhancements 
The Alpha view gadget has been enhanced to allow multi-line copy and paste. 

23.5.7 Button gadget enhancements 
The Button gadget has an additional Link Label sub-type, which provides a purely textual button 
presentation, used to indicate a link to some application item, e.g. a hyperlink to a file, a link to an 
associated form etc. 

23.5.8 New separator Line gadget 
This gadget gives the ability to display a horizontal or vertical separator line to improve the layout of 
gadgets on a form. It does not apply to toolbars. 

23.5.9 New Numeric Input gadget 
The NumericInput gadget allows numeric input within a specified range, with given granularity. 

23.5.10 New Container gadget 
The new Container gadget allows the hosting of a PMLNET control inside a PML defined form. The 
Container supports the usual size, dock and anchor attributes to allow intelligent resize behaviour. It 
allows the user to add an external .Net control, which may raise events that can be handled by PML. 
In order to customise the context menus of the .NET control, the Container may have a PML popup 
menu assigned to it. This is shown when the .NET control raises a ‘popup’ event. 

See the PMLNET user documentation for details of creating PMLNET controls. 

23.5.11 Miscellaneous Gadget changes 
1. Extend Method AddPixmap(…) for Button and Toggle gadgets to allow pixmaps to be 
changed after the gadget is displayed. 

2. Add new method SubType() to Form and Gadget objects. 
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3. Add new method Container() to Gadget objects. 

4. RToggle UNSELECT event only raised for open callbacks. 

5. Add new TEXT gadget member Editable. 

23.5.12 Form changes 
The following FORM enhancements have been added: 

1. New attribute AutoScroll 

2. New events FirstShown and Killing 

3. New method SetOpacity to control form transparency 

23.5.13 Forms & Menus (FMSYS object) enhancements 
Further details and examples are available in the Software Customisation documentation. 

Progress Bar 
The application main window now has an inbuilt progress indicator in the status bar along its base. 
This can be accessed from PML via methods on the FMSYS object. 
 
Method Name Result Purpose 

Progress(  ) real Get the current Integer value in 
percent shown by the progress 
bar, in the range 0 to 100. Zero 
means the bars is invisible. 

SetProgress( !percent ) no result Set the Integer value in percent 
to be displayed in the progress 
bar. Values will be forced into 
the range 0 to 100. Resultant 
value of 0 will cause the bar to 
become invisible. 

 
The progress bar can be used in conjunction with the FMSYS object’s INTERRUPT methods. 

Cursor Function Support 
New methods are available to improve cursor function handling. The system now prevents a cursor 
function from being executed if there are no appropriate graphical views displayed; it raises the usual 
‘quit’ error (61, 528): 'User exit from submode' so that this can be handled, and then raises 
error (61,  115): 'Invalid command when GRAPHICS OFF or no suitable view 
available', which will alert the user unless trapped.  

Only the application knows exactly which graphical views can handle the specific cursor command, 
so the OKCurfnView methods are available to allow it to use this knowledge intelligently. 
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Method Name Result Purpose 

OKCurfnView( !viewtype is 
STRING ) 

boolean Queries whether graphical views of the 
specified view type are displayed. Graphical 
view types supported are: ‘G2D’; ‘G3D’; 
‘ANY’ and any view subtype is implied. 

OKCurfnView( !viewtype is 
STRING, subtype is STRING ) 

boolean Queries whether graphical views of the 
specified view type and subtype are displayed. 
Graphical view types supported are: ‘G2D’; 
‘G3D’; ‘ANY’. View subtypes supported are: 
‘ANY’ and for 

G2D: ‘NORMAL’ (Draft); ‘PLOT’; 
‘ISOSPOOL’ 

G3D: ‘NORMAL’ (Design) 

23.5.14 String handling 

New method on STRING object: SplitString(STRING delim) 
Result: ARRAY 

Purpose: An alternative to Split(STRING delim), taking the full contents of the delim string as the 
separator, and not only its first character. 

NOTE: Currently, the methods Split(STRING delim) and SplitString(STRING delim) differ only in 
the way they handle multi-character delimiters. The customer is advised to review his PML code for 
any occurrences of the method Split(STRING delim) that use a multi-character delimiter as an 
argument. Any code similar to: 

!string.split(!delimiter) 

where !delimiter could be a multi-character string, should be replaced either by the explicit code:  
!string.split(!delimiter.substring(1,1)) 

if the intention was to use only the first character of the delimiter as the separator, or by: 
!string.splitString(!delimiter) 

if the intention was to use the full multi-character delimiter. Note that in the latter case, the original 
code was not performing the proper splitting, as the full length of the delimiter was not being taken 
into account. 

In future releases, these two functions may be merged into one, providing the functionality of the new 
splitString(STRING delim) method.  

New method on ARRAY object: Join(STRING delim) 
Name: Join(STRING delim) 

Result: STRING 

Purpose: Concatenates the elements of the array, using delim as the delimiter. Non-string or unset 
array elements are skipped. 
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23.6 PML support for Secure Login  *12.0.SP5* 
Additional PML support has been introduced in all modules. A new object, 
PMLSECURELOGIN, controls the encrypted command script generation functionality. This 
object is used in the new Admin Command Script Generate form. The methods on this object 
are: 
 
<PMLSECURELOGIN> PMLSECURELOGIN 
  ASSIGN(PMLSECURELOGIN) 
  EMBEDMACRO(BOOLEAN) 
  HASLICENCETOEMBEDMACRO() 
  MACRO(STRING) 
  MDB(STRING) 
  PASSWORD(STRING) 
  PMLSECURELOGIN() 
  PROJECT(STRING) 
  SAVETOFILE(STRING) 
  USER(STRING) 
  VALID() 
  VERIFYAFTER(DATETIME) 
  VERIFYBEFORE(DATETIME) 
  VERIFYHOSTNAMES(ARRAY) 
  VERIFYWINUSERS(ARRAY) 
 
In addition the “environmental” conditions applied to generated command scripts make use 
of a new PML object, VERIFY. This object can also be used directly to verify that the 
executing user is on a list of approved users and is running on an approved host computer, 
and is running within a given time period. If the condition is not met the command script 
terminates immediately with a “Verification error”. The methods on this object are: 
 
<VERIFY> VERIFY 
  AFTER(DATETIME) 
  ASSIGN(VERIFY) 
  BEFORE(DATETIME) 
  HOSTNAME(STRING) 
  HOSTNAME(ARRAY) 
  VALID() 
  VERIFY() 
  VERIFY(BOOLEAN) 
  WINUSER(STRING) 
  WINUSER(ARRAY) 
 
A further PML addition allows the Appware developer to test whether a password entered is 
correct for the current user. This is provided by a new method on the existing SESSION 
object, ConfirmID(). This method takes a string as argument: the suggested password text 
with leading ‘/’ character It returns a boolean value that determines whether the password is 
correct for the current user. The method is only valid for the current session object. Example: 
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 !s = CURRENT SESSION() 
 if !s.ConfirmID( |/SESAME| ) then $*… 

23.7 Incompatible PML changes 
Great effort has been made to maintain upwards compatibility between the current and previous 
versions, while introducing major changes. The following are known potentially non-upwards 
compatible changes, most of which were advised in the PDMS 11.6 Bulletin. 

23.7.1 Toolbar based Option gadget field reselection  
Reselection of the selected field of an Option gadget on a toolbar no longer constitutes a change of 
value. This provides better conformance with Windows style GUI; the expectation is that there has 
been no selection change, so no action should result. 

The effect is that the gadget’s SELECT callback will not be run. 

Possible workarounds: 

• Add a do-it button to achieve the reselection callback. 

• Make use of the new ZeroSelection property of Option gadgets. 

23.7.2 Single choice list gadget reselection behaviour 
See List gadget enhancements 

23.7.3 Old RADIOgroup gadget removed 
The old RADIOgroup gadget has been removed from the core code and from all AVEVA Appware. 
Users will need to replace any RADIO gadgets in their own Appware by use of the Frame gadget with 
its radio group behaviour. 

23.7.4 Removal of Save and Restore using .bin files 
This has become unsafe because many system PML objects are core-code based rather than pure PML 
and these cannot be saved and restored by the PML binary-dump. Increasingly, Form, Menu and 
Gadget objects hold instances of such PML objects and so also cannot be restored correctly. 

PDMS11.6 introduced layout preservation, which ensures that a session starts up with the same forms 
and layout that were present at the end of the last session. The content on graphical views could be 
saved and restored manually using .disp files. 

User syntax to save and restore using .bin and .disp files has been removed. New mechanisms to 
automatically save the contents of graphical view gadgets at session close and to allow users to 
(optionally) restore them at start up will be provided. 

2.2 Form layout changes 

2.2.1 Frame gadget size must follow position setting 

The syntax for defining a Frame gadget has been modified to make it consistent with all other gadgets 
and to prepare for enhancement of gadget size setting to the extent positions of other gadgets. Setting 
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the frame’s position (AT syntax) must now precede the setting of width or height. Setting the frame’s 
size before the position will now generate a syntax error. 

23.7.5 Cursor Functions use in Docking Dialogs 
Cursor functions such as ID@ are no longer supported for graphical view gadgets in Docking Dialog 
forms, although this change was not announced in advance. AVEVA applications made little use of 
them and have been revised as necessary. Users with their own customised applications may also need 
to make adjustments – see below. 

There have been some serious difficulties in maintaining the older demand driven input facilities in 
what is now an event driven environment. In particular, it is tricky to control the use of other 
functions while cursor functions are in use, without causing performance issues. Docking dialogs are 
an up-to-date feature in PDMS and the use of archaic demand driven inputs is inappropriate to the 
new look and feel of the interface.  

Cursor functions continue to be supported at PDMS12.0 for document forms and simple dialog forms, 
so users’ applications can easily be amended to use these at PDMS 12.0. However, we intend to 
replace them with better event-driven graphical interaction mechanism in future releases – see section 
2.9.3. 

Possible workarounds (both are simple one line changes): 

• Convert the form type docking dialog to a document in the ‘setup form’ command. The 
resulting document form appears as an MDI child form in the client area of the main window. 
The child forms’ layout and accessibility are then managed via the Window pull-down menu 
on the main menu bar, just like the main PDMS graphical views. These child forms can be 
floated outside of the client region. 

• Convert the form type docking dialog to a (simple) dialog in the ‘setup form’ command. 
These forms exist independently of the main window. 

In both cases, the form can be placed on alternate screens in a multi screen configuration. 

23.7.6 Opsystem Function      *12.0.SP5* 
 

This function was used to distinguish between UNIX and Windows, so it is no longer required and 
has been removed. Any references to it should also be removed. A consequence is that a global 
variable !!NT, which it used to set, will no longer be available. If this is used in custom PML 
applications, it should also be removed, or alternatively it can be set to TRUE. 
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24  Updates to standard projects 

24.1 PDMS Test Projects 
The table below lists the test projects supplied with PDMS 12.0, and shows where to find the test data. 

 

Project Description MDB 

SAM Sample project – Metric units Sample 

IMP Sample project – English / Imperial units Sample 

MAS Master project including Catalogue  

Note: In future releases it is intended to withdraw the IMP project and customers wishing to use sample data in 
imperial mode should work in the MDB /IMPSAMPLE within SAM. 

These projects can be accessed using the standard system username and password:  

SYSTEM/XXXXXX 

24.2 Project Updates for 12.0 
All the test projects have been extensively updated for PDMS 12.0. 
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25 Product Faults & User Requests 

25.1 Known faults & Outstanding Issues 

25.1.1 Warnings 

RECREATE command  
Warning for customers using both AVEVA Plant and AVEVA Marine: 

A Plant project XYZ should not have the environment variable XYZMAR set, as this is required only 
for Marine projects. An attempt to recreate a Plant project while the variable is set will result in failure 
with messages similar to: 

replicate XYZ 

The correct d065 file was not found in the replicated project directory. 

(1,702)   Error preparing directory structure for the replicated project. 

In line 3 of Command/Form Input 

25.1.2 Faults & limitations – future corrections   *12.0.sp5* 
Please refer also to the Product Release letter included with the release – this may have updated 
information. 

Unless otherwise indicated, the following faults will be corrected, if possible, by the time of the next 
service pack. 

Defect 
Reference 

Incident 
Reference 

Description Workaround 

  Difficulties may be encountered 
exchanging data with Excel 
using Windows locales that use 
the comma (,) as decimal 
separator 

Change the Region to English (UK) or other 
using dot (.) separator 

P-4232  Using ‘Paste as macro’ in the 
PDMS command window 
currently works only with 
ASCII text – not all character 
sets. This should be resolved at 
PDMS 12.1. 

The context menu item 'Paste', rather than 
'Paste as macro’, works correctly. 

P-4233  The PML Add-in mechanism 
works only with ASCII text – 
not all character sets. 

 

P-26438 SI-18173 
 

The SAM sample project has 
incorrect Cable-tray Property 
data for variable length 
straights, leading to incorrect 
weight & centre-of-gravity. 

AVEVA can supply a correction macro on 
request. This creates new CMPD elements in 
place of TUBDs for variable length straights; a 
formula multiplies the length by the CWEI used. 
It also updates the CMPREFs for the GPARTs 
and SPCOs and deletes the old TUBDs.  
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25.1.3 Global – known limitation 
Reference Description Workaround 
P-11751 

KB 737 

Global update crashes with Dabacon 578 when 
session history in the secondary database is 
incompatible with that in the primary database.  

This may happen when importing 
from other projects or restoring old 
versions of a database from backup. 

25.1.4 DICE reports errors in some upgraded projects   *12.0.sp5* 
Reports by DICE (Database Integrity Checker) utility in PDMS 12 report more issues than earlier 
versions of PDMS. It is therefore possible that PDMS projects which were DICE “clean” may, after 
the upgrade to PDMS 12, report errors. 

This is likely to be the case where projects have been upgraded from 11.2 or 11.3 when elements that 
have attributes CATREF, LSTU, SPREF did not exist in database tables as they do today. 

These errors will be of the format: 

Entry missing from Dabacon table CATR. Element =8196/8420 has reference to element 
=8223/38681 which is not recorded in the table. 

Please use patch option or reconfigure this DB to resolve the problem 

The patch option does not in fact resolve the issue and users should reconfigure the database(s) using 
the SAMEREF option. For example, for a database MASTER/DESI 

FROM DB MASTER/DESI 
TO FILES /REC1 /REC2 
RCFCOPY ALL 
RECON 
BACKTRACK MASTER/DESI TO SESSION 2 
FROM FILES /REC1 /REC2 
TO DB MASTER/DESI 
RECON SAMEREF 

Projects created using PDMS 11.4, 11.5 and 11.6 should be unaffected.  

At the time of writing, there is no intention to modify the PDMS upgrade process described in section 
2.5 of this User bulletin. 

25.1.5 Isometric ADP (Automatic Drawing Production)   *12.0.sp5* 
The Isometric Automatic Drawing Production add-on application is being upgraded for version 12.1. 
Existing users who need to use it at version 12.0 might like to consider modifying the 11.6 version. 
The upgrade is fairly simple, but has some limitations; 

1. Because of the change in the handling of colour at Draft 12.0, all colours used within the 
application revert to grey. If you wish to recover the original colours, you have to reset all 
necessary drawing templates, backing sheets, representation styles and label templates used 
by the application. 

2. The application will not handle any new HVAC components, either those supplied as 
standard since PDMS 11.2 or those created using the HVAC user-defined mechanism. 

3. The application will not handle spaces in file names. 
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4. There may be some conflicts if you are using user-defined element types (UDET) that are 
based on the HVAC group of element types. 

5. AVEVA Marine grid and location systems will not function correctly. 

6. You cannot print using the application print options, but must instead use the print mechanism 
supplied with PDMS 12. 

Detailed instructions are available on request. 

25.2 Corrections & minor enhancements *12.0.sp2* 
A large number of improvements have been made in response to user feedback: the table below lists 
the significant defects corrected in PDMS 12.0 – up to service pack 2. Some have also been corrected 
in later releases of 11.6 or 11.5. 

Internal 
ref. 

Remedy ref. Reported in Fixed in Description 

2031  DRAFT 
11.5 

12.0 Removed duplicate polygons from design views. 
Particularly noticeable to users who export to DXF or DGN 
files. 

6961 HPD 19570 DESIGN 
11.5 

12.0 During equipment creation the positioning control form is 
used to position the equipment. If the Explicit Position 
form is shown but a graphical pick used, the positioning 
control form disappears but the explicit position forms 
remains, greyed out. 

7092 HPD 27531 ADMIN 
11.4.SP2 

12.0 Attempting to reconfigure a properties database could 
cause an error message: 
(24,19) Copy List full - Maximum number 300. 
This was due to the maximum number of root elements 
allowed being 300 

7104 HPD 19506 11.5 12.0 User-defined HVAC joints now available 
7368  11.6.SP1 12.0 GENSEC limits box improved – gives improved view 

behaviour 
9101 HPD 31731 DESIGN 

11.6.SP2 
12.0 Result from these two lines in a macro comes up in the 

wrong order: 
!!CDCMEMBER.show() 
!Answer = !!Alert.Confirm ('') 

9347 HPD 32217 DESIGN 
11.6.SP2 

12.0 Error message when measuring distances from insulation 
graphics of bend or elbow - causes crash  

9838 HPD 33779 PARAGON 
11.6.SP3 

12.0 When you display a component, KILL the relevant window 
and bring it back up again, you cannot see any component 
or the AXES 

9951 HPD 33961 DESIGN 
11.6.SP3 

12.0 Measure Error when using Graphics Snap on Panels 

10082 HPD 34048 DRAFT 
11.6.SP3 

12.0 Rectangular opening on a wall modelled as a fitting has p-
points defined but only a negative geometry set. I cannot 
pick any of the p-points to measure or dimension in 
DRAFT. The opening can be highlighted, but the p-points 
do not display, either with holes on or off. The p-points do 
appear in DESIGN.  
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Internal 
ref. 

Remedy ref. Reported in Fixed in Description 

10150 HPD 34216 DESIGN 
11.5.SP2 

12.0 EXTRACT FLUSH RESET can no longer be used on an 
Extract Master - it is meaningless and caused PDMS to 
crash  

10252 HPD 34398 DESIGN 
11.6.SP3 

12.0 Corrected an error the convertdbar object 

10268 HPD 34492 DESIGN 
11.6.SP3 

12.0 Attempting to modify the justification line or joint line of a 
Gensec with the appware Modify>Sections>Justification... 
or Joint Line no longer gives a Syntax error. 

10277 HPD 34552 PARAGON 
11.6.SP3 

12.0 Improved accuracy in calculator 
 

10279 HPD 34522 DESIGN 
11.6.SP3 

12.0 Pull down colour form stopped working. 
 

10334 HPD 34448 DESIGN 
11.6.SP3 

12.0 Feature points are now shown on pipe components if 
insulation is switched on 

10354 HPD 34803 DESIGN 
11.6.SP4 

12.0 Penetration did not re-orientate to suit re-oriented panel 
when using the Orientate>Align with ref. option from the 
Penetration application menu. An error message 'Unable to 
orientate to reference item' is displayed 

10518 HPD 35068 11.6.SP4 12.0 Bolt weights in VPRM did not transfer to PDMS for 
display on the isometric. Fixed in GATEWAY 5.1.0.1 

11607 HPD 36222 ADMIN 
11.6.SP4 

12.0 No longer crashes when Expunging a User Process.  

9946 HPD 33950 SPOOLER 
11.5.SP2 

12.0, 
11.5.SP2 

Field weld was not created following a lug.  
 

10422 HPD 34927 ISODRAFT 
11.5.SP2 

12.0, 
11.5.SP2 

Overall dimension on isometric was wrong, possibly 
because of the fact that the flange is dotted.  

10301 HPD 34637 ISODRAFT 
11.5.SP2 

12.0, 
11.5.SP2 

Incorrect dimensions. 
 

10151 HPD 34219 ISODRAFT 
11.5.SP2 

12.0, 
11.5.SP2 

Overall dimension is missing on isometric. 

10131 HPD 34169 ISODRAFT 
11.5.SP2 

12.0, 
11.5.SP2 

Weld number was incorrectly shown in middle of pipe, 
where there wasn't any weld.  

9958 HPD 33981 ISODRAFT 
11.5.SP2 

12.0, 
11.5.SP2 

Wrong dimension on isometric, where the flange on the left 
of the dimension has attribute MTOC equal to DOTU. 

10047 HPD 34062 11.5.SP2 12.0, 
11.5.SP2 

Extra checks are now included in Undo Failed Flush 
(removes Dabacon error 516 session page not found). 

9975 HPD 33984 ISODRAFT 
11.5.SP2 

12.0,11.5.
SP2 

Continuation notes are no longer wrongly positioned on 
OLETS.  

7121 HPD 26805 ISODRAFT 
11.5.SP1 

12.0,11.5.
SP2 

Split ATTA no longer causes wrong dimensions – these 
were caused by a Flow arrow before hanger with composite 
dimension on 

2879 HPD 16305 DICE 
11.5.SP1 

12.0 
11.6.SP2 
11.5.SP1 

Spurious errors no longer shown in large Dabacon tables 
Error in level 2 INDEX table, session no. 332, page no. 
186243 - incorrect value of first key on lower level page 
no. 186423 (extract 1) 

9095 HPD 31744 11.5.SP1 12.0 
11.6.SP3 
11.5.SP1 

Corrected a name clash when flushing.  
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Internal 
ref. 

Remedy ref. Reported in Fixed in Description 

9091 HPD 31711 ISODRAFT 
11.5.SP1 

12.0 
11.6.SP3 
11.6.SP2 

Corrected dimensional error on isometric under certain 
cases.  
 

8790 HPD 31125 ADMIN 
11.5.SP1 

12.0 
11.6.SP2 
11.5.SP1 

Reconfigurer was crashing with kerror 41 

7089 HPD 27267 ADMIN 
11.5.SP1 

12.0 
11.6.SP2 
11.5.SP1 

Database growth during ISSUING or FLUSHING has been 
corrected. 

7141 HPD 28795 ADMIN 
11.5.SP1 

12.0 
11.6.SP1 
11.5.SP1 
11.4.SP2 

Extract info no longer lost on Merge changes. 

7076  DESIGN 
11.6.SP1 

12.0 
11.6.SP4 

Settings > Defaults > Main option gave error due to 
missing DES-SUPP-DFLTS file 

6776 HPD 30600 ISODRAFT 
11.4.SP1 

12.0 
11.6.SP4 

Incorrect tube weights were given in the material list. The 
new weights & Centre of Gravity feature resolves this. 

3342 HPD 16691 DESIGN 
11.5.SP1 

12.0 
11.6.SP4 

Hangers & Supports problems with Imperial units 

3356  DESIGN 
11.6 

12.0 
11.6.SP4 

Faster operation of the explorer on elements with large 
member lists 

3359 DFN2796 DESIGN 
11.6 

12.0 
11.6.SP4 

Penetration display form improved 

8870  DESIGN 
11.6.SP2 

12.0, 
11.6.SP4 

Quick Pipe Routing now works better with insulated pipes  

8996 8997 HPD 
31508/9 

DRAFT 
11.6.SP2 

12.0 
11.6.SP4 

FRMW is now consistently added as a FRMW when you 
drag it into the 3D view  
 

9022 HPD 31551 DESIGN 
11.6.SP2 

12.0 
11.6.SP4 

Blocking form with an OK button behaved differently in 
PDMS 11.5 & 11.6. A subsequent graphical pick was no 
longer possible - the form was still displayed and ESCAPE 
did not work. This limitation is now resolved. but the use of 
Blocking forms is not recommended. 

9369 HPD 32362 DESIGN 
11.6.SP2 

12.0, 
11.6.SP4 

Textpane test limit removed 

9593 HPD 32975 DESIGN 
11.6.SP3 

12.0, 
11.6.SP4 

ATTA was reordered using when moving components 
using model editor 

9713 HPD 33441 DESIGN 
11.5.SP2 

12.0, 
11.6.SP4 

Corrections to volume calculations so that Map build MDB 
command is no longer required to get the correct volume 
when modifying spec. of a SCTN under a TMPL. 

9223 HPD 32010 DESIGN 
11.6.SP2 

12.0, 
11.6.SP4 

Performance improvements in several areas, especially 
graphics and explorer. 

9291  SPOOLER 
11.6.SP3 

12.0, 
11.6.SP4 

No longer crashes on switching module from Spooler to 
Design - on Global projects. 

9652 HPD 33312 PARAGON 
11.6.SP3 

12.0, 
11.6.SP4 

Performance improvements – especially for large 
catalogues. 

10303 HPD 34554 DESIGN 
11.6.SP3 

12.0, 
11.6.SP4 

No longer gets stuck in Isodraft mode 
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Internal 
ref. 

Remedy ref. Reported in Fixed in Description 

10329 HPD 34668 Design 
11.6.SP3 

12.0, 
11.6.SP4 

Volumes of cable tray or pipe made up of two welds and no 
other components are now calculated correctly. This means 
that  they clash correctly 

10629 HPD 35255 11.6.SP4 12.0, 
11.6.SP4 

Horizontal Slider for the Command Line window. 

9665 HPD 33195 DRAFT 
11.6.SP2 

12.0 
11.6.SP4 
11.6.SP3 

Corrected runtime errors when deleting Draft objects and 
using multi-write databases 
 

9639 HPD 33170 DESIGN 
11.6.SP3 

12.0, 
11.6.SP4 
11.6.SP3 

Primitives with translucent obstruction were displayed 
offset from their correct position when REPR HOLES ON. 

9106 HPD 31780 DESIGN 
11.6.SP2 

12.0 
11.6.SP4 
11.6.SP3 

Splash errors were occurring when running a macro 
creating multiple isometrics in Isodraft mode.  

9607 HPD 33068 SPOOLER 
11.5.SP1 

12.0, 
11.6.SP3 
11.5.SP2 

IWELD at LUG no longer omitted from SPLDRG. 

10442 HPD 33873 DESIGN 
11.6.SP3 

12.0 
11.6.SP5 

No longer crashes calculating weight of 0mm long objects  

11121 HPD 35722 DESIGN 
11.6.SP4 

12.0.SP1 Improved specification selection 

11706 HPD 37566 11.6.SP4 12.0.SP1 Corrected HVAC insulation sample project 
9705 HPD 33443 PARAGON 

11.6.SP3 
12.0.SP1 Display--Component did not show component in the 3D 

view when used after the first time. 
6965 HPD 22387 DESIGN 

11.5.SP1 
12.0.SP1 Corrected Syntax Error when trying to "Rename All" from 

Modify > Name form menu if / not used in name. 
7050 HPD 28734 ISODRAFT 

11.5.SP1 
12.0.SP1 
11.6.SP4 

Option to show dimensions on Isometrics above the 
dimension  

7933 HPD 29406 ISODRAFT 
11.5.SP1 

12.0.SP1 
11.6.SP4 

Option to show the drawing number of the continuation not 
just sheet no. 

7934 HPD 29407 ISODRAFT 
11.5.SP1 

12.0.SP1 
11.6.SP4 

Option to show continuation of the LINE Number not the 
PIPE number.  

7964  
8519 

HPD 29405 
30460 

ISODRAFT 
11.5.SP1 

12.0.SP1 
11.6.SP4 

Option to have coordinates shown at start and end points of 
sheets.  

9614 HPD 33088 ISODRAFT 
11.6.SP3 

12.0.SP1 
11.6.SP4 

Weights and totals can now be displayed on Isometrics.  
 

11613 HPD 36284 ISODRAFT 
11.6.SP4 

12.0.SP1 
11.6.SP4 

Correction to the Dimensions Composite option  
 

8906 
11615 

HPD 31255 
36613 

ISODRAFT 
11.6.SP2 

12.0.SP1 
11.6.SP4 
11.5.SP2 

Incorrect dimension caused by additional weld inserted by 
Spooler. Correct isometric was produced from Design 
(using Pipe Isometric),  

11434 HPD 35876 DESIGN 
11.6.SP4 

12.0.SP1 
11.6.SP4 

Incorrect centre of gravity on a SCTN when its owner is a 
TMPL owned by an SJOI.  

11549 HPD 36069 ISODRAFT 
11.6.SP4 

12.0.SP1 
11.6.SP4 

Corrected fixed length tube weights. 
 

11578 HPD 36362 ISODRAFT 
11.6.SP4 

12.0.SP1 
11.6.SP4 

Corrected continuation number when field weld added to 
SPLDRG 

11596 HPD 36497 ISODRAFT 
11.6.SP4 

12.0.SP1 
11.6.SP4 

ATTA no longer shown as bend 
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Internal 
ref. 

Remedy ref. Reported in Fixed in Description 

11604 HPD 36563 ISODRAFT 
11.6.SP4 

12.0.SP1 
11.6.SP4 

Reducer ISO Symbol takes account of component 
eccentricity where necessary 

8868 HPD 30838 SPOOLER 
11.5.SP1 

12.0.SP1 
11.6.SP4 
11.5.SP2 

Spool breaks now correct when an OLET is connected to 
an ATTA 

7777  
7990 

HPD 29415 
29847 

11.5.SP1 12.0, 
11.6.SP2 
11.5.SP1 

Corrected problems with extract refresh/flush related to 
UDA name length 

9029 HPD 31571 ISODRAFT 
11.6 

12.0.SP1 
11.6.SP4 

New SKEY for a branching OLET with offset P3 

10617 
11130 

HPD 35218 
35736 

ISODRAFT 
11.5.SP2 

12.0.SP1 
11.6.SP4 
11.5.SP2 

Error in display of elbow angle no longer occurs when 
angleaccuracy is set to 1. The problem occurred if the value 
had a zero at its first decimal place, e.g. 45.091 was shown 
as 45.9  

25.3 Corrections & minor enhancements *12.0.sp3* 
These include the following: 

Incident 
number 

Defect 
number 

Description 

I-4434 P-8205 Bolting only accepts length to 2 dp 
I-4386 P-8207 Bolting Utility Precision/Accuracy errors using imperial projects 
I-4387 P-8369 DBREF error on adding INSU category to spec. 
 P-8682 TUFLAG on negative primitives in Paragon 
I-4917 P-11695 PDMS 12.0.sp2.2 Add TEE to Spec using Branch Table 
I-4920 P-11752 PDMS 12.0.sp2.2 Add COUPLING to PSPEC 
HPD 38167 P-12286 Quick pipe router does not detect change of spec i  
HPD 37796 P-12253 PDMS generated DXF file has errors for Japanese 
HPD 32183 P-7848 No status flag error 
HPD 32763 P-8225 ISODRAFT and SPOOLER error 
HPD 35321 P-8228 Check valve dimension is wrong on isometric 
HPD 35905 P-8229 Duplicate part numbers for tubi connected to seton 
HPD 36110 P-8230 Weld Numbering Error  
HPD 36484 P-8231 Wrong dimensions on pipe legs with olets  
HPD 36585 P-8232 Problem using weld for small slopes an pipes  
HPD 36260 P-8233 Isodraft reporting wrong dimension  
HPD 36969 P-8234 Isodraft produces an FATAL ERROR while processing  
HPD 34236 P-8236 Missing Bends in Part List  
HPD 37298 P-8237 Connections to 6-way components do not always show correctly  
HPD 37347 P-8238  Spooler deletes the WLDGRP or JNTGRP  
HPD 37612 P-8239 Isos not up to date  
HPD 37697 P-8241 Spooling dimension  
HPD 37060 P-8242 IWELD not shown on SPLDRG  
HPD 37836 P-8243 Partno 2 is shown in Part List but not on the Iso   
HPD 37190 P-8245 Piping quantity incorrect on Spool Drawing iso  
 P-8247 Isodraw hangs when processing "busy" isometric 
HPD 37941 P-8248 ATTA cause wrong dimension value  
HPD 37994 P-8250 dimension line of overall length points to wrong p  
HPD 37171 P-8251 A fatal error has occurred in ISODRAW (Signal 11 trapped) 
HPD 38120 P-8252 Spurious length of pipe and bad Skewbox triangle representation 
HPD 38119 P-8253 Bad Skewbox dimensioning  



 
 

  
 

196 

Incident 
number 

Defect 
number 

Description 

HPD 38200 P-8254 Material control files in error  
HPD 38211 P-8255 Missing dimensions on 11.6 Isometrics  

HPD 38347 P-8257 
Dimension line of overall length points to wrong position while MTOC 
attribute of first part in flow direction is set to DOTD 

 P-8258 Problem using weld for small slopes on pipes 
 P-8259 Centreline length output to file only works for metric. 

HPD 38472 P-8348 
ERROR in SPLASH routine HQTYPE Area:'NULL SPLASH AREA' Error:5 
ELM ELMNT does not exist  

HPD 37946 P-8350 Offset TEE - offset shown in inches  
HPD 34955 P-8351 Wrong dimension and wrong representation on isometric.  
HPD 27771 P-11982 Opposite symbol when split drawing at bottom flat reducer  
HPD 34769 P-11983 Incorrect bore value shown on Iso  
HPD 37648 P-11985 MATL error when outputting Simplified Chinese  
HPD 38179 P-11989 Bolt part numbers incorrectly consolidated by Gateway  
HPD 38638 P-11990 Bolting problems with Isodraft equipment detailing  
HPD 38929 P-12188 Number of character mismatch errors  
HPD 38718 P-12343 Isodraft-error on Valve with offset between P1 and p2  
HPD 38850 P-12346 Wrong dimensions with offset skey in Isodraft  
HPD 35577 P-12542 Imperial System Isometric Options file missing  
HPD 36568 P-12545 Isodraft - too many Z Coordinates on lugs  
HPD 28166 P-9208 Modify > Component > Route  
 P-9380 Modify Clearance Form window is not displaying 
HPD 36834 P-10232 Report Details form error  
HPD 38373 P-10336 SPCOM doesn't has FLUREF attribute  
I-4619 P-10632 Pipe creation form Forward/Afterward was not ticked. 
HPD 36978 P-11462 When the clearance is set to 12 or larger on Imper  
 P-11601 Imperial units problem using Position Control 

I-4242 P-11905 
Cannot select a Datum Ppoint on positive or negative BOX primitive when in 
wireline mode. 

I-5052 P-12597 When Long EVAR paths are present the whereIs.pmlfnc fails  
I-3460 P-6506 Couplings require a LOFF attribute 
I-3247 P-6945 Pipe Assemblies can not select STYPE of type string for example 'EL90' 
 P-7421 Test 71 FLUSH attempts to flush a different db 
I-2340 P-7429 Split Pipe by moving Components does not do anything 
I-4274 P-7840 text needs aligning with Radio button 
 P-8180 DNF Not found error if Router is not installed 
HPD 37174 P-10260 Alternate Pipe Spec not selecting correctly  

Please see also Global product release letter d51797. 

25.4 Corrections & minor enhancements *12.0.sp4* 
A significant number of corrections have been made in this service pack. Particular attention has been 
paid to the use of Imperial units and some of the new applications such as Cable Design.  

Some of the most significant are documented below.  
Incident 
number 

Defect 
number Description 

 P-12263 
Default Specification disappears behind PDMS main window when cursor run 
over the graphical view. 

I-2930 P-6948 Router Create Pipe Rack fails 
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Incident 
number 

Defect 
number Description 

HPD 38668 P-11986 Tube numbering problem for Pulled Bends with no leave tube  
 P-11987 IWELD created when COCO not defined 
HPD 38849 P-11991 We have a problem with numbering if after the spool break are (support) ATTAs  

 P-12085 
Error message is displayed when saving the Numbering and Spool settings 
defaults 

 P-2236 Imperial Units now work better in the Paragon Modify>CATE form 
 P-6302 Schematic element CONARRAY can now be set correctly using Datal output 

4434 P-8205 
Bolt table utilities form now accepts more accurate values – useful for imperial 
fractions 

HPD 34214 
HPD 34899 

P-10036  
P-10102  Model Editor Increments now use more appropriate defaults for imperial units 

 P-11816 
A more appropriate error message is given when picking Go to > Owner from the 
Members form ends up at WORLD 

 P-11967 
Corrected a defect in PML Profile object union() method causing hole 
management failure in imperial units 

5095 P-12337 
Enhanced Size Range table allows non- standard nominal bores; this overcomes a 
spec creation problem with imperial units  

5233 P-12373 
Modification of the value of any parameter of SCOM in Model View no longer 
causes all the parameters to become zero.  

 P-12868 
Improved error message shown when entering Offset dist in Move Cableway 
Segment form  

4009 P-13019 Can now define equal TEEs in the Branch Table 
5797 P-13222 Resolved a pipe spool generation problem 

5798 P-13223 
When inserting a support ATTA, the generation of additional pipe spools now 
takes account of SHOP attributes to ensure correct pipe spool sketches. 

 P-13339 Crash and SGL errors when drawing negative revolution is now resolved. 
 P-13470 SGL Errors and invisible equipment with Holes Drawn and Obstruction set 

5751 P-13474 
On GMSE creation, if Piping Detail representation is selected, the OBST value is 
now HARD (2) rather than NONE.  

 P-13497 Corrected AccessViolationException when accessing attributes via .NET API 
 P-13540 Corrected error in command window when running PDMS script. 
 P-13556 PANELs under TMPLs in ASL no longer misplaced 
 P-13681 Corrected Random crash entering modules 
 P-13782 Corrected PML error when using MDS Application Defaults in paragon  
6452 P-13807 Pipe Penetrations now work correctly in Imperial Units 
6404 P-13864 Upgrade script now upgrades LEXICON with IMACRO 
 P-13374 Problem with cable way material when inserting a POINTR element. 
4386 P-8207 Precision and Accuracy errors using bolt sizes in imperial units 
 P-14111 Apply changes changed the values of tray width - imperial 
 P-14455 GUI calculator errors 
7041 P-14777 The coaming of Cabling Penetration System (defined by a FIXING) was not 

drawn 
 P-13975 Error message stating ‘Variable !LOOKWESTDIR does not exist’ when 

generating ADP dwg. 
 P-14123 Error with Equipment Import utility. 
 P-14328 Pipe - Model Editor Crash. 
 P-14330 Pipe - Measure with Insulation Crash. 
 P-14381 PML: Invalid array expression error message is displayed and specification form 

Task Section becomes blank when clicking on Add Items Link under the Items 
section in the Specification form of the Paragon Module. 
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Incident 
number 

Defect 
number Description 

 P-14419 An error message “Variable !LIST does not exist” was displayed when the Add 
Selected button was clicked in the Split Pipe form. 

 P-14420 Pipe Splitting Button ‘ID Selection’ did not make any selection. 
 P-14421 Pipe - Modify Components Form Modify Insulation and Tracing Spec was not 

working. 
 P-14571 Ceiling tiles were not being drawn in the correctly position, and holes in them 

were not being drawn. 
 P-14596 Validation of managed hole fitting in Panels & Plates failed with syntax error. 
5549 

P-13192 

A new attribute RANEQ controls the threshold distance for routing directly 
EQUI-EQUI rather than through cableways. This means that short cableway 
branches that are not close to equipment start/end point can still be routed  

6895 
P-14908 

The cableway branch is no longer rotated if the cableway is pulled down or pulled 
up when creating the branch using quick routing  

2741 
P-15499 

Outfitting entry speeded up – system doesn't load Integrator if no SCHE DB in 
MDB 

5549 P-15530 Free route between equipments is now considered during Cable Routing 
 

P-13114 
RECTANGULARGRID is now split when passing through the start/end position 
of the ARC shaping the circular opening 

 P-14329 Application no longer exits when a pipe is moved using the Model Editor handle. 
7079 

P-14820 
P-14863 

Runtime error due to degenerate arc no longer occurs while modifying Stair 
Tower.  
Handles PML error due to above when modifying the Stair Flight Spacing 

 
P-15151 

Paragon GUI: setting parameters at CATE level using Imperial units no longer 
gives error message ‘String is too long. Truncating to 4 characters’ 

 P-15152 Reducer table no longer allows equal Main and Reducing Bores 
4917 P-15471 Can now add TEE to SPEC using Branch Table 
 

P-15528 
Fixed some cases where the cables were not re-routed after moving the CWBRAN 
Segment 

7068 P-15532 Can now add COUPLING to PSPEC 
5548 

P-15523 
Cable Design: cable can no longer be routed through a cableway branch that is not 
connected to the main network 

5548 
P-15525 

Cable Design:  cableway network checking has been much improved to make it 
more robust so that unconnected branches do not prevent auto routing 

5797 
P-16345 

Pipe sketch: a pipe spool with a head tubi no longer causes the whole of the 
BRAN to be drawn 

3310 
P-16873 

Cable Design:  There is now a warning if YDIR is the same as direction of first 
RAIL segment 

4783 
P-16877 

Cable Design:  There is now more flexibility for the radius of Rail as distinct from 
Rpath. 

7651 

P-15795 

UDAs on UDETs now work correctly again after Getwork. Note that the 
correction to this problem may mean that the wrong type of elements can be 
created under UDETs (P-7342) – this will be further investigated. 

7340 
P-15945 

Equipment: Modify ATT form now lets you amend the value of USERWEI and 
USERWWEI attributes. 

8101 

P-16566 

Improvement to Paragon Spec Editor: with units set to INCH BORE FINCH DIST 
and the Spec Editor form active, the “Apply” button no longer causes the PBOR 
answers to change by a factor of 25.4, each time it’s selected! 

4297 8147 ASL: Platform internal frame created in wrong orientation 
4298 8149 ASL: Platform internal frame is lost when creating an opening where spref set 
4267 8167 ASL: Deleting ladder side exit renames LADDER element to db ref. no 
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Incident 
number 

Defect 
number Description 

4263 8168 
ASL: Ladder evaluation/creation does not offset ladder centreline to 'Clearance 
from Obstruction' value 

4017 8170 ASL: Multiple Attached Sctn Copy problem 
4266 8181 ASL: Missing ladder cage hoop bars 

4271 8362 
ASL: Platform Intermediate span profiles not complete when Connect sections 
checkbox on 

4434 8567 
Cats & Specs - Bolting only accepts length to 2 decimals – not enough for inches / 
fractions 

4250 11608 
ASL: Create Stair Landing Layout Definition form - Select Plate Specification 
link label not working 

4025 11895 Negative Extrusion GUI Enhanced for unnamed items 
5290 12143 Plane Positioning not working correctly on Branch Connections 
5304 12213 Creating a Split Plane using Element Intersect gets stuck in loop 
5055 12279 File Browser in v12 does not behave the same as in 11.6  
4275 12295 Assembly Form now defaults to last assembly used 
5395 12515 Function("Extend through feature") is required for quick routing of cable way 
5511 12686 SOP Directions: for element used to centre a grid, the prompt is now  -Y, -X etc. 
3714 12803 GPART should be referenced in "Sub Element Ref" to make SUBE in TMPL 
5346 12807 Corrected cable material error - “(2,813) Cannot convert string to DBREF”  
5550 13035 Cable can not be un-routed, when cable is routed by free route cable function 
5750 13366 Error on parameter creation - grid for input of parameter values is not updating 

5315 13454 
Cableway Branch Create Tasks form needs additional attribute for the IClass 
(Interference Class) 

5342 13738 Cabletray tier material does not get dressed correctly 
6474 13943 ASL: Error when creating or modify Stairtower Landing Configurations 

6579 13979 

Create > Copy > Offset with "to Rel. Adjacent to Object" option on a pipe with a 
Spool List causes an error – the result is the Pipe will be copied but the offset will 
not be applied and the new pipe will not have a spool list 

6599 14132 Cannot select different tube SPCO with same size (Nominal Bore) 
6261 14194 Templates that use constants fail in Imperial – changed sample data 

5313 14348 
Cable Design - Additional defaults for excess for cables and fill level for 
cableways 

6863 14488 ASL: Ladders - Crossed Stringers 
6860 14489 ASL: Ladders - Work Point Markers 
6825 14498 ASL: Stair Flights - Preview of stair flight 
6851 14538 ASL: Stair Flight - Installation sense error 
6814 14604 ASL: Stair Towers - stair flights - centre line spacing 
6937 14609 ASL: Ladders - Side Exit Height 

6868 14780 
Quick Pipe Routing - HSTUBE and LSTUBE revert to default SPCO if the spec 
has several tube SPCO with same bore,  

5314 14823 
Cableway Branch Create form now has two options for Othogonal Route –routing 
in a X, Y, Z or a Y, X, Z direction 

6660 14845 
Quick Routing - starting from a Nozzle and finishing with piece of tube open: 
connecting PT to last member causes error 

6928 14912 Cable should be routed from a route point to another route point by defining PRPS 
6918 14913 Cableway branch creation using branch off or route attachment point incorrect 

6930 15026 

Cableway branch is incorrectly dressed using straight material between first and 
second components by picking component - the position of this material is 
incorrect 

6929 15027 Part of a cableway branch cannot be dressed with material by picking point 
3960 15033 When inputed parameter in paragon, do not become preview to graphic view. 
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Incident 
number 

Defect 
number Description 

7053 15103 AVEVA plot application is missing MSVCR71D.dll 
7260 15154 Cable Design – some functions fail if Region setting uses ‘,’ as decimal separator. 
7173 15161 Incorrect operation of 'Add to Drawlist Colour' 
7269 15189 Access Control Assistant form does not read User Security correctly 
7287 15301 Paragon : Form data duplicated for Create/Modify Text Details 

7124 15306 
Data Consistency Check Form does not navigate to component selected in the 
form 

6961 15330 ASL: Platform - Trimmed sections - platform openings. 

6423 15354 
Under some circukmstances, Utilities>Sketch Drafting to set the 2D element 
Attributes gave a PML error 

7170 15379 Wrong descriptions for p-point attributes in Design 
7340 15469 Equipment, Modify ATT form improved – notably for weights, imperial units 
6862 15480 ASL: Ladders - Side Exit aborted 

7337 15567 
Paragon Modify CATEGORY using ‘ Import CSV file’ to add SCOMs to a CATE 
does not work correctly 

7410 15837 Compound Joint not displaying correctly 
6270 15856 Query Attribute Tracking error in Catalogue Explorer 
7464 15874 Panel Loop Editor Vertex Coordinate display improvements 
6844 15939 ASL: Stair Flights - Handrail Connectivity 
6846 15940 ASL: Stair Flights - Handrail Alignment 
6897 15941 When cable is unrouted, the free line between start and end equipment is removed 
7758 15943 Replicate Project Structure Error 
7622 16039 User defined Linestyles plot with wrong scalefactor when using Windows Plotting 
7544 16154 Query attributes output incorrect for parameters 
5415 16172 GUI for Cable Properties added 
7862 16363 Corrections to Modify Equipment Specification form 
6861 16443 ASL: Ladders - Command Line error messages 
7975 16493 Curved Sections Creation form layout correction 
7796 16506 Update Names fails when a GLAB references an unnamed and deleted element  
8066 16525 Modify>Cate, with tracking ON loops when navigating to a parameter.  
7054 16565 Improved  PDMS 12 upgrade macro for Draft – option to upgrade picture files 

8443 17070 
Model Editor - “Align with Feature” or move model-editor’s handle to particular 
snap points did not catch P-point of each element 

8357 17089 Pipework application: 'Component Selection' has an error with TUBI in Explorer. 

8604 17441 
Quick Router does not move the RNODE created at the head/tail when a change 
in direction occurs 

8073 17460 Error message on Modify>Spec – now removed 

9286 18226 
Cableway CWLIST now has members in order, sorted by distance from the 
begining of cable in the right diection 

8974 18267 Paragon - Data set not updating on Model View form 
8976 18268 Unable to create Insulation Specs using the appware 
9288 18276 CLIST now ordered correctly 
9279 18411 Cableway Branch table form - changed TAB order of Textboxes 
9446 18414 RATTA position affected by Fillet Radius on neighbouring POINTRs 
9377 18420 Unable to create Bolt Specs using the UI 

9284 18427 
Cable reconnected between start equipment and head / between end equipment 
and tail changed, after the equipment is moved 

9752 18850 

Inserting a route point on cableway using model editor now updates affected 
RNODEs (changing ZDIS and leaving PKDIS unalterted) consistent with model 
editor. 

9619 18890 Equipment Import errors and hangs after selecting the csv file to import 
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Incident 
number 

Defect 
number Description 

6769 19190 Merge changes fails with  dbnames over 49 characters 

10869 20226 

HVAC Assemblies - when placing assembly in model, application returns to 
Monitor, if the user selects the assembly component displayed in the 3d assembly 
view. 

25.4.1 Fixes to Global Daemon 
 

User 
incident 

Defect Details 

HPD 34926 
HPD 36158 
HPD 36489 

P-10101  
P-10184  
P-11399  

Corrected a problem causing Global to freeze PDMS during updates 

HPD 38428 P-10421 Prevent crash for 100+ Inter-db macros 
HPD 29322 P-9535;     

P-9439 
Missing file no longer stalls Change primary;  command now fails if DB File 
is missing 

 P-14520 Recover command stalls when recovering to an Offline location 
 P-14829 Daemon crashes when Global DB is not available during a Synchronise 

command 
 P-8855 Unable to create extract at Satellite locations due to timing issues on the 

Global Database 
 P-14971 Propagation of Databases leads to Dabacon Error 578 on secondary databases 
HPD 37489 P-10281 

P-7465 
Spurious “Dabacon 10 – Invalid reference” errors in Daemon  

25.4.2 Fixes to PDMS Global Admin 
 

User 
incident 

Defect Details 

HPD 33573 P-11576 Reverse Propagation after Generate; removed automatic Expunge except for 
new system db 

HPD 38385 P-11575 CHANGE ACCESS crash (Deleted user) – relates to ADMINISTER 
command 

HPD 26298 P-9274 Replicate System Satellite errors 
 P-14828 Crash on MAKE GLOBAL when no TRANSACTION DB exists 
 P-14836 Crash on EXTRACT FLUSH when daemon is down 
 P-16553 Implicit Global claim leads to crash on heavily loaded machines 
SI-8136 P-16817 Admin Elements Form (Databases) Sort By Location is not correct for 

Satellites 
SI-8163 P-16669 It is not possible to Filter on Location for a number of Admin forms: 

• Create MDB 
• Database Allocation (By Location) 
• Database Integrity Check 

25.4.3 Fixes to PDMS Global Admin – Offline Locations 
 

User 
incident 

Defect Details 

HPD 37152 P-6578 Unable to transfer Global Database 
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HPD 37069 P-6583 Transfer of inter-DB macros with NULL references causes the Offline 
Transfer process to crash 

 P-7420 Ensure that the system databases are copied correctly during Transfer process 

 DFN 1486 Option to propagate non-propagating databases during Transfer process 

 P-15524 “Database not open error (1,267)” reported on TRANSFER FROM command 

25.5 Corrections & minor enhancements *12.0.sp5* 
The following corrections were made in PDMS 12.0.SP4 fix releases and were also applied to SP5. 
Details of a number of the other corrections to SP5 are given in the release letter. 
 
12.0.SP4.7: 
Incident 
number 

Defect 
number 

Description 

SI‐16151  P‐24452  Error message was given when a valve, fitting, etc. was included 
 
12.0.SP4.7 
Incident 
number 

Defect 
number 

Description 

SI‐9508  P‐24933 
Model editor uses incorrect handle for some components when the pipe route is incomplete 
– 11.6 behaviour has been restored 

SI‐7099  P‐14939  Diagrams: The valve number wrapping with symbol should be able to be created. 

 
12.0.SP4.6 
Incident 
number 

Defect 
number 

Description 

SI‐11081  P‐22822  DRAFT: Justification and Alignment have been corrected for standard DXF output 
 
12.0.SP4.5: 

Incident 
number 

Defect 
number 

Description 

SI‐15001  P‐23540  GUI forms did not work correctly if imperial distances including a foot mark ‘ were entered 

SI‐13404  P‐24063 
Clash missed in some circumstances for primitive with a minimum dimension greater than 
20 metres 

  P‐24187  Diagrams: Refresh doesn't work for referenced attributes. 
SI‐14804  P‐24191  ISODRAFT entry crashed if an ATTA has more than 100 UDAs 

SI‐15863  P‐24223 

Database crash under certain specific conditions – initially identified for Global Daemon 
Flush DB 
(see also release 51896 – Global Server 12.0.SP4.5) 

SI‐8838  P‐24457  Admin: Performance problem merging System and Global databases 
 
12.0.SP4.4: 

Incident 
number 

Defect 
number 

Description 

  P‐14025  Diagrams: Primary‐Secondary shape handling dialog should be more easily understood 
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  P‐21805  Diagrams: The label offset is no longer cleared by Edit Master 
  P‐22589  P&ID Manager: Incorrect branch head and tail refs no longer set on import 

SI‐14259 
P‐22876 

Correction to <project>DFLTS path – caused problem with Global Satellite location creation 
(and possibly similar issues with Replicate function. 

  P‐23297  AVEVA PMLFileBrowser now supports UNC file paths 
SI‐14890  P‐23524  Piping: GUI problems with pipe bores in imperial units 
  P‐23579  P&ID Manager: UUNI not set properly in Lexicon 
  P‐23580  P&ID Manager: Imperial Distance/Bore units on UDAs were not correctly imported 
  P‐23581  P&ID Manager: unqualified values were not correctly interpreted when setting UDAs 
SI‐14560  P‐23641  GUI problems setting some text attributes that include a foot mark ‘ 
SI‐9943  P‐23777  ‘Production Checks' now produce correct spool 
SI‐15397  P‐23798  Draft: Limits defined view not working with Imperial units 

 
12.0.SP4.2: 
Incident 
number 

Defect 
number 

Description 

SI‐11830  P‐21360  Diagrams: Consistency Check Error for Cable Connection to geometry end 

  P‐21669  Diagrams: Highlight highlight resets user defined formula for line width (& colour) 
SI‐9943  P‐20221  Pipe 'Production Checks' produces incorrect spool  
SI‐7937  P‐16550  Pipe Piece Cutting is not Correct for Branch and Tee Point 
SI‐11431  P‐22321  Diagrams: Copy ‐ paste to Custom Properties causes crash 

SI‐8665  P‐20834 
When generating pipe spool, the pipe component connected to TEE becomes a separate 
pipe spool. 

SI‐10053  P‐20251  Isodraft: sheet continuations shown at coordinates E 0 N 0 EL 0. 
SI‐9891   P‐20564  Isodraft: Missing label for support plates on isometrics  
SI‐12057  P‐22310  Isodraft: Parameterized Weights on isometrics incorrect  

SI‐11337   P‐22320  Isodraft: Wrong Dimensions on iso with Overallskews ON  

HPD 38939  P‐22331 

Isodraft: Spool Drawing with several Spools, plotted using ISOTYPE SPOOL and 
SpoolNumbers PREF FROMDB options, means that Spool n does not necessarily correspond 
to the nth Plot File 

SI‐3231  P‐22839  Specon OUTPUT command ignores database IPR protection  
  P‐22864  Draft: Corrupt Cyrillic DXF output when using TrueType text 
  P‐22921  Paragon: Error when modifying specifications (introduced by fix for P‐20455) 

SI‐6600  P‐22941 
It is now possible to replace the default system (software defined) popup menu on the 
command line form using a user defined PML menu. 

SI‐13027  P‐22253  Integrator: Connections not set on Build SCPLINs connected branch head to tail 

 
12.0.SP4.1: 
Incident 
number 

Defect 
number 

Description 

SI‐9284  P‐18427  
P‐19183 

Cable Design – can now reconnect the head or tail of the cable with any precedence of the 
legs in orthogonal free route (e.g. 'xyz' 'zyx' 'zxy' and so on...). 

  P‐21821  DRAFT: Pipe sketches wrong when SITE or ZONE not at Pos (0,0,0) 
  P‐21828  DRAFT: PSPOOLs accidentally drawn when PIPEs included in IDList 

SI‐10083  P‐20455  PARAGON: User interface error with Russian characters:  
  P‐21467  PARAGON: If we use the ‘underbar’ for SCOM and display it in ModelView, Command 

Window displays errors. 
SI‐11549  P‐21622  DIAGRAMS: Unable to reference templates from the Master Project 
SI‐13737  P‐22448  UDA values were lost after upgrade from PDMS 11.6.if the type of data had been changed 

from an array to a scalar at some point. This unusual situation is now handled correctly.  

 


